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P Preface

About MaxLoad®Pro
Congratulations on purchasing MaxLoad®Pro, a Windows-based multi-sized product loading analysis 
software.  You have made an excellent choice!  MaxLoad®Pro is extremely powerful and has proven 
to save millions of dollars for thousands of companies because of the efficiencies you’ll realize in 
your business.  We’re confident that MaxLoad®Pro will provide the same benefit to your company, 
regardless of your product, package or volume.

TOPS® MaxLoad® technology has been the industry’s premier vehicle and container loading 
system.  MaxLoad®Pro offers a sequenced loading report, along with a variety of ways to display 
the load, such as sequenced 3-dimensional color/number coded load diagrams and placement-
by-placement displays.  MaxLoad®Pro also has the ability to construct straight and mixed pallets.  
With MaxLoad®Pro, you can accurately plan your vehicle/container loads in advance, resulting in 
increased efficiency and better customer support.

Over the years, we’ve maintained a steady effort to simplify our software so that you, the end user, 
are able to conduct your loading analysis quickly and efficiently.  Just in case you have a problem, 
we’ve written this User’s Guide to assist you with every possible issue or question you might have.

If this User’s Guide does not answer your questions, or if you should experience problems 
while using the MaxLoad®Pro software, please call TOPS Technical Support or your TOPS sales 
representative at 972.739.8677.
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How the User’s Guide is Organized
This User’s Guide is organized into 12 chapters and three appendices, as follows:

Chapter 1, Getting Started, discusses system requirements necessary to run MaxLoad®Pro and 
instructions on how to install the MaxLoad®Pro software.

Chapter 2, The Basics, presents the basic features and functions of the MaxLoad®Pro system, such as 
the Control Center, common features used throughout the system and opening an existing manifest.  
This chapter also outlines MaxLoad®Pro’s new features and improvements.

Chapter 3, Defining MaxLoad®Pro Databases, presents the three primary MaxLoad®Pro databases – 
SKU, Pallet/Slipsheet and Vehicle.  This chapter walks you through how to define, modify and delete 
items in each of the three databases.

Chapter 4, Loading a Truck Manifest, discusses the features you’ll use to define a truck manifest load 
– the Vehicle, Options, Mixed Pallet and Comments tabs, the SKU List and the Manifest List.  This 
chapter walks you through how to define a truck manifest.

Chapter 5, Loading a Pallet Manifest, discusses the features you’ll use to define a pallet manifest 
load – the Mixed Pallet, Options and Comments tabs, the SKU List and the Manifest List.  This 
chapter walks you through how to define a pallet manifest.

Chapter 6, Loading a Tote Manifest, discusses the features you’ll use to define a tote manifest load. 
This chapter walks you through how to define a tote manifest.

Chapter 7, Loading a Single-SKU Manifest, discusses the features you’ll use to define a single-SKU 
manifest load – the Vehicle, Options and Comments tabs, the SKU List and the Manifest List.  This 
chapter walks you through how to define a single-SKU manifest.

Chapter 8, Viewing a Solution, discusses the Manifest View screen, which provides a range of 
information about a load.  This chapter shows you how to view a load solution from different angles 
and with different options, and presents the different types of information displayed for a load.

Chapter 9, Editing a Solution, discusses the Editor screen, which allows you to fine-tune or 
completely change a load solution.  This chapter walks you through how to add and remove SKUs 
and placements from a vehicle; how to align and center SKUs and placements on a vehicle; how to 
view the load from different angles; and how to deal with stacking/loading violations.

Chapter 10, Reports and Printing, walks you through all the system’s printing functions, including 
how to define print parameters, work with the print preview and add text annotations to a printout.

Chapter 11, Configuration, discusses how to customize MaxLoad®Pro by turning on and off a range 
of options and by changing the defaults and/or properties for each individual field in the system.

Chapter 12, Import/Export Functions, discusses the various import and export options available in 
MaxLoad®Pro.

Appendix A, Command Line Parameters, provides various command line options along with syntaxes 
available for Maxload.exe.
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Appendix B, Frequently Asked Questions, provides common issues and questions encountered by 
users.

Appendix C, Glossary, provides definitions for a range of terms used in the MaxLoad®Pro system and 
the product loading industry.

New Features in MaxLoad®Pro 4.0
•	 Improved loading of flatbeds, split/beam railcars, side bay trucks.

•	 ULD (air freight) support.

•	 Support trucks with shelves.

•	 Support trapezoid shaped SKUs.

•	 Move SKUs between two trucks in 3D edit view.

•	 New weight balance by segments for trucks and containers.

•	 Auto adjust axles on truck for axle weight limits.

•	 Enhance air bag dunnage functions.

•	 Support multiple load rules.

•	 Create multiple custom reports.

•	 Preview all containers/trucks in manifests.

•	 Support stack options for mixed pallets.

•	 Copy data from MaxLoad®Pro screen to system clipboard.

•	 Copy data from other applications to MaxLoad®Pro pick list via system clipboard.

•	 Unicode support allows switching between far-east and roman character based languages 
without changing system locale setting and restarting system.

•	 Enhanced email options include support of 32 and 64 bit Outlook, Gmail and Thunderbird.

•	 Easy zoom, pan and new 3D display options.

•	 Enhancement to MaxLoad®Pro ADO version.

Chronology of Features in MaxLoad®Pro 
This section outlines the various releases of the MaxLoad®Pro software, along with the features 
included in each release.

Version 3.6

•	 Support L-Shape SKUs like sofas and chairs including the option to optimize their bundle sizes.

•	 In 3D View, highlight selected placement in color and other placements as wire frames only.

•	 Support SKU bundles, especially useful for thin SKUs like wood planks and metal sheets. Multiple 
preferred bundle sizes can be set up for loading.

•	 Allow priorities within stops.

•	 Adjust weight distribution by moving the entire load towards the front or back of the vehicle. 

•	 Support weight limit to ensure the load is within these limits and highlight violations.
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•	 Support multiple pallets for pallet manifests. 

•	 Customize reports.

•	 Add air fill dunnage to protect and secure the load during transport.  

•	 Advanced data filter for manifest name, date, user name and customer name.

•	 Export 3D load diagrams to JPEG, BMP, TIF or other formats.

Version 3.0

•	 Support new vehicle types including side-bay trucks, flatbeds and ULDs.

•	 Rotate layers when creating unitload patterns for SKUs.

•	 Split editing to provide two views of the same vehicle load during editing for better visualization.  

•	 Edit mixed pallet in vehicle.

•	 Define wheel wells for trucks and corner boxes for sea containers.

•	 Break drum SKU placement into individual items for editing. 

•	 Add descriptive comments for manifests include customer name, address, ship status, and 
delivery date.  

•	 Improved layer algorithms for mixed pallets to generate more stable layers by stacking SKUs of 
similar heights to form layers. 

•	 Custom import for pallet and tote manifests.

•	 Direct export to PDF files without the use of Adobe Acrobat or other third party PDF tools.  

•	 Import SKUs and order data from a secured FTP server.

•	 Specify Date Range for Manifests:  New filter to sort manifests based on the dates they were last 
saved, within 7, 30, 60, 90 or 180 days.

•	 Implementation of Load Rules: Ability to view and edit contents of load rules within Max Load.  
Please contact TOPS directly to implement this feature. 

Version 2.7x

•	 Enhanced algorithm options including pinwheel patterns for unitloads, pyramidal staggering of 
pipes, improved nested loading of mixed size rolls and automatically align loads inside transit 
vehicles

•	 Imports case sizes and pallet patterns from TOPS Pro.

•	 Support Loading by Percentage, for example, 50% of SKU-A, 30% of SKU-B and 20% of SKU-C.

•	 New Export Options include solution, load list, placement list and export by placement.

•	 Data Import Wizard which allows easy import of selected SKU and MFT fields.

•	 More efficient and stable mixed pallets.

•	 Ability to see contents of mixed pallet SKUs in the containers.

•	 Use of Fill Items to for leftover space with selected SKUs,.

•	 Creates partial unitloads to fill leftover spaces on top, optimizes unitload height for top layers.

•	 Right-click menu in the 3D editor for SKU alignment, snap placement and to break a placement 
into individual items.
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•	 Use of loading rules to better optimize and control loading of transit vehicles.

•	 Load by Placement report indicates SKU quantity and configuration for each step.

•	 Improved Import/Export functionality to allow selected data to be transported to and from 
MaxLoad®Pro.

•	 More Language Support: Adds support for Simplified Chinese, Traditional Chinese, Portuguese 
and Thai.

Version 2.6x

•	 Improved stop-off handling

•	 Color coded orders and rules to force orders to be loaded together

•	 Assign number of units to SKU as piece count

•	 Nest and stagger drums, pipes and rolls in a container

•	 New export options, Export by Placement and Export to XML

•	 New Import options, Import XML, Import Piece count

•	 Split door and side door loading for Rail Cars

•	 Added “Save to Library” feature

•	 Added “Bundle SKUs” feature

•	 MaxLoad®Pro self cleans the database for SKUs not used for days, months, or years

•	 Enhanced reports

•	 Better loading algorithms, load for efficiency and/or by speed

•	 Increased stacking rules for loading along with preferred stack sizes

Version 2.5x 

•	 Improved loading of mixed pallets for increased stability and stackability

•	 Improved order handling

•	 Improved algorithms

•	 Improved “Maximum Axle Weight” calculations

•	 Added railcars

•	 E-mail reports directly from MaxLoad®Pro using the default e-mail client

•	 Load a tote manifest

•	 Load a mixed pallet manifest (a specific collection of SKUs placed on a pallet)

•	 New global security settings in the Global Settings dialog box

•	 “Calculate All Vehicles” feature automatically loads trucks to complete a manifest

•	 Right-click feature displays properties information for the selected SKU

•	 Sort data in a column in ascending, descending, alphabetical, or numerical order

•	 “Multiple Truck Summary Report” feature displays a load report for each truck in the solution
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Version 2.x  

•	 Added “Multiple View” feature for printouts

•	 Added three new user specified information fields for  SKUs and manifests

•	 “Copy to Clipboard” feature allows the user to copy 3D views generated in MaxLoad®Pro 

•	 “Paste-On Graphics” feature allows the user to paste bitmap images onto the sides of individual 
SKUs

•	 Added “Colored Outlines” feature for printouts

•	 Activated user passwords

•	 Added Axle weight calculations

•	 Updated Italian translation

•	 Improved online help.  The MaxLoad®Pro manual is now available through online Help

•	 Improved manual editing of truck and mixed pallet manifests

•	 Less cluttered screens.  MaxLoad®Pro now allows the user to turn of some columns that they do 
not use.
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1 Getting Started

This chapter covers the following topics to get you up and running on the MaxLoad Pro system.

System Requirements/Specifications

•	 Standard MaxLoad
•	 MaxLoad for SQL/Oracle

Installing MaxLoad Pro

•	 Important Notes
•	 Installation Procedure
•	 License Setup
•	 Setup Client Machines for Network License
•	 LAN and WAN Explained

Starting MaxLoad Pro

Registration Information

Add a New User

Viewer Mode

Installing and Moving License

By the end of this chapter, you should be logged into the system and ready to use the software.

System Requirements/Specifications
Standard MaxLoad

To install and run the MaxLoad Pro software, your system needs to meet the following requirements:

•	 Platform:  Windows 7, 8 and 10 – both 32 and 64 bit

•	 Network:  Any network is compatible.  MaxLoad Pro is not network-protocol dependent; it 
only needs a file server

•	 Processor Required:  Any processor capable of running the installed platform.  Recommended  
Pentium 133 MHz or better

•	 Hard Disk Space Required:  50 MB

•	 RAM Required:  64 MB or more recommended

•	 Video Required:  800 x 600 at 256 colors recommended

Network Information:  MaxLoad Pro is installed from a client to the file server.  MaxLoad Pro and 
DirectX usually do not take more than 50 MB space on the file server, depending on the database 
size.  DirectX is copied to the file server for install on client(s) that do not have DirectX.  Most 
Windows clients come with DirectX.   Individual workstation’s hard disk space requirements will 
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vary.  They will have the support files for DirectX and DAO installed that their machine lacks and the 
program will be run from the network.
 
The software internally manages concurrent user licensing.  No third party metering of the software 
is required.  Licensing can support an unlimited number.  The software has been tested with up to 30 
concurrent users.  Provisions are in place for distinguishing between viewers of old/completed work 
and generating new work. Those who access the software in View Only mode do not count against 
the concurrent user limit. 

Software Design:  The MaxLoad Pro uses 32-bit code.  Work is stored as database records instead of 
individual files, using DAO (MS Access).   For import/export of data, MaxLoad Pro uses ASCII comma 
Delimited text files or csv- comma separated values file and XML, compatible with most document 
management systems, spreadsheets, databases and mainframes, including Excel, Access, AS400, and 
UNIX platforms. 

MaxLoad for SQL/Oracle
For Microsoft SQL server 2000 and above, Oracle server 9i and above.

Client Requirements

•	 Processor: Pentium III 450 MHZ or better

•	 RAM: 128 MB or more

•	 Hard Disk Space: 50 MB

•	 Video Required:  800 x 600 at 256 colors recommended

•	 Client Operating System: Windows7, 8 and 10

•	 DirectX: 6.0 or above

•	 OLE DB Provider: No additional component required for MS SQL Server.  Oracle client full 
installation is required to setup the Oracle OLEDB provider if the database server is Oracle.

•	 Database component: MDAC 2.8 or above

Please note this is already built into Windows XP and Vista. It only needs to be installed for earlier 
version of Windows.

�� Note: MaxLoad Pro does not require Microsoft .Net platform but can work on any PC 
with Microsoft .Net platform.	

Installing MaxLoad Pro
This section will walk you through the installation process and get you logged into the system.  It is 
recommended that a person in the Information Technology department installs the software.

�� Note: If during the installation an error message occurs, please make a note of the error 
message and continue with the installation until it is finished.  Then contact TOPS Technical 
Support for further instructions.

For the latest installation instructions, refer to the instructions  
that comes with your purchase packet or download link email.
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Important Notes

•	 The following instructions apply to both MaxLoad new installation as well as upgrade.

•	 If you are installing or upgrading a network license, please start from the client PC.

•	 Before you begin, make sure you have administrative rights to install to your computer and 
to the network. After setup, user will not need administrative rights but will require full 
permissions to access the TOPSAPPS folder and everything inside it. 

•	 After installation, you MUST contact TOPS via phone or email to complete the license setup. 
Until the license is setup, your MaxLoad software will behave like a demo, with access to 
sample data only.

•	 Have the serial number of your MaxLoad software available when contacting TOPS.  The serial  
number is marked on the front of the CD installer, the CD case and on the Product Registration 
Card.  If you receive your software via email download, the serial number will be referenced in 
the email.

Installation Procedure
1.	 Make sure you have administrative rights to the workstation on which you wish to install 

MaxLoad Pro. If installing a network copy, you will need the same rights on the network drive.

2.	 Close all other applications on that workstation.

3.	 Start the installation process by inserting the MaxLoad Pro CD in the proper drive of the 
machine.  The software setup should run automatically.  If this does not happen, click on the 
Windows Start button and select Run.

  The Run dialog box appears and prompts you to enter a directory path and the program to run.  

4.	 Type D:\SETUP and hit the Enter key on your keyboard (where D: is the CD drive). If your CD drive 
is designated with another alphabet like E or F, please change it accordingly. 

5.	 A window will open for you to select the software you want to install.  Click on “Install MaxLoad 
Pro”.

  
6.	 You will see a welcome message.  Continue installation by clicking on the Next button.
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7.	 Click on “Install to Local PC” if you are installing a stand-alone license.  Click on “Install to Server” 

if you are installing a network version of MaxLoad Pro.  Network version should be installed 
from a client machine to the server.  You can check the sticker on the front of the CD case to 
determine if you have a stand-alone or server copy.

The Backup Replaced Files dialog box appears.

   
8.	 To create backup copies, click on Yes and specify a location where the backup files will be saved.  

Click No if you do not want back up copies of the installation files. When ready, click on Next to 
continue and the Destination Location dialog box appears.
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9.	 You can use the default location to install MaxLoad Pro or click the Browse button to specify a 

new location.  Click on Next to continue.

•	 Stand-alone License – Use the default folder of C:\Program Files\TOPSAPPS\ or click the 
Browse button to specify another folder on your computer. 

•	 Network License – Click the Browse button to select the mapped drive of the server from the 
client machine.  
Note that you will need to run NETSETUP or WANSETUP on each new client machine after 
installation is complete.

 

   
10.	 Click Next to start the installation process. MaxLoad Pro will start copying the files to the 

specified location.  You will see the progression on screen and the following will appear when 
installation is complete.
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11.	 Click on Finish to close the dialog box.

When installation is complete, MaxLoad Pro will create the required shortcuts for the software and 
place those shortcuts on the desktop and under Start | Programs | TOPS for Windows Apps Menu.

You will need to run MaxLoad Pro at this time to finish the License Setup process as described in the 
next section.

License Setup
Until the license has been setup, the newly installed MaxLoad software will behave as a demo – you 
can only open and view existing analysis but not perform new calculations.  To setup the license, 
follow these steps and contact TOPS via email or telephone.

1.	 Start MaxLoad by going to Start | All Programs, select TOPS Apps folder and then click on 
MaxLoad Pro.

You will see the Demonstration Mode Information dialog box as shown below prompting for your 
action. If your license has already been setup, you will go right to the MaxLoad login screen.
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2.	 Click on the “Use E-License” button and the Reset Authorization screen appears. 

  

�� Note:  Until the license is set, the information in the dialog box above does not reflect 
the correct serial number or configuration (Number of Users and Network/Stand Alone). 

3.	 Have the following information ready and call TOPS at 972-739-8677 for license setup:

•	 Company Name – the company name that you’d like to  appear in all reports from MaxLoad

•	 Serial number of your MaxLoad Pro license – this is the serial number in the format of 
12345.x as marked on the front face of your MaxLoad CD, not the serial number shown in this 
dialog box.  

•	 The Key from the above dialog box.

To setup via email, please send an image of the Reset Authorization screen or click the Email 
button for MaxLoad to place the license information in a text attachment. Email either to tech@
topseng.com so the Verification Code can be emailed to you to complete the process. 
 
Note that the Verification Code is time sensitive and needs to be entered within 24 hours to 
complete the license setup process.

4.	 Upon receipt of new serial number and verification code from TOPS, enter them into the Reset 
Authorization dialog box click on the OK button.  Make sure the Company Name is entered 
“exactly” the way provided to you.

If all information is entered correctly, you should see a message saying “MaxLoad License 
successfully set”.
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5.	 Click Ok again to close the Reset Authorization dialog box.  The Defaults dialog box appears

  
6.	 Select the default settings for MaxLoad:

•	 Units – Select from the drop list the units of measure.

•	 Language – Select from the drop list the language used for MaxLoad user interface.

•	 Logo Path – Click the Browse button to specify the location of your company logo to be used 
all reports from MaxLoad. 

�� The logo should be a BMP file of size less than 256x256 pixels, 256 colors (8-bit graphics)

•	 Apply to existing users – Check this box to apply the defaults to all existing users.

•	 Apply to new users – Check this box to apply the defaults to all new users from this point on.

When all selections are made, click on the OK button.

The MaxLoad Login screen appears.  The software is now ready for use.  Please refer to the section 
“Starting MaxLoad Pro” and later chapters on how to use the software.	
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Setup Client Machines for Network License
After the license has been properly setup, you can now proceed to setup MaxLoad access on any 
client machine.

Note that all users should have Full Control (read and write) access to the TOPSAPPS directory on the 
network.

1.	 Make sure you have administrative rights to the workstation you wish to set up MaxLoad Pro on.

2.	 Permanently map a network drive to the location on the server, where you installed MaxLoad 
Pro.  

3.	 Browse across the mapped network drive to the Max2Pro directory.  Run the NETSETUP.EXE file 
for a LAN (Local Area Network) install and WANSETUP for WAN (Wide Area Network) install, 
respectively.

4.	 NETSETUP / WANSETUP will verify that there is a valid version of DirectX installed on the local 
PC, create a local Maxload2.ini file and place it in the Windows directory.  It then creates the 
required shortcuts for the software and place those shortcuts on the desktop and under Start | 
Programs | TOPS Apps Menu. 

WAN and LAN Explained
A LAN (Local Area Network) install is a network install where the data and software files are 
stored on a shared server.  Client machines then connect to the server through shortcuts and run 
all processing on the client side. When you run NETSETUP, MaxLoad will copy over the shortcuts, 
.INI file and all .DLL files needed for the software to run (it will also check to ensure you have the 
minimal version of DirectX).  Once the install is done and you click a shortcut, the software will find 
the .INI file which tells it where to find its database and executables.  These will then point across 
the mapped network drive (or UNC path) and the software will run, with the processing load being 
entirely on the client side. 

A WAN (Wide Area Network) install differs from a LAN install by copying also all executables and 
support files to the local client.  This way when the software runs, there is no lag in starting the 
executable file.  The only lag then is in reading data from the server.  The WAN setup can be used 
for customer having multiple locations in different cities, but wants to maintain a single database. 
(This may not work for all situations, depending on the customer’s network bandwidth, it may be 
too slow).  Another situation well suited for the WAN install is a slow LAN.  If the LAN the customer 
is using is slow for some reason, they may use a WAN setup to speed up the responsiveness, even on 
the local network.
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Starting MaxLoad Pro
To start MaxLoad Pro, double-click on the MaxLoad Pro icon on the desktop (if you have one), or 
go to Start | All Programs, go to the TOPS Apps folder and click on MaxLoad Pro.  The Login screen 
appears, as pictured below.

Notice the default user list in the login screen: Export Department, Supervisor and Traffic 
Department.

�� Note:  The Supervisor login is password-protected (password is “tops software”).  Log 
in as a Supervisor only if you’re performing Configuration functions.  For more information, 
please refer to Chapter 11, Configuration.

Select the user group you belong to and click on the Login button and the MaxLoad Pro Control 
Center appears, as pictured below.  Note that you can also add a new user to the list, see page 13.
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The MaxLoad Pro Control Center serves as your starting point in the system.  From the Control 
Center, you can start or create one of four types of manifests:  Truck, Pallet, Tote and Single-SKU.

•	 The MaxLoad Pro Control Center is discussed in Chapter 2, The Basics.

•	 The Truck Manifest is discussed in Chapter 4, Loading a Truck Manifest.

•	 The Pallet Manifest is discussed in Chapter 5, Loading a Pallet Manifest.

•	 The Tote Manifest is discussed in Chapter 6, Loading a Tote Manifest.

•	 The Single-SKU manifest is discussed in Chapter 7, Loading a Single-SKU Manifest.

Registration Information
The About MaxLoad Pro information box, pictured below, provides important information regarding 
your MaxLoad Pro license.  To access this box, open the Help menu and select About MaxLoad.

 

The About MaxLoad information box displays the following information:

•	 MaxLoad Pro Version:  Shows the version of MaxLoad Pro you are currently running.

•	 Registered to:  The name of the company or organization the software is licensed to. This is the 
same Company Name that you enter when you setup the license under the Adjust Authorization 
function.

•	 Serial Number:  This is the software serial number.  It is unique for every customer.  Whenever an 
issue is reported to technical support, the serial number is the first thing needed. Provide to us 
the first 7 digit of the serial number when calling TOPS for assistance.

•	 Current User:  Lists the login name of the current user.

•	 Security:  Displays the security method used to install the license.
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•	 Custom:  Reflects if any custom programming was done.

•	 Date:  The build date of the current MaxLoad executable file.

•	 INI Path:  Indicates the location of the INI file for the current login user.

•	 App Path:  Indicates the location of the MaxLoad executable file.

•	 Data Path:  Indicates the location where all the MaxLoad data are saved.

•	 TOPS Contact Info:  TOPS Engineering Corporation address, phone number, e-mail address, and 
website address.

Notice that the About MaxLoad information box contains two buttons:

•	 OK Button:  Closes the About MaxLoad Pro information box.

•	 System Info button:  Displays the System Information box, as pictured below which provides 
a range of technical system information and allows you to print, save or email the system 
information.  

The System Information box displays the following information:

1.	 Date:  Current system time.

2.	 Operating System:  Machine operating system and build number.

3.	 Processor:  Processor manufacturer.

4.	 Memory:	  Amount of memory being used. 

5.	 Windows Directory:  Operating system’s default directory, usually Windows.

6.	 Common Files directory:  Location of System (Windows) common files folder.

7.	 Windows User Name:  Name of the user currently logged into the Windows system.
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8.	 Computer Name:  Machine name as it appears on the LAN.

9.	 Video Card:  Style of video adapter.

10.	 Bits Per Pixel:  Screen color depth and resolution.

11.	 DirectX Version:  It tells the version of directX being used.

12.	 MaxLoad Serial Number:  Software serial number.  

13.	 Valid License:   If the user is running a sale or demo license.

14.	 Expiry Date:  This applies to MaxLoad Pro demo.  Reflects the date MaxLoad Demo will expire.  If 
this is a sales copy, it shows “Never”.

15.	 Execution Count Left:  This applies to MaxLoad Pro Demo.  Reflects the number of executions 
left before the demo expires. For a sales copy, it shows “N/A”

16.	 Executable Location:  Provides the location while the MaxLoad executable file is saved.

17.	 Command line Parms:  Lists any command line option on your copy of MaxLoad during program 
startup.

18.	 Default Printer:  Reports the default printer being used.

19.	 Primary Network:  Type of the network the user logs into.

20.	 Network Login Name: It is the username that the user logs in under onto the network.

21.	 INI Path:  INI path points to the location of the maload2.ini file.  Maxload2.ini file tells the 
software where to find the data, license, and other required files.

22.	 App Path:  Points to the location of the license files.

23.	 Data Path: Points to the location of the max2pro\data directory.

24.	 Stack Matrix Path:  Location of the StackMat.mdb (data directory).  

25.	 Defaults Path:  Location of the Defaults.mdb (data directory).

26.	 Language Path:  Location of the language directory which stores all language files.

27.	 Graphics Path:  Location of the *.wmf file used by XML.

28.	 Logo Path:  Location where the company logo is saved.

29.	 Custom:  Show if there is any customization done on your copy of MaxLoad.

Add a New User to the System
No matter whether your MaxLoad Pro is stand-alone or network, or regardless of the number of 
concurrent users, you can add as many user logins as you like in MaxLoad Pro.  To add your name or 
department to the list of user names, follow these instructions:

1.	 Login as a Supervisor. The default password is “tops software” and is case insensitive.

2.	 Access User Login from the File menu.

3.	 When the Login dialog box appears, click on the New User button.

4.	 At the New User dialog box, type in the new user name in the User Name field.
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5.	  The Password and Verify Password are optional fields.  Set a password only if you intend to use 
MaxLoad Pro in a more secure way.

6.	 In the Password field, type in the new user’s password.  

7.	 In the Verify Password field, type in the new user’s password again.

8.	 Click on OK.

MaxLoad Pro adds the new user to the system and returns you to the Login screen.  Notice that the 
user list now displays the name of the new user.

Viewer Mode

The Viewer Mode checkbox at the login dialog box allows you to start MaxLoad Pro in “viewer” 
setting only – where you can only open existing analyses for viewing but not performing new 
calculations.  The Viewer mode will not take up any license seat so there is no limit as to how many 
users login Viewer mode.

For a network license supporting say, only two simultaneous users, a third or fourth user can log in 
using viewer mode to retrieve existing analyses and print reports.

Please note that in Viewer mode, the Calculate button, as well as the New button in each Button 
Window will be grayed out.
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Moving or Resetting License
You will need to contact TOPS for a new Verification Code whenever you are installing MaxLoad. For 
example, you need to make changes to the operating system on your PC, need to move MaxLoad to 
another computer (stand-alone license) or server (network license).  The license will not be migrated 
by copying the installation to another PC.

�� If you have a network license and are making changes to client PCs only, there is no 
need to get a new license code. All is required is to browse from the client PC to the network 
share where MaxLoad was installed and run NETSETUP.  This will copy necessary files from 
the network install to the client PC to access MaxLoad.

Each MaxLoad license, stand-alone or network, can only be installed on one single PC or network file 
share/server.  Multiple installations of the same license, as identified by the unique serial number 
before the decimal point marked on the software CD or the first seven (7) digits of the long serial 
number under Help | About screen, is a violation of the MaxLoad end user license agreement.
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2 The Basics

This chapter presents the basic features and functions of the MaxLoad Pro system.  This overview 
will acquaint you on how to navigate the program with the following topics:

Control Center

•	 Button Windows
•	 Version and Registration Information
•	 Menu Bar
•	 Tool Bar (Standard)

Common Features

•	 Tab System
•	 Graphical Online Drawing (g.o.d.) System
•	 Sort Function
•	 Direct E-mail

Open an Existing Manifest

•	 Filter (Manifests)
•	 Combine (Manifests)
	
Exit MaxLoad Pro 
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Control Center
Control Center is the starting point for working in the MaxLoad Pro Software.  This is the first screen 
that appears after you login to the software.  From the Control Center, as pictured below, you will 
choose to either open an existing manifest or create a new manifest. 

 

�� Note:  From anywhere in the system, you can access this screen with this Menu Bar 
command:  File | Close.

Notice the following components on this screen:

•	 Button Menus:  The four button groups provide shortcuts to allow you to create a new manifest 
or open an existing manifest.  

•	 Version and Registration Information:  Displays the version number and registration information 
for your copy of MaxLoad Pro.  

•	 Menu Bar:  Contains seven drop-down menus that allow you to perform common tasks.  

Button Menus
The four button menus are designed as shortcut buttons to open existing or create new manifests.  
Each contains an Open button and a New button.  Note that the New button will be grayed out if 
“Viewer Mode” is enabled during login.

Open Button:  The Open button displays the File Open dialog box, which contains a list of all 
manifests that have already been defined for a manifest type.  

New Button:  The New button opens the Manifest Pick List screen, which allows you to create a new 
manifest for the respective manifest type.  
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Control Center
Control Center is the starting point for working in the MaxLoad Pro Software.  This is the first screen 
that appears after you login to the software.  From the Control Center, as pictured below, you will 
choose to either open an existing manifest or create a new manifest. 

 

�� Note:  From anywhere in the system, you can access this screen with this Menu Bar 
command:  File | Close.

Notice the following components on this screen:

•	 Button Menus:  The four button groups provide shortcuts to allow you to create a new manifest 
or open an existing manifest.  

•	 Version and Registration Information:  Displays the version number and registration information 
for your copy of MaxLoad Pro.  

•	 Menu Bar:  Contains seven drop-down menus that allow you to perform common tasks.  

Button Menus
The four button menus are designed as shortcut buttons to open existing or create new manifests.  
Each contains an Open button and a New button.  Note that the New button will be grayed out if 
“Viewer Mode” is enabled during login.

Open Button:  The Open button displays the File Open dialog box, which contains a list of all 
manifests that have already been defined for a manifest type.  

New Button:  The New button opens the Manifest Pick List screen, which allows you to create a new 
manifest for the respective manifest type.  

Truck Manifest Button: This is the most commonly used button and allows you to 
load multi-size and shape SKUs into a vehicle.  This window can also be used for 
single-size SKUs.

 

Pallet Manifest Button: The Pallet Manifest button window allows you to perform a 
mixed-pallet loading analysis.  

 

Tote Manifest Button: The Tote Manifest button window allows you to load mixed 
items into a tote.  

Single SKU Button: The Single SKU button window allows you to determine
the exact quantity of single-size SKUs that will be loaded to cube out a vehicle.

 
Version and Registration Information

The lower right-hand corner of this screen displays the following information:

•	 Version Number and Registration Information:  Refer to this number if and when you call the 
TOPS Software Technical Support Department.

•	 Executions Remaining:  If you’re running a demo version of the software, this tells you how many 
more times you can execute the software.
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Menu Bar
The Menu Bar provides a number of drop-down menus.  These menus provide options that allow 
you to perform common tasks, many of which are duplicated on the Toolbar.

The Menu Bar is comprised of the following menus:

•	 File Menu:  Allows you to create new manifests, open existing manifests, save manifests and set 
up print parameters for different reports.

•	 Edit Menu:  Allows you to undo or redo your most recent action in the Editor, as well as copy text 
and images to the Windows clipboard.

•	 View Menu:  Allows you to view loading solutions in a number of formats:  by placement, by 
leading edge, by priority.  It also allows you to view the Stacking Violations list to verify that 
you’ve not violated any stacking rules.

•	 Define Menu:  Allows you to define parameters for a new SKU, Tote, Pallet, Vehicle or Stack 
Matrix.

•	 Tools Menu:  Allows you to revise your system configuration, system language (MaxLoad Pro 
is used worldwide) and user list.  It also allows you to import and export work to and from the 
system.

•	 Layout Menu:  Allows you to work with a number of Align and Snap tools as you position SKUs 
onto a pallet.

•	 Help Menu:  Allows you to display Help information for all features and function in the system.

This Menu Bar remains consistent throughout the entire MaxLoad Pro system.  Each screen that you 
work with contains the same seven menus.  However, be aware that depending on the individual 
screen that you’re working in, the list of commands (sub-menu choices) changes or becomes tailored 
to reflect that individual screen.  Menu options that cannot be accessed at the moment are disabled 
(“grayed out”).

Toolbar (Standard)
The Toolbar, as pictured below, contains icons that perform individual MaxLoad Pro commands and 
offer shortcuts that simplify commands.  Oftentimes, you can click on an icon once to complete a 
command, rather than click two or three times using the Menu Bar.

When you place the mouse cursor over the tool button, MaxLoad will show a small context box 
telling you the function of the current tool icon.
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This table outlines the Toolbar icons.

Icon Function

New:  Displays the Manifest Pick List screen, where you can begin work on a 
new manifest.

Open:  Displays the File Open dialog box, which allows you to open an existing 
manifest.

Save:  Saves the active manifest.  

Import: Imports a generic list of SKUs or order list.

Export: Opens a submenu for the user to export the Solution, Placement or 
Load List or air bag list to a flat text file like CSV.

Cut:  Cuts a selected graphic or block of text and moves it to the Windows 
clipboard.

Copy:  Copies a selected graphic or block of text to the Windows clipboard.

Paste:  Pastes a selected graphic or block of text onto a working area of the 
screen.

Print:  Prints a hard copy of a loading solution.  

About:  Opens the About MaxLoad dialog box to display software license 
information.

Help:  Accesses the online help system.

Units: Switches measurement units from English to Metric and vice versa.

Every icon found in the Toolbar has a corresponding Menu Bar option.  The Toolbar changes 
depending on the screen in which you’re currently working.  The sample Toolbar shown above is 
found in the Manifest Pick List screen.  We chose this Toolbar because most of the icons on this 
Toolbar are common to other Toolbars.  The Manifest View screen and the Editor screen each have 
their own Toolbars.  Each Toolbar is described in detail in their respective chapters.

Common Features
Some features that are used throughout the MaxLoad Pro system are categorized as the Common 
Features. The primary common features include the following:

•	 Tab system

•	 Graphical Online Display (g.o.d.) system

•	 Sort function

•	 Direct E-mail
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Tab System
MaxLoad Pro uses tabs throughout the system.  Tabs allow you to quickly and easily switch back and 
forth between different data entry areas or sub-screens.  For example, the Manifest Pick List screen 
contains four tabs, as pictured below, which provide five different sub-screens – Vehicle, Options, 
Mixed Pallet, Comments and Weights.  Similarly, on the Define SKU screen, three tabs allow you to 
move easily between Size, Stacking and Graphics sub-screens.

 

Also, notice that all command buttons – in the figure above, View, Calculate and Help – are available 
on each tab.  To switch between tabs, simply click on the appropriate tab and the new sub-screen 
will appear.

Click the left arrow button at the top right corner to show the Vehicle tab which is not visible if you 
are at the Weight tab.

Graphical Online Drawing (g.o.d.) System
The Graphical Online Drawing (g.o.d.) system is referred to throughout this User’s Guide as the g.o.d. 
system.  The g.o.d. system provides a 3-dimensional image of various objects, as pictured below.  The 
g.o.d. feature is most commonly found in the Define screens (Manifest, SKU, Pallet and Vehicle), but 
is also available in the Create Unit Load screen and the Manifest Pick List Screen.
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The g.o.d. system helps you define objects by illustrating the characteristics of the item – length, 
width, height, etc. – as you define it.  For example, in the Define Manifest screen, the g.o.d. feature 
displays a visual of the vehicle you’ve selected for the manifest.  This gives you a visual confirmation 
of the vehicle before you exit the screen.  The g.o.d. system also shows color choice, if applicable.

Notice that the g.o.d. system contains four buttons at the top of the pane:

•	 3D Button:  Displays a 3-dimensional view of the item.

•	 Top Button:  Displays the item from the top.

•	 Side Button:  Displays the item from the side.

•	 Front Button:  Displays the item from the front.
		

Sort Function
MaxLoad Pro uses a number of lists to display information for a manifest:  SKU List, Manifest List, 
Solution List, Placement List, Load List, Cut List, etc.  Each of these lists is comprised of columns that 
contain data.  The sort function allows you to sort the data in these columns.

For numeric data – quantities, weight, cube percentage – you can sort data in a column in ascending 
or descending order numerically.  For alpha data, such as a list of SKUs (barrel, bulk frozen yogurt, 
computer, etc.), you can sort data in a column in ascending or descending order alphabetically.

To sort data in a column, follow these instructions:

1.	 For the column you want to sort, click on the column heading.  For example, on the View 
Screen’s Placement List, if you want to sort data in the Quantity column, simply click on the 
Quantity (Qty) heading.  The heading works like a button.

MaxLoad sorts the Quantity column in ascending order, as pictured below.  Notice that the 
Quantity column reads 1, 2, 3, 3, 12, 15 and so on. 
 

2.	 To sort data in the Quantity column in decreasing order, click on the column heading again and 
MaxLoad sorts the Quantity column in descending order, as pictured below.  Notice that the 
Quantity column now reads 33, 27, 24, 18 and so on. 
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Direct E-Mail
This function allows you to e-mail any of the print reports or a manifest directly from MaxLoad Pro 
via your default e-mail application.  To setup your email client:

1.	 Go to the Tools | Configuration menu and click on the E-Mail button. 

2.	 At the Email Options dialog box, select the E-Mail option you are using and set up the 
corresponding data.

  

To e-mail a report from MaxLoad, start from the Print Preview Screen and follow these instructions:

1.	 Click on E-Mail on the menu bar.

2.	 Select the between JPEG or PDF formats. The system launches your default e-mail application 
and attaches the selected report in the format selected.

3.	 Enter the e-mail address where the report will be sent.

4.	 Send the e-mail.

�� Note:  The e-mail function is built into the Print Preview Screen throughout the MaxLoad 
Pro System.

To e-mail a manifest, follow these instructions:

1.	 Open the manifest to be emailed.

2.	 Click on Tools menu and select Email MFT. The system launches your default e-mail application 
and attaches the selected report as a TXT file.

Opening an Existing Manifest
To open an existing manifest, follow these instructions:

1.	 Use one of two options:

•	 From the MaxLoad Pro Control Center, click on the Open button on one of the button 
windows.

•	 Or open the File menu and select Open.

The File Open dialog box appears, as pictured below, with a list of all existing manifests for a 
selected manifest type.  The following figure displays a list of existing vehicle manifests.
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Remember that manifest names are associated with specific login names, which you choose 
during the login process.  Therefore, if you login as Export Department, the Open Manifest dialog 
box will display only those manifests that were originally created under the Export Department 
login name.

An exception to this is that if the Supervisor has enabled the “Share MFT” option under Global 
Configuration, then each user will see one another’s works.  See page 193 in Chapter 11 for 
more information.

2.	 Notice the manifest-type buttons – Vehicles, Pallets, Totes and Single SKUs, on the right-hand 
part of the dialog box.  Click on the button that corresponds to the type of manifest you want to 
open.  For example, to see a list of existing vehicle manifests, click on the Vehicles button.

3.	 Click on a manifest name to select it.  In this example, we’ll select Appliance Load. MaxLoad Pro 
automatically inserts the manifest name in the field at the top of the dialog box.

4.	 Click on OK.  Note that you can also double click on the manifest name to open the manifest 
directly

The Manifest Pick List screen appears, as pictured below, with information for the selected 
manifest.  Notice that the title bar of the Manifest Pick List screen shows the name of the 
selected manifest – Appliance Load.



26 | MaxLoad®Pro User Guide v4.0

�� Note:  If option “View On Open” under Tools | Configuration is enabled, MaxLoad 
will open the graphical load solution directly instead of the Manifest Pick List Screen.  See 
Chapter 11 – Configuration for more information.

Preview (Manifest)

�� The Preview button is grayed out unless the CalcAllTrucks option is enabled. To turn 
on this function, login as Supervisor, go to Tools | Configuration. Click on the Global 
button to open the Global setting dialog box to access this option. See page 193 for more 
information.

The Preview option allows you to open a manifest and view all the loaded containers/trucks at the 
same time.  To use this function:

1.	 Go to the File | Open menu.

2.	 Highlight a Manifest to preview and click the Preview button. 

3.	 The Solution View screen, similar to one shown next, will open.

4.	 The “film strip” view on the left shows thumbnail images of each loaded container in the 
manifest.  
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Once in the Preview screen, you can edit the load in each container or use Split Edit to move 
SKUs between two selected containers.  Remember to save any changes to the existing manifest 
or to a new manifest.

To exit out of Preview mode, click the (X) button on the upper left corner of the film strip.  The 
thumbnail images will be replaced by the standard statistics and function buttons of the solution 
screen.

Filter (Manifest)
If you have lots of manifests saved in MaxLoad, the Filter button allows you to tell MaxLoad to 
display only the manifests which meet the conditions selected.  You can specify among Manifest 
Name, User, Customer Name and a date range when the manifests were last saved.

MaxLoad offers two ways to filter manifests, via the Filter button or via the right click local menu.

Using the Filter button:

1.	 Click on the Filter button to open Filter Options.

2.	 Check against the fields to be used as filter(s)  and enter the match strings.  
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When the manifest filter is enabled, the filtered field options are highlighted with a corresponding 
check mark. You can quickly clear all filters by clicking on the Clear All button.

Using the Right Click Local Menu:

This method allows filtering based on one single criterion only.

1.	 At the manifest list box, highlight the manifest which contains the condition of the filter.

2.	 Click the right mouse button to open the local menu and select the filter field.

  

The above filter will display manifests created by the Export Department if the filter field is User. If 
Delivery Date is the filter field, only manifests with a delivery date of 08/15/2008 will be displayed.

Combine (Manifests)
The Combine button allows you to combine two or more manifests into a single one.  Only the pick 
lists are combined, you will have to click the Calculate button to find a new loading solutions for the 
combined SKUs and quantities.

To use this function, follow these steps:

1.	 Open the File Menu and select Open.

2.	 While holding down the ‘Ctrl” button on the keyboard, click on the names of the manifests to be 
combined.

3.	 When ready, click on the Combine button. 

4.	 The Combine Manifest Options button appears. Click to specify whether to combine the 
manifests by using Priority or by Stop Off and click on OK

  
5.	 Enter a name for the new combined manifest which now contains all the SKUs, corresponding 

quantities and load priorities or stop numbers (if applicable) of the individual manifests. 
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The new manifest will be added to the manifest name list in the File Open dialog box.

When you open the new combined manifest, you will need to click the Calculate button to find a 
new loading solution for the combined SKUs and quantities.

Saving an Existing Manifest
To save a manifest, go to the File menu and select Save or Save As.  The File Save (As) dialog box, 
similar to the File Open dialog box, opens with two special options as described next.

Save as SKU
This option is only available for Pallet and Tote manifests where you can save the solution as a Pallet 
SKU or Tote SKU in the database to be used in Truck manifests. This serves the same function as the 
File|Save Manifest as SKU menu function.

     

•	 SKU: Enter the name of the Pallet (Tote) SKU.

•	 Manifest: Name of the current manifest.

•	 Weight: Calculated weight of the pallet or tote manifest based on its contents and weight of 
pallet or tote.

•	 Don’t show this again:  Check this box to use the calculated weight for the SKU.  To use  a 
different weight, leave box unchecked and click OK.  The dialog will be refreshed as shown on the 
right with these updates:

»» New SKU name appended with “-N” where N indicates the number of pallets when there are 
multiple pallets (totes) in the manifest.

»» The calculated weight. You can change the weight (285 lb in above example) to a new value, if 
desired, to account for packaging materials or other accessories.



30 | MaxLoad®Pro User Guide v4.0

Once the SKU is saved, this is how it appears in the Define|SKU menu.  Note the name, description 
and dimensions for the SKU.  You can change the name and description but not dimension and 
weight.

Save to Lib
The Save to Lib function gives the user the flexibility to save edited loads to library. If later they 
replicate a load, MaxLoad Pro will show the saved edited load as one of the solutions in the Sol List.

Exiting MaxLoad Pro
To exit MaxLoad Pro, follow these instructions:
1.	 Open the File menu and select Exit.

2.	 If you’ve made any changes since you last saved the active file, MaxLoad Pro will prompt you to 
save the file.  

3.	 If you need to save any changes, click on Yes. MaxLoad Pro saves your changes and closes down 
the MaxLoad Pro application.
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3 Defining MaxLoad Databases

As you set up the MaxLoad Pro system and prepare to use it in your daily operations, one of the 
most critical functions is setting up the various databases.

Before we begin this chapter, it is important to remember one critical fact:  A computer does not 
think like a human.  Therefore, it’s imperative that all inputs and measurements be precise.  For 
example, think of a space as tiny as 1/16 of an inch.  While you and I may think nothing of such a 
small number, and certainly would not think it could affect the way a truck is loaded, MaxLoad Pro 
thinks otherwise.

For a computer, everything is “black and white.”  An object will either fit or it won’t.  Let’s take a 
truck that is 99” wide.  Suppose you want to place three refrigerators side by side across the nose of 
the truck; each refrigerator is 33-1/16” wide.  A quick calculation shows that 3x33-1/16 equals 99-
3/16, which is greater than 99”.

Therefore, MaxLoad Pro will not place these refrigerators side by side.  If you ever run across a 
situation like this, double-check the dimensions of both your truck and your SKU.  Are they exact 
dimensions?  Also, remember that humans may tolerate a “fudge factor.”  Perhaps the person 
loading the truck will make these refrigerators fit.  MaxLoad Pro, however, will not.

When you define databases in the MaxLoad Pro system, you’ll always start with the Define Menu, 
located on the Menu Bar.  You can use either the mouse or the Tab key to move around within each 
screen.

This chapter walks you through how to define databases and stack matrix:

Define Data Base

•	 Stock Keeping Unit (SKU) including creating unitload and bundle
•	 Pallet/Slipsheet
•	 Vehicle
•	 Tote

Stack Matrix

Of course the more practical and accurate way to setup MaxLoad’s master 
database including SKUs and Vehicles is to import existing data. This will 

be covered in Chapter 12.
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Stock Keeping Unit (SKU) Database
The Define SKU screen allows you to define a new SKU or modify an existing SKU.  In this screen, 
you enter SKU parameters and save it to the SKU database.  Start from the Menu Bar and open the 
Define menu and select SKU.  The Define SKU screen appears, as pictured below.

The Define SKU Screen is comprised of the following components:

•	 Size Tab: Allows you to define the dimensions of the SKU.

•	 Stacking Tab: Allows you to define loading parameters for the SKU.

•	 Graphics Tab: Allows you to assign graphics on the SKU.

•	 g.o.d. Window: Displays a 3-dimensional graphic image of the SKU.

•	 Close Button: Closes the Define SKU screen and returns you to the previous screen.

•	 Save Button: Allows you to save changes to an existing or a new SKU.

•	 New Button: Allows you to define/create a new SKU.

•	 Delete Button:  Allows you to delete a SKU from the database.

•	 Create UL Button: Allows you to create a unitload for a shipcase or a drum SKU.  A unitload is a 
collection of single-sized items loaded onto a pallet.

•	 Bundle Button: Creates preferred bundle sizes for thin, flat SKUs like sheetrock, wood planks, 
metal sheets. This will be discussed further later in the chapter.

•	 Help Button:  Clicks this button to access the on-line help information in this topic.

�� Note: The Tab key allows you to easily move forward to the next field.  To move 
backward to a previous field, use the Shift and Tab keys simultaneously.

Size Tab (Define SKU)
The Size tab allows you to define the dimensions of a SKU.  This is where you will name the SKU and 
enter the required dimensions for the SKU.  You will also start to define specific loading parameters 
in this screen.

•	 SKU Style: MaxLoad Pro allows you to define five types of SKU’s: 

»» PalletLoad: A PalletLoad is a SKU that represents an entire unitload.  It’s beneficial to define a 
SKU as a unitload any time you want to show a single object loaded onto a pallet or slipsheet.  
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For example, you might receive a complete palletload of product from a supplier.  Rather then 
referring to the palletload as 50 cases of peanut butter, you can refer to it as one pallet of 
peanut butter.  If you do want to show 50 cases of peanut butter loaded onto a pallet – and 
have some say in the pallet pattern used when building the unitload – define the SKU as a 
shipcase or drum, then create a unitload for the SKU.

          	          

The above examples show PalletLoad SKUs on pallet with and without overhang and on a slip 
sheet. The dimensions entered represent the dimension for the overall palletload including the 
pallet.

»» Shipcase:  A rectangular or square object to be referred to as an individual item.

»» Drum:  A cylindrical object to be referred to as a single item.

»» Tote SKU:  A Tote SKU can only be created by saving a Tote Manifest via the File | Save 
Manifest as SKU function, as indicated by the dimension and weight fields being grayed out.  
You can, however, define the orientation of the Tote SKU using this menu. 

»» Pallet SKU:  Similar to the Tote SKU, the Pallet SKU can only be created by saving a Mixed 
Pallet Manifest via the File | Save Manifest as SKU function. However, you can define the 
orientation of the Pallet SKU in this dialog box.

»» L Shape:  Any L-shape object like chair, sofa or similarly shaped items.

»» Trapezoid:  Any trapezoid shaped items.

•	 SKU Number: The SKU Number field is alphanumeric and holds up to 32 characters.  Each SKU 
must have a unique number or name.  SKU numbers are sorted numerically and/or alphabetically 
in a database within MaxLoad Pro. To display and access a list of existing SKU’s, click on the down 
arrow to the right of the field.  If you select a SKU from the predefined list, the information for 
that SKU will automatically fill in the screen.

•	 Description:  The Description field is also alphanumeric.  This field holds up to 50 characters and 
allows you to give your SKU a more easily recognizable name.  This field is optional and does not 
need to be filled in if you feel the SKU number provides an adequate description.

�� Note: The SKU Number and Description fields are found in the Sizing, Stacking and 
Graphics tabs.  Changes or additions on one tab are automatically transferred to the other 
tabs.  This also means that you can begin defining a SKU from any of the three tabs.

•	 Pallet: The Pallet field is only available when you’re defining a PalletLoad SKU.  You can choose 
from multiple pallet/slipsheet styles from the drop down list. MaxLoad Pro will draw a single 
block to represent a unitload on top of the pallet.  If the pallet or slipsheet is not present in the 
list, you can define a new one in the Define Pallet screen.

•	 Color: MaxLoad Pro uses the standard (48-color) Windows Color Selection dialog box, which 
allows you to select a custom color for each SKU. However, MaxLoad Pro also allows you to 
override the designated color of the SKU when it is drawn. You can check the color currently used 
for an SKU by looking at the color box located in the lower portion of the Size tab.
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To change the color of an SKU, follow these instructions:

1.	 Click on the color box. The Color Selection dialog box appears.

2.	 Click on a color to select it.

3.	 If the color is correct, click on OK. The Color Selection dialog box closes.  MaxLoad Pro 
assigns the selected color to the SKU.

•	 Dimensions and Weight: You’re required to enter values for Length, Width, Height and Weight for 
the SKU you’re defining.  You must enter values in each field.  The Weight field is optional and can 
be set to zero.  Be aware that if you choose to do this, MaxLoad Pro will not calculate accurate 
weight values – total weight, weight efficiency and estimated axle weights – for your load.

Many industries have different opinions on how to define length, width or height.  As a rule of 
thumb, the packaging industry defines height as the dimension that runs through the case flaps.  
In other words, if SKU height is set vertical, the case flaps will always face up or down.

Extending this definition, length is defined as the largest dimension of the remaining two 
dimensions. Width would then be the last dimension undefined.  Keep in mind that this is a 
general rule used in the packaging industry; your industry may be different.

•	 Diameter (Drum):  When you are defining a drum style SKU the length width dimensions get 
replaced by diameter.  Here you enter the width of the cylindrical SKU.

•	 Maximum Overhang: Maximum Overhang represents the distance the SKU can overhang the 
SKU placed beneath it.  The overhang can be defined by the length, width, and diameter of the 
SKU/load.  In case of Maximum Overhang by Height, it refers to the distance this dimension can 
overhang when placed on its side.

•	 Allowed Vert:  This field allows you to choose the way the SKU is loaded into a transit container.  
The Allowed Vertical checkboxes tell MaxLoad Pro which dimension is allowed vertical when 
loading.  Check the appropriate box to designate that dimension as vertical.  You can check any 
combination of dimensions to be vertical, or you can designate only one dimension to be allowed 
vertical. 

For example, in many cases, packaging for certain liquids is marked “This End Up ”.  This end is 
usually the top of the shipcase – where the case flaps are located – and therefore you’ll notice 
that the dimension designated vertical is the height.

If your product displays this characteristic, height would be the only dimension allowed vertical.  
If an item has no critical dimensions – and is not marked with a “This End Up” warning – you can 
designate other dimensions (length, width or both) to be allowed vertical.

•	 Preferred Vert: This field is defined as the dimension that must be vertical when loading on the 
floor, if there is such a restriction for your product.  This column contains four radio buttons – 
labeled Length, Width, Height or No Preference – one of which must be selected.

MaxLoad Pro gives you these choices because most boxes usually have one dimension that is 
stronger than the other two.  When the SKU is not being loaded on the floor, MaxLoad Pro will 
first attempt to load an SKU with its preferred dimension vertical.  If this is not possible, it will use 
any of the other Allowed Vertical dimensions.

You’re not required to commit to a Preferred Vertical dimension.  Simply select No Preference.  
Therefore, whenever an SKU is placed on the floor, MaxLoad Pro will evaluate any dimension 
allowed vertical when determining the most efficient placement.  

�� Note: The contents of the Preferred Vertical field are mutually exclusive, meaning that 
you can only choose one Preferred Vertical dimension (or No Preference) from the available 
Allowed Vertical dimensions.
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Further, you cannot choose a dimension as Preferred Vertical if that dimension has not been 
designated as Allowed Vertical (the Preferred Vertical fields will be grayed out).  If you select one 
dimension as Allowed Vertical, that dimension will automatically be selected as Preferred Vertical.

•	 Piece Count:  This field reflects the quantity of items going into the SKU.  Piece Count will be used 
in the Manifest List to reflect the total piece count of items for the specific SKU.

•	 Family: (Not implemented) This field allows you to specify if the SKU is categorized as Frozen, 
Cooled, Dry and Unknown.  MaxLoad uses this information to make sure SKU’s of the same family 
will be are loaded together at specific locations.

•	 L-Shape SKU:

»» Height Base (L-Shape): This represents the height of the seat portion of the SKU.

»» Width Base (L-Shape): This represents the thickness of the back portion of the SKU.

»» Slope (L-Shape):  Check this option when the L-shape SKU has a slope side. 
 

                                     

»» Top Width (Trapezoid):  This represents the width of the trapezoid SKU.

»» Bottom Width (Trapezoid):  This represents the bottom width of the trapezoid SKU.

•	 Trapezoid SKU:

»» Bottom Width: This represents the width on the bottom side of the trapezoid SKU.

»» Bottom Length: This represents the length on the bottom side of the trapezoid SKU.

»» Flip Layers:  This option applies to floor loads only.  When enabled, the SKUs will be stacked 
with alternate layers flipped as shown below. 

	
		    floor loads With Flip layers	                   floor loads Without Flip layers	

Width Base

Height Base

L-shape with Slope
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Stacking Tab (Define SKU)

The Stacking tab allows you to define parameters for stacking the SKU within a vehicle or onto a 
pallet.

•	 Conveyance Options: MaxLoad Pro gives you two options for loading a SKU into a vehicle:

»» Unitize: This option is available only after you’ve created a unitload for the SKU you’re 
defining.  Once you’ve created a unitload, this box will automatically initialize.  When you 
check this box, the SKU will automatically appear with the UL column checked in the Manifest 
List on the Define Manifest screen.  If this box remains unchecked, the UL column will appear 
unchecked in the Define Manifest screen.  In this case, remember that you can always check 
the column when you define the manifest.

»» Put on Mixed Pallet:  This option behaves like the Unitize option.  If you initialize this box, 
its corresponding column (MP) will appear checked in the Manifest List in the Manifest Pick 
List screen.  This means the SKUs that do not make a full unitload will be placed onto a mixed 
pallet, instead of being loaded directly to the floor of the vehicle.

�� Note:  The conveyance options are not available if you are defining a PalletLoad style 
SKU.

•	 Load Into Vehicle: MaxLoad Pro gives you options as to how an item may be loaded into a 
vehicle.  For example, certain SKU’s can be loaded only by a forklift from one direction and this 
can be defined within MaxLoad.

You have three choices on how to load a SKU into a vehicle.

»» By Length:  Loads the length of the SKU parallel with the length of the trailer.

»» By Width:  Loads the width of the SKU parallel to the length of the trailer.

»» Best Fit:  Shows no preference; loads the SKU using the best orientation in relation to other 
items being loaded.

•	 No stacking on tops of sided loaded items: Check this option if you want this SKU not to be 
loaded on top of SKUs that are loaded on their sides.

•	 Dead Stacking Rules: Dead Stacking Rules are guidelines for how MaxLoad Pro will load SKU’s 
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into a vehicle when they’re not placed on a pallet (sometimes referred to as floor-loading).

»» Must Be Stacked On Floor: MaxLoad Pro will disregard any solutions in which the SKU is not 
placed on the floor.

»» Must Not Be Stacked On Floor:  MaxLoad Pro disregards any solutions in which the SKU is 
placed on the floor.

»» Best Fit: MaxLoad Pro disregards the two options above and places the SKU where it’s most 
efficient in relation to other items in the load.

»» Prefer On Floor:  MaxLoad Pro will place the SKU on the floor if given the choice of either 
placing it on the floor or on top of another SKU.

»» Prefer On Top: MaxLoad Pro will place the SKU on top of another SKU if given the choice of 
either placing on the floor or on top of another SKU.

•	 Stack Code: Defines the stacking relations among different SKUs.  The code establishes 
parameters that a class of SKUs would use.  This field contains 10 characters.  Whenever you add 
a new SKU to the database, you’ll need to assign a new or existing stack code to the SKU.  Most 
likely, you’ll have one stack code that represents a group of SKU’s.  However, if each product you 
ship is unique in regard to how it can be stacked, you may want to define a unique stack code for 
each individual SKU.

MaxLoad Pro treats all SKUs with the same stack code in the same manner regarding; (1) which 
SKUs can be loaded on top of other SKUs and (2) which SKU’s can be placed under other SKUs.

For example, your company ships five different types of lampshades, all identical except for 
color.  In this case, you’d group these five SKUs together using the same stack code.  However, 
if you manufacture another type of lampshade made of paper mache, you’d assign a stack code 
different from the other five lampshades because the paper mache would change the stacking 
characteristics.

For SKUs that have no stacking restrictions, we recommend that you use the default stack code 
“All/All.”  When you define a SKU and click on OK to save it, the stack code will automatically 
appear in the Stack Matrix.  We’ll discuss the stack matrix in greater detail later in this chapter.

If you can’t find a stack code that suits your needs, you can define a new stack code.  To define a 
new stack code for the stack matrix, follow these instructions:

1.	 Click on the New button found just the left of the Stack Code field. The Define New Stack 
Code dialog box appears.

		
2.	 In the Stack Code field, enter a new stack code.  You can key in any alpha/numeric 

combination up to 10 characters long.

3.	 In the Default Value field, specify – Yes or No – whether other SKU’s can be placed under or 
on top of this SKU.  Use these guidelines:
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»» This can stack on others:  Can this SKU stack on top of other SKUs?  If so, select Yes.  If 
this SKU cannot stack on top of other SKUs, for example. when it is very heavy, select no.

»» Other can stack on this:  Can other SKUs stack on top of this SKU?  If so, select Yes.  If 
no other SKUs can be stacked on top of this SKU (as in the case of the paper mache 
lampshade), select no.

Keep in mind that you’re deciding how this SKU relates to all other SKU’s.  You may find it 
necessary to make changes in the stack matrix if an SKU relates differently to other SKUs on 
a case-by-case basis.

4.	 If all your stack code information is correct, click on OK. MaxLoad Pro saves the new stack 
code to the SKU database.

•	 Default Stack Codes
MaxLoad has provided several default stack codes to provide quick classification of stack relations 
among different SKUS:

»» All/All:  Assigned to SKUs which can be stacked on top of all items and all items can be stacked 
on top of it (current SKU being define).

»» All/None:  Assigned to SKUs which can be stacked on top of all items but nothing can be 
stacked on top of it.

»» None/All:  Assigned to SKUs which cannot be stacked on top of any items but all other items 
can be stacked on top of it.

»» None/None:  Assigned to SKUs which cannot be stacked on top of anything and nothing can 
be stacked on top of it.

�� Note:  When stacking same SKUs, MaxLoad will refer to Maximum Stack Height instead 
of the Stack Code for load solutions.

•	 Maximum Stack Height (On Base):  Defines the number of layers high the same SKU can be safely 
loaded on its base.  Use this option when the case flap is facing the ceiling.

•	 Maximum Stack Height (On Side):  Defines the number of layers high the same SKU can be 
loaded on its side.  This field compliments the stack code.

For example, when you defined a SKU for Computer Monitors, you also defined a stack code 
that tells MaxLoad that Computer Monitors can be stacked on top of one another.  However, the 
stacking strength of the bottom Computer Monitor dictates that you can only stack this SKU four 
layers high.  In this case, enter “4” for four layers in the Maximum Stack Height on Base field.

•	 Maximum Stack Weight:  Defines the maximum weight that can be placed on an individual SKU.  
This field is defined in units of measure (either English or Metric) representing weight, and also 
compliments the stack code.  Even though the stack code allows one item to be placed on top of 
another item, this field will override the stack code to limit the weight of a placement on top of 
a particular SKU.  By the nature of this calculation, a stack of SKUs will always be limited to the 
maximum stack weight of the product on the bottom of the stack.

�� Note:  When building a stack of like SKU’s, Maximum Stack Height takes precedence over 
Maximum Stack Weight.  That is, when building a placement of like SKUs, MaxLoad Pro will 
only take the defined Maximum Stack Height into consideration when determining how to 
build the placement.  However, if there is space for a different SKU to be placed on top of 
the stack, MaxLoad Pro will then consider the Maximum Stack Weight to determine the new 
placement.
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Maximum Stack Height also takes precedence over the stack matrix.  For example:  I define a 
SKU and assign it a new stack code.  In the stack matrix, I say that this SKU cannot stack on top of 
itself.  However, if when defining my SKU I also say that the SKU can stack three layers high; this 
parameter will take precedence over the stack matrix, which says that I cannot stack this SKU on 
top of itself.  This rule was made in an effort to help users limit the number of stack codes within 
the stack matrix.

For example, my Computer Monitors weigh 30 pounds each.  I define the maximum stack height 
of a computer to be five units tall and the maximum stack weight to be 100 pounds. Is a stack of 
five computers a legal placement?  Yes – regardless of the fact that the bottom computer will be 
supporting 120 pounds.

Another example, suppose I’ve stacked three computers on top of one another, meaning that the 
bottom SKU (computer) is supporting 60 pounds.  I notice that there is room to load a 60-pound 
box of stereos on top of the computers.  Is this stack of three computers and one stereo a legal 
placement?  No!  Why not?  Because the maximum stack weight of 100 pounds will be violated 
when the stereo is loaded.

•	 Label: The Label feature allows you to designate another name for a SKU, as opposed to being 
limited to the SKU Number.  For example, perhaps the SKU Number of a box of parts is “8315,” 
but the SKU is commonly referred to as “Coils.”  The custom label allows you to assign the SKU 
both names, while at the same time giving you the control over which name is used when 
printing.

To initiate this feature, simply type in a string to use as the label.  The string should be alpha/
numeric and can contain up to 20 characters.

•	 Stack Limit: (Not Implemented) This parameter works with MaxLoad Load Rules and determines 
how many total (same of different) SKUs can be allowed in a stack. 

•	 Location: (Not Implemented) This parameter works with MaxLoad Load Rules and determines 
where inside the vehicle the SKUs will be placed - front, center or rear.

Stack Matrix
The Stack Matrix allows you to define the stacking relationships between the various stack codes, 
which are assigned to SKU’s in the Define SKU screen.  The stackability matrix is a square matrix 
contains one row and one column for each stack code.

To access the stackability matrix, open the Define menu and select Stack Matrix. The Stack Rules 
screen appears, along with the stackability matrix.

�� Note:  Always start with category at columns, then go left to find the corresponding 
category along rows.  At the current intersected cell, the entry “No” means “Heavy” cannot 
be stacked on tops of “Light”. 
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Notice that the Stack Rules screen contains the following:

•	 OK Button:  Clicks to accept all changes made to the stack matrix during the current visit and 
returns you to the Define SKU screen.

•	 Cancel:  Clicks to cancel all changes made to the stack matrix during the current visit and returns 
you to the Define SKU screen.

•	 Delete Button:  Uses to delete a stack code by first highlighting the row or column header and 
click on the Delete button.

•	 Add Button:  Allows you to add a new stack code through the Define New Stack Code dialog box.

•	 Yes Button:  Allows you to change all values to Yes for a particular row or column.

•	 No Button:  Allows you to change all values to No for a particular row or column.

•	 Rebuild Button:  Searches the SKU database for any stack codes that have not been added to the 
Stack Matrix.  MaxLoad Pro updates the Stack Matrix with the new stack codes.

•	 Sort Field:  Allows you to sort the Stack Codes in ascending order (alphabetically), descending 
order (alphabetically), or by insertion order.

When you define a SKU, the stack matrix initializes automatically.  To work with the Stack Rules 
Screen, use these guidelines:

•	 When you enter a new stack code, MaxLoad Pro adds a new row and column to the matrix.  Each 
entry in the matrix is a box marked with a “Yes” or “No.”  The Yes/No indicate whether a SKU with 
the stack code for the corresponding column can be loaded on top of a SKU with the stack code 
for the corresponding row.

•	 The stack codes across the top of the matrix (columns) are considered the “top” SKU, while the 
stack codes along the side of the matrix (rows) are considered the “bottom” SKU.

•	 Click on column and row headers to highlight the entire row or column (or both).

•	 Use the gray scroll bar or the arrow keys to move around the stack matrix.

•	 To change a single Yes/No value inside individual cell, simply click on it.
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Graphics Tab (Define SKU)

 
The Graphics tab allows you to place some graphics on the SKU.

•	 Top Graphic:  This option allows you to place a graphic on the top of a SKU.  Click on  button 
to browse to a location from where you can pick a bmp image to be placed as a graphic on the 
top of the SKU.

•	 Side Graphic:  This option lets you place a graphic on the side view of the SKU.

•	 Front Graphic:  This option is used to place a graphic on the front view of the SKU.  The Front 
Graphic option is not available for PalletLoads.

•	 SKU Info:  SKU Info fields are some useful fields which the user can use to write notes about a 
SKU.  These get placed in the SKU List and the Manifest List and is only available in the Manifest 
report.

•	 Consumable:  You can check this box to specify if the SKU is perishable.

General Tab (Create Unitload)
The General and Options Tab described in this and following section can be found upon clicking the 

 button in the Define SKU dialog box.

When MaxLoad Pro loads a shipcase or drum onto a pallet or slipsheet, this is known as creating a 
unitload.  First, you must either create a SKU or select an existing SKU from the drop down list.
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The General tab allows you to select the type of pallet or slip sheet to be used when creating a 
unitload, as well as to define the absolute maximum size of the unitload and a number of loading 
options.

•	 Pallet: The Pallet field requires you to select a specific pallet to be used in creating the unitload.  
To see a list of available pallets, click on the down arrow to the right of the field.

We ship MaxLoad Pro with a list of standard pallets for you to choose from.  However, if you don’t 
see a pallet that suits your needs, you can always define one.  

�� Note:  If you wish to bundle this SKU, but not display it on a pallet, choose None as the 
pallet style.  MaxLoad Pro will display a grouping of SKU’s in a specific pattern, but will not 
display a pallet.  You’re still required to enter height, weight and any overhang parameters.  

Also, keep in mind that even though you’ve chosen None as the pallet, you’re still required to 
define area (length and width) parameters for this unitload.  Therefore, if you define None as a 
48-inch by 40-inch area, MaxLoad Pro will generate answers that reflect a grouping of products in 
an area roughly the size of 48-inches by 40-inches in length and width.

•	 Maximum Height, Weight and Overhang:  Maximum Height and Maximum Weight are self-
explanatory. These fields allow you to assign the maximum height of the unitload, as well as the 
maximum allowable weight.  These height and weight values include the pallet.

The Maximum Length and Width Overhang fields represent the maximum distance a SKU is 
allowed to overhang the edge of the pallet along the length and width dimensions.  You’re 
required to enter a value for both the length and width.  If no overhang is allowed, set these fields 
to zero.

•	 Rotate: Click the Rotate button opens the Layer Parameters dialog box which allows you to rotate 
selected layers on the unitload. Unitload with rotated layers provides better stability but may 
yield weaker load due to lack to corner support.

To rotate layers, place a check mark against the layer or click the Rotate Alt button to rotate 
alternate layers. Click OK to confirm.
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Options Tab (Create Unitload)

The Options tab allows you to select pattern styles to be used when building the unitload, as well as 
the loading orientation of the unitload within the vehicle and stacking rules for the unitload.

•	 Pattern Styles: The Pattern Styles options tell MaxLoad Pro which pallet patterns to consider 
when calculating a unitload.  When it generates solutions, MaxLoad Pro will analyze any pallet 
patterns that have been selected.  The table on the next page outlines the various pallet patterns.

Pallet Patterns
Pattern Style Is Designed Like This
Staggered Applicable to Drum SKUs, this pattern allows more drums to be 

packed per layer through staggering.
1 Block Block pattern or column stack
2 Block Bi-Block pattern
3 Block Tri-Block pattern
4 Block Pinwheel pattern
5 Block Penta-Block pattern
5 Block Plus Penta-Block Plus pattern
Soldiered Pattern that spreads the boxes to allow other boxes to be slid down 

in between.
Diagonal Diagonal pattern
Multi-Dimension Each layer can have a different dimension vertical
Multi-Surface Loads pallet top-to-bottom, front-to-back, and side-to-side with 

multi-dimensions allowed.  Very complex and usually recommended 
in rear loading circumstances.

Multi-Layer Puts cases onto the pallet with the last layer with different 
dimensions vertical.

•	 Load Into Vehicle: This option determines the orientation of a unitload when it’s loaded into a 
vehicle:

»» Load by Length:  The length of the unitload is loaded parallel to the length of the vehicle.
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»» Load by Width:  The width of the unitload is loaded parallel to the length of the vehicle.

»» Best Fit:  The unitload is loaded using the most efficient orientation, with no consideration of 
any limiting parameters.

•	 Stack Rules: Stack rules for a unitload work like the stack rules for an individual SKU. There are 
three options:

»» Must Be Stacked on Floor:  MaxLoad Pro will disregard any solutions in which the unitload is 
not placed on the floor.  

»» Must Not be Stacked on Floor:  MaxLoad Pro disregards any solutions in which the unitload is 
placed on the floor.

»» Best Fit:  MaxLoad Pro disregards the two options above and places the unitload where it’s 
most efficient in relation to other unitloads.

•	 Stack Code: It’s important to remember that the stacking rules defined for the unitload take 
precedence over the individual stacking rules of the SKU’s that make up the unitload.  Due to 
outside factors such as corner posts, padding, etc., SKU’s are generally considered to be stronger 
when loaded as part of a unitload.

You can assign a Stack Code to a unitload just as you can an individual SKU.  Stack Codes will 
appear in the Stack Matrix along with all other Stack Codes that were defined when defining an 
SKU.  You can choose an existing stack code, or define a new one.

•	 Max Stack Height: Max Stack Height (UL’s) defines the maximum number of stacks this unitload 
can accommodate when it’s loaded on itself; that is, the unitload you’re defining plus any 
unitloads stacked on top of it.  For example, if you can safely load only one other unitload on top 
of the unitload you’re defining, Max Stack Height would be two.  However, if you can safely stack 
two other unitloads on top of this unitload, Max Stack Height would be three.

•	 Max Stack Weight:  Max Stack Weight (UL’s) defines the maximum amount of weight that can be 
placed on top of the unitload.  This value is defined separately from the Max Stack Weight of the 
SKU.  However, when it comes to these values, you’ll need to decide which takes precedence:  the 
individual SKU or the associated unitload.
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Unitload Solution
After you’ve completed the General and Options tabs, you’re ready for MaxLoad Pro to generate the 
unitload solutions.  To generate unitload solutions, follow these instructions:

1.	 Click on the Calculate button. The Create Unitload (UL) screen redisplays with a list of possible 
solutions displayed in the bottom portion of the screen.  MaxLoad Pro calculates these solutions 
based on the pallet patterns selected in the unitload parameters. 
 

Each unitload solution includes the following information:
•	 The case dimension designated as vertical
•	 The length, width, height and weight of the unitload
•	 The type of pattern used to build the unitload
•	 Number of cases per layer
•	 Number of layers per unitload
•	 Number of cases per unitload
•	 Area and cubic efficiency of the unitload

The g.o.d. window in the upper right portion of the screen displays a graphic of the selected 
unitload solution. Use the down arrow or gray scroll bar to the right of the solution list to see the 
next solution.  As you scroll through the list, notice that the g.o.d. window changes to reflect the 
different possible solutions.  Additionally, notice that the information on the title bar changes to 
reflect the solution that you’re currently viewing.

MaxLoad Pro allows you to view the unitload diagram in a number of ways.  All options are 
accessed through the view buttons on top of the g.o.d. window.

In each view for the selected solution, you can rotate the unitload using the arrow keys after 
clicking anywhere inside the g.o.d. window.



46 | MaxLoad®Pro User Guide v4.0

View Option View of the Unitload
3D Shows a 3-dimensional view of the unitload
Top Shows a top view of the unitload (view from above the unitload looking down)
Side Shows a side view of the unitload

Front Shows a front view of the unitload

2.	 Select the pallet pattern that best suits your needs.

3.	 To rotate layers in the unitload, click on the Rotate button to open the Layer Parameters dialog 
box.

  

»» Rotate:  Clicks the corresponding box in the Rotate Column to rotate the corresponding layer.  

»» Rotate Alt:  Clicks this button to quickly rotate alternate layers of the unitload, instead of 
checking off individual layers.

»» Clear Rotate:  Clicks this button to clear all layer rotation.

4.	 Click OK to save layer rotation or click on Cancel to cancel.  Rotated layers will apply to all 
unitload patterns.

5.	 Click OK again to save the selected pallet pattern and accompanied layer rotation, if applicable.

MaxLoad Pro saves the selected pallet pattern to this particular SKU.  Therefore, when you select 
the SKU in the Define Manifest screen and click on the Use Unitloads box, MaxLoad Pro draws the 
SKU in the vehicle using the selected pallet pattern.  

To change the pallet pattern in the future, follow the steps outlined above to save another 
unitload pattern.
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Creating a Unitload vs. Defining a Palletload SKU
By now, you may have noticed that MaxLoad Pro allows you to create a unitload as well as define a 
palletload.  What’s the difference? While defining, you must have noticed that the two have quite 
distinct features.

When you create a unitload, MaxLoad Pro loads individual shipcases or drums onto a pallet/slipsheet 
with other identical SKU’s.  In doing so, MaxLoad Pro considers the pallet style, dimensions/weight 
of the SKU, whether or not the SKU can overhang the edge of the pallet, as well as various pallet 
patterns. Multiple shipcases can be loaded together to create a unitload.  This option is available 
when you define a SKU.  However, only shipcases or drums can be combined to create a unitload.

               Defined Palletload SKU               Created Unitload

Whereas, when you define a palletload, you’re defining the outside dimensions of the unitload, 
without considering the individual shipcases that combine to create a unitload.  As with creating 
a unitload, you must choose a pallet style.  However, the dimension you enter will be the absolute 
dimensions of all of the SKU’s when loaded onto a pallet/slipsheet.  The result is a block drawn onto 
a pallet.  A SKU already defined as a palletload cannot be loaded with other objects to create a 
unitload.

Reason why we make the above distinction is that, many of our customers don’t want to concern 
themselves with the pallet patterns that make up a unitload.  Perhaps they receive pre-built 
unitloads and have no control over how a unitload is built.  When these companies pick a unitload 
for shipping, they usually refer to an entire unitload as one object, rather than by the quantity of 
individual SKU’s that combine to create a unitload.

Define a SKU
To define a SKU, start from the Define SKU screen and follow these instructions:

1.	 Click on the Size tab, if necessary, to activate it.

2.	 From the SKU Style drop-down list, select SKU Style.
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3.	 Enter information in the following Size tab fields:

•	 SKU Style: When the SKU screen appears, your first decision is which type of SKU you want 
to define.  The five types of SKUs that can be defined using MaxLoad Pro are palletload, 
shipcase, drum, tote SKU, and pallet SKU.

•	 SKU Number:  Enter a SKU number.

•	 Description:  Enter a description for the new SKU.  This field is optional; you can leave it 
blank.

•	 Pallet:  Select a pallet.  This field is available only if your selected SKU style is a PalletLoad.

�� Note:  MaxLoad Pro allows you to choose from a large database of both pallets and 
slipsheets.  If you cannot find the pallet you’re looking for, you can define a new one.

•	 Color:  Click on the Color field to display the Color Selection dialog box.  Select a color for the 
new SKU.

•	 Length: Enter the absolute length of the SKU.

•	 Width: Enter the absolute width of the SKU.

•	 Height: Enter the absolute height of the SKU.

•	 Diameter: Enter the diameter of the drum.  This field is only available if your selected SKU 
style is a drum.

For example, if you are defining a Palletload style SKU, using a GMA  Notched pallet (48” by 
40”) with one inch of overhang along both the length and width, enter a length of 50 inches 
and a width of 42 inches (48” by 40” plus an inch of overhang on both sides of the pallet).

•	 Weight: Enter the weight of the SKU

•	 Piece Count:  Enter the quantity of items loaded in this SKU.

•	 Maximum Overhang Length:  Enter the maximum number of inches the SKU can overhang 
the SKU placed beneath it along its length.

•	 Maximum Overhang Width:  Enter the maximum number of inches the SKU can overhang 
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the SKU placed beneath it along its width.

•	 Maximum Overhang Height:  Enter the maximum number of inches the SKU can overhang 
the SKU placed beneath it when it is placed on its side.

•	 Maximum Overhang Diameter:  Enter the maximum overhang along the diameter of the 
drum.  This field is only available if a Drum style SKU is being defined. 

•	 Allowed Vertical:  Select the dimension(s) that will be allowed as the vertical orientation.

•	 Preferred Vertical:  Select the dimension that will serve as the preferred vertical orientation.  
If there’s no preference, select No Preference.

4.	 Click on the Stacking tab to activate it. The Stacking tab appears, as pictured here.

   

5.	 Enter information in the following Stacking tab fields:

•	 Unitize:  Check this box to tell MaxLoad Pro to use this SKU as a unitload, whenever possible. 
This option is available only after you’ve created a unitload for the SKU.

•	 Put On Mixed Pallet:  Check the box to place the SKU on a mixed pallet.

•	 Load into Vehicle:  Select an option for loading shipcases into a vehicle – Load by Length, 
Load by Width or Best Fit.

•	 No stacking on tops of side loaded items:  Check the box if this shipcase should not be 
loaded on top of items loaded on their side.

•	  Dead Stacking Rules:  Select an option for loading shipcases on the floor – Must Be Stacked 
On Floor, Must Not Be Stacked On Floor, Best Fit, Prefer On Floor or Prefer On Top..

•	 Stack Code:  Select an existing stack code or define a new one.

•	 Maximum Stack Height (On Base):  Enter a maximum stacking height when the SKU is 
stacked on its base.

•	 Maximum Stack Height (On Side):  Enter a maximum stacking height when the SKU is stacked 
on its side.  This is not available for PalletLoad style SKU’s, as they can not be loaded on side.  

•	 Maximum Stack Weight:  Enter a maximum stacking weight of the SKU.

•	 Label:  Enter an optional label for the SKU.
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•	 Location:  Check – Light, Medium, or Heavy- depending on which SKUs can stack on top of the 
SKU being defined and which cannot.

6.	 Click on the Graphics tab to activate it. The Graphics tab appears, as pictured here.

   

7.	 Enter information in the following Graphics tab fields:

•	 Top Graphic:  Use the Browse function to select a graphic for the top of the SKU.

•	 Side Graphic:  Use the Browse function to select a graphic for the side of the SKU.

•	 Front Graphic:  Use the Browse function to select a graphic for the front of the SKU 

8.	 If all your graphics parameters are correct, click on the Save button. MaxLoad Pro saves the new 
SKU to the SKU database.
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Create a Unitload
To create a unitload, start from the Define SKU screen and follow these instructions:

1.	 Click on the Create UL button. The Create Unitload (UL) screen appears. Notice that this screen 
has two tabs: General and Options tab.

    

2.	 At the General tab, enter the following information.

•	 Pallet:  Select a pallet from the drop down list.  If you don’t see a pallet you want, you can 
define a new one.

•	 Maximum Height Incl Pallet:  Enter the maximum height of the unitload, including the height 
of the pallet.

•	 Maximum Weight Incl Pallet:  Enter the maximum weight of the unitload, including the 
weight of the pallet.

•	 Maximum Length Overhang:  Enter the maximum number of inches the unitload can 
overhang the pallet along the length of the pallet.

•	 Maximum Width Overhang:  Enter the maximum number of inches the unitload can 
overhang the pallet along the width of the pallet.

3.	 Click on the Options tab to enter the following information.
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•	 Pattern Styles:  Select the pattern styles you want MaxLoad Pro to look at during the unitload 

building process.

•	 Load Into Vehicle:  Select an option – Load by Length, Load by Width or Best Fit – to specify 
the orientation (if any) of the unitload when it’s loaded into a vehicle.

•	 Stack Rules:  Select an option – Must be Stacked on Floor, Must Not be Stacked on Floor or 
Best Fit – to specify any stack rules for this unitload when it’s being loaded into a vehicle.

•	 Stack Code:  Select an existing stack code or define a new one.

•	 Maximum Stack Height:  Enter a maximum stacking height for the unitload.

•	 Maximum Stack Weight:  Enter a maximum stacking weight for the unitload.

4.	 If all of your unitload parameters are correct, click on the Calculate button. 

5.	 Select the pallet configuration you’d like for the SKU and click on OK to save the pattern and back 
to the Size tab of the Define SKU screen.

6.	 Click the Save button to save the SKU and the unitload to the SKU database.

Modify an Existing SKU
To modify an existing SKU, follow these instructions:

1.	 Click on the down arrow to the right of the SKU Number field.  The drop-down list displays a list 
of existing SKU’s.

2.	 Select the SKU you want to modify. The Define SKU screen redisplays with information for the 
selected SKU.

3.	 Modify information on the screen as necessary.

4.	 If your SKU parameters are correct, click on the Save button.  

If you want to modify the SKU and give it a different name, simply type over the existing 
description (using standard windows conventions), and click on the Save button.

MaxLoad Pro saves the modified SKU record to the SKU database.
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Delete a SKU from the Database
To delete a SKU from the database, follow these instructions:

1.	 Click on the down arrow to the right of the SKU Number field.  The drop-down list displays a list 
of existing SKU’s.  

2.	 Select the SKU you want to delete. he Define SKU screen redisplays with information for the 
selected SKU.

3.	 Click on the Delete button on the middle portion of the screen. A dialog box appears with the 
name of the selected SKU and asks “Are you sure you want to continue?”

4.	 To delete the SKU, click on the Yes button. MaxLoad Pro deletes the selected SKU from the SKU 
database.

Create SKU Bundle
In addition to creating unitloads, MaxLoad also allows you to define bundles. Bundles provide a 
more flexible ways of loading SKUs in different preferred configurations for better use of the loading 
space.  This function is available to Shipcase and Drum SKUs. For L-shape SKUs, please see the next 
section.

SKUs will not be loaded as bundles if the options Use Unitloads and/or Use Mixed Pallets are 
enabled.

�� Important: To use bundles, you will need to add the line “DoBundle=True” to the 
Loadrules.ini file. Please contact TOPS Tech Support team for more information.

To define bundle for SKU, follow these steps:

1.	 Go to Define Menu and select SKU.

2.	 Enter the SKU information including SKU Number, dimension and weight as shown below. You 
can also select an existing SKU by clicking the drop down arrow in the SKU Number field.

  
3.	 Click on the Bundle button to open the Bundle Preferences dialog box as shown below. You can 

set up to three (3) bundle sizes for the SKU. MaxLoad will load them based on the quantity and 
space available.
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•	 Bundle Size: Define the property of the SKU bundle:

»» Vertical – The dimension of the SKU to be loaded vertical inside the transit vehicle.

»» Orientation – Define which dimension of the bundle will be loaded parallel to the side of the 
vehicle.

»» Length x Width x Height – Enter the SKU quantities along each dimension of the bundle. 
Referencing the example in the dialog box, the 1 x 1 x 36 bundle will have one SKU along the 
length and width of the bundle but 36 SKUs along the vertical dimension. This configuration 
is illustrated in the container on the left below. Note that it shows two bundles with 36 SKUs 
each placed on a pallet.

   

The second bundle preference 2 x 25 x 1 (with SKU width vertical) will load the SKUs as 
illustrated in the container on the right above. It shows only one (1) bundle with 2 SKUs along 
the length and 25 along the width but stack only one high.  Note that this is one single bundle 
of 50 SKUs. The pallet selected will be sized to carry all SKUs for the bundle.

»» Allow Partial – Click the drop down arrow to specify if partial bundle is allowed and if so, 
along which dimension.

»» Min Count – When partial bundle is allowed, enter the minimum number of SKUs for the 
partial bundle along the specified dimension.



                                                                                                                          Chapter 3: Defining MaxLoad Pro Databases | 55

The container here shows a load with a preference which allows 
partial bundles. The smaller bundle on the right comprises of 
only 2 SKUs along the width to take advantage of the tighter 
space.  Any SKUs not enough to make a bundle will be floor 
loaded.

•	 Pallet: Specify the pallet, if any, to be used to carry the bundle.

»» Height: Specify the height of the pallet used for the bundle.

»» Pallet Style: Select from the drop list the pallet style to be used for the bundle. The size of the 
pallet will be the same as the footprint of the bundle.

•	 Slack: Define extra space around the bundle to accommodate for clamp or similar tools for 
maneuvering.  If slacks are added to the bundle length and width, the pallet will be sized 
accordingly to include these slacks.

»» Top:  Add extra space to the top of the bundle.

»» Length: Add extra space to the length of the bundle.

»» Width: Add extra space to the width of the bundle.

Define Bundle for L-Shape SKU
To define bundle for L-shape SKUs, click the Bundle button after entering the dimensions to open the 
L Shape Bundle Screen as show below.

•	 No Bundle – Click this box to disable bundles for the SKU. If checked, the SKU will be loaded as a 
single item and MaxLoad will use the overall dimension (60x40x42 in this example) of the SKU to 
calculate the space occupied by this unit. The space above the seat will not be treated as loadable 
space.

�� Note: Using bundles for L-Shape SKUs is not controlled by the load rules. This No Bundle 
option will dictate whether L-Shape SKUs will be loaded as bundles.
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•	 Optimize – Click the Optimize button to have MaxLoad calculate the bundle size which will be 
displayed in the dimension fields.

To use an alternate bundle size, enter the dimensions directly along the Length, Width and Height 
fields.

•	 OK – Click OK to use the bundle dimension as entered. Make sure to click on Save at the Define 
SKU dialog box to save all set parameters.

Pallet/Slipsheet Database
The Define Pallet screen allows you to enter parameters for a new pallet or slipsheet and save it 
to the pallet database.  Start from the Menu Bar and Open the Define menu and select Pallet. The 
Define Pallet screen appears.

 
This screen is comprised of the following components:

•	 Description:   Enter a description of the pallet or slipsheet you’re defining.  Use any combination 
of letters and numbers.  The maximum length of the description is 32 characters (including any 
spaces in between words).

•	 Style: Style field allows you to select a pallet style.  Click on the down arrow to display a list of 
pallet styles.  If you select Slipsheet, the Slipsheet section of the screen is activated.  If you select 
None, MaxLoad Pro allows you to create a pallet without labeling it as one of the existing styles.

The various styles of pallets that can be defined in the MaxLoad Pro software are:

»» None:  Use this pallet style if you do not want a pallet to be displayed in the unitload or mixed 
pallet view.

»» Stringer:  This is most commonly used pallet style, in United States.  In a stringer pallet boards 
of stringers are used between the top and bottom deck boards.  The length and width of pallet 
is the length and width of the stringer boards, respectively.

»» Notched Stringer: Like a regular stringer, but non reversible and has notches cut in the side to 
allow for 4 way entry.

»» Block: This is a 4-way entry pallets. Blocks of solid wood, 
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plywood, or plastic to support the unit load

»» Block Stringer: A stringer pallet is called so because it uses “stringers,” which support the unit 
load. The stringers are the boards, typically 2 x 4’s or 3 x 4’s, sandwiched between the top and 
bottom deck boards.

»» Euro Pallet: Usually 800mm x 1200mm. This pallet is a standardized block pallet introduced by 
the European railroads after World War II.

»» Slip Sheet:  Sheet of corrugated slipped under the bottom layer of a load.

»» Chep: Pallet style by the pallet manufacturer Chep.

•	 Dimensions:  Enter the length, width, height and weight of the pallet or slipsheet you’re defining.  
For example, a standard GMA (Grocery Manufacturers Association) pallet, commonly used in 
the U.S. marketplace, measures 48” in length by 40” in width, is generally 5” to 6” in height and 
weighs 65 pounds.  

You can define these dimensions either in English or Metric units by selecting the type of units in 
the Toolbar.

•	 Constructions: Select the pallet construction style:

»» Single Face:  The deck boards are positioned only on top of the pallet.

»» Double Face:  The deck boards are positioned on both sides (top and bottom) of the pallet.

»» Reversible:  The pallet is identical on both sides.  A notched pallet cannot be reversed.

�� Note:  If you choose Slipsheet, Euro Pallet, or a None style of a pallet, the construction 
selection is not available.

•	 Alignment:  This refers to how you position the stringer in relation to the deck boards.

»» Flush:  Aligns the stringer flush to the outside edges of the deck boards.  

�� Note: Single Wing and Double Wing are options that allow you to offset the stringers on 
a double-faced pallet.

»» Single Wing:  Represents a pallet design that has offset deck boards on the top, but flush deck 
boards on the bottom.

»» Double Wing:  Represents a double faced pallet design that has both top and bottom deck 
boards offset from the stringers.

»» Offset:  If you select Flush, the Offset field will be grayed out.  If you select Single or Double 
Wing, the Offset field will be activated and you’ll need to enter the Offset amount.  Offset is 
the distance that the stringers will be offset from the edge of the pallet.

•	 Slipsheet: The Slipsheet section of the screen is activated only if you’ve selected Slipsheet as the 
pallet style.  You can add tabs to the length, width or to both sides of the slipsheet.  If you choose 
to define tabs as part of your slipsheet, you’re required to define a tab width.
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»» Autosize:  Check option to have MaxLoad Pro automatically cut the size of the slipsheet down 
to the outside dimensions of the unitload.

For example, you choose a 48” by 40” slipsheet.  Let’s also assume that once you’ve created a 
unitload for your SKU, the outside dimensions of the unitload equal 47” by 34.”  MaxLoad Pro 
will automatically trim the dimensions of the slipsheet to 47” by 34.”  If you deactivate this 
feature, MaxLoad Pro will use the outside dimensions of the unitload as previously defined (in 
this instance 48” by 40”).

»» Length Tab:  Check option to display a tab of the specified width to the length of the slipsheet.

»» Width Tab: Check option to display a tab of the specified width to the width of the slipsheet.

»» Both Sides: Check option to display a tab of the specified width to all sides of the slipsheet.

»» Tab Width: Specify th width of the tab for the slipsheet.

•	 Deck Boards: Deck boards are the flat surface of the pallet on which you place a product when 
you create a unitload.  MaxLoad Pro requires you to define the number of inside deck boards, 
the deck board thickness, inside deck board width, outside deck board width, stringer width and 
center deck board width.  You’ll enter all values, except for the number of inside deck boards, in 
either inches or millimeters.

�� Note: If you choose Slipsheet as the pallet style, the deck boards section of the screen is 
not activated.

•	 Loading Priority: When you specify multiple pallet styles to be used in a truck manifest, MaxLoad 
will use this value to determine which pallet to use unless the SKU does not fit on the preferred 
pallet. Enter 1 as the first preferred pallet, 2 as second and so on.

•	 Color: To change the color of a pallet/slipsheet, click on the color box and select the color of your 
choice for the pallet or slipsheet.  MaxLoad Pro then assigns the selected color to the pallet/
slipsheet.

•	 g.o.d. Window: Displays a 3-dimensional graphic image of the pallet.

•	 Close Button: Closes the Define Pallet screen and returns you to the previous screen.

•	 Save Button: Allows you to save changes to an existing or a new pallet.

•	 New Button: Allows you to create a new pallet.

•	 Delete Button: Allows you to delete the current pallet from the database.

�� Note:  The Tab key allows you to easily move forward to the next field.  To move 
backwards to a previous field, press the Tab key while holding down the Shift key on the 
keyboard.



                                                                                                                          Chapter 3: Defining MaxLoad Pro Databases | 59

Define a New Pallet
To define a new pallet, start from the Define Pallet screen and follow these instructions:

1.	 Click on the New button. The Define Pallet screen redisplays with some default values in the 
dimension fields and the cursor positioned in the Description field.

2.	 Enter information in the following fields:

•	 Description:  Enter a description of the new pallet.

•	 Style: Use the down-arrow to view a list of pallet styles.  Select a pallet style.

•	 Length:  Enter the length of the pallet in inches or millimeters.

•	 Width:  Enter the width of the pallet in inches or millimeters.

•	 Height:  Enter the height of the pallet in inches or millimeters.

•	 Weight:  Enter the weight of the pallet in pounds or kilograms.

•	 Construction:  Select a type of construction – Single Face, Double Face or Reversible.

•	 Alignment:  Select a type of alignment – Flush, Single Wing, Double Wing – or key in an Offset 
value.

•	 Total Deck Boards:  Enter the total number of deck boards in the pallet.

•	 Deck Board Thickness:  Enter the thickness of the deck board in inches or millimeters.

•	 Inside Deck Board Width:  Enter the width of the inside deck board in inches or millimeters.

•	 Outside Deck Board Width:  Enter the width of the outside deck board in inches or 
millimeters.

•	 Center Deck Board Width:  Enter the width of the center deck board in inches or millimeters.

•	 Stringer Width:  Enter the width of the stringer in inches or millimeters.

•	 Num of Stringers:  Enter the number of stringers on the pallet.

3.	 If all your pallet parameters are correct, click on the Save button. MaxLoad Pro saves the new 
pallet to the pallet database.

Define a New Slipsheet
To define a new slipsheet, start from the Define Pallet Screen and follow these instructions:

1.	 Click on the New button. The Define Pallet screen redisplays with some default values in the 
dimension fields and the cursor positioned in the Description field.

2.	 Enter information in the following fields:

•	 Description:  Enter a description of the new slipsheet.

•	 Style:  Select Slipsheet.

•	 Length:  Enter the length of the slipsheet in inches or millimeters.

•	 Width:  Enter the width of the slipsheet in inches or millimeters.

•	 Height:  Enter the height of the slipsheet in inches or millimeters.

•	 Weight:  Enter the weight of the slipsheet in pounds or kilograms.

•	 Autosize:  Check the box to automatically size the slipsheet to the unitload dimensions.
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•	 Length Tab:  Check the box to put a tab along the length of the slipsheet.

•	 Width Tab:  Check the box to put a tab along the width of the slipsheet.

•	 Both Sides:  Check the box to put a tab along both sides of the slipsheet.  You must also check 
the Length and Width Tab in order to add tabs on all four sides of the sheet.

•	 Tab Width (in):  Enter the width of the tab in inches or millimeters.

•	 Color:  Click on the color box and select the color for the slipsheet.

3.	 If all your slipsheet parameters are correct, click on the Save button. MaxLoad Pro saves the new 
slipsheet to the pallet database.

Modify an Existing Pallet/Slipsheet
To modify an existing pallet/slipsheet, follow these instructions:

1.	 Click on the down arrow to the right of the Description field.  The drop-down list displays a list of 
existing pallets/slipsheets.

2.	 Select the pallet/slipsheet you want to modify. The Define Pallet screen refreshes with 
information for the selected pallet/slipsheet.  

3.	 Modify information on the screen as necessary.

4.	 If your pallet/slipsheet parameters are correct, click on the Save button.  

If you want modify the pallet/slipsheet and give it a different name, simply type over the existing 
description (using standard windows conventions), and click on the Save button.

MaxLoad Pro saves the modified pallet/slipsheet record to the pallet database.

Delete a Pallet/Slipsheet from the Database
To delete a pallet/slipsheet from the database, follow these instructions:

1.	 Use the Description drop-down list to select the pallet/slipsheet you want to delete.

2.	 Click on the Delete button on the middle portion of the screen. A dialog box appears with the 
name of the selected pallet/slipsheet and asks “Do you want to delete this record?”  

3.	 To delete the pallet/slipsheet, click on the Yes button. MaxLoad Pro will remove the selected 
pallet/slipsheet from the pallet database.
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Vehicle Database
Start from the Menu Bar, open the Define menu, and select Vehicle. The Define Vehicle Screen 
appears.

 
Note the following about the Define Vehicle screen:

•	 Size Tab: Allows you to define the dimensions of the container.

•	 Axles Tab: Allows you to define parameters for the container’s axles

•	 MultiZone Tab:  Allows you to define a multi-zone vehicle. Currently not supported, please 
contact TOPS for latest update.

•	 Advanced Tab:  Allows you to define size and location of corner boxes which are common in 
sea vans or containers.  Use this tab also to define the weight limit for different segments of the 
vehicle.

•	 Shelf Tab:  To define shelf setup for vehicles with shelves.

•	 (g.o.d.) Window: Displays a 3-dimensional graphic image of the container. 

•	 Close button: Closes the Define Vehicle Screen and returns you to the previous screen.

•	 Save button: Allows you to save changes to an existing or new container.  

•	 New button: Allows you to create a new vehicle.

•	 Delete button: Allows you to delete a vehicle from the database.

Size Tab (Define Vehicle)
The Size tab allows you to enter the inside dimensions of vehicle.

•	 Description: Enter a description (name) of the vehicle to define a new vehicle. You can enter a 
total of 32 characters in this field, including any spaces between words. 

To select an existing vehicle, make sure you have specified the correct vehicle type (see below), 
then select the vehicle name from the drop down list by clicking the down arrow.  Once you have 
selected an existing vehicle, all parameters defined previously for this vehicle will be displayed.

•	 Type: Select the type of vehicle to be defined or modified.  The various types of vehicles available 
in MaxLoad Pro are truck, sea van, rail car, rail wagon, multi zone (not implemented), double 
trailer, ULD, sidebay trucks, flatbed trucks, tractors and vehicles with shelves.

�� Note: Vehicles with special definition will be described in more details in later sections.
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When defining a new manifest, MaxLoad Pro allows you to filter the vehicle database to display 
only one type of vehicle type.  Any vehicle defined as a truck type will be added to the truck type 
list on the Manifest Pick List screen.  The same principle applies to other container types.

•	 Dimensions: You are required to enter the dimensions – length, width and height – of the vehicle 
you’re defining.  These values represent the inside (loadable) dimensions of the vehicle.  Chapter 
4, Loading a Truck Manifest, discusses how to limit the maximum height of the cargo regardless of 
the inside dimensions of the vehicle.  This comes in handy when you’re evaluating refrigerated or 
frozen loads that need room for air circulation.

•	 Maximum weight: This refers to the maximum cargo weight allowed in the vehicle.  This weight 
is usually found by subtracting the tare (empty) weight of the vehicle – both trailer and power 
unit – from the maximum over-the-road weight (80,000 pounds in most states, with some 
restrictions).  The maximum weight is usually around 45,000 pounds for most vehicles in the 
United States; however, laws vary from state to state and country to country.

•	 Drop Off: These fields allow you to define a drop deck (goose neck) trailer, as the one shown 
here. 

Referring to the figure below these are the different Drop Off parameters:

 

»» (A / E)  Distance to Drop Off: The distance from the front wall of the trailer to the drop off 
point at floor and ceiling level respectively.

»» (B / F) Drop Off Depth (Front): The drop off depth in the front of the vehicle at floor and 
ceiling level respectively.

»» (C / G) Distance to Drop Off: The distance from the front wall of the trailer to the drop off 
point for the rear end drop off, at floor and ceiling level respectively.

»» (D / H) Drop Off Depth (Rear): The drop off depth in the rear of the vehicle, for floor and 
ceiling respectively.

�� Note: Drop deck is not calculated for Single SKU manifests.

•	 Color: The Color dialog box allows you to define a custom color for the vehicle. To change the 
color of a vehicle, click on the color box, and make a color selection. 
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Size Tab – Special Vehicles
For special vehicle types as described below, you will find different Size tab parameters.

•	 Rail Wagon: Rail wagons have curved top which can be defined using the ceiling parameters.

»» (A) Width (Outside): The distance from the wall of the wagon toe 
end the first curve at ceiling level.

»» (B) Height (Outside): The height of first curve point.

»» (C) Width (Inside): The distance of second curve point from the 
end of the first curve point.

»» (D) Height (Inside): The height of second curve. 

•	 Double Trailer: Double trailers composes of two vehicles connected together.  Select from the 
existing vehicle database using the drop down list the vehicle to use for the first and second 
trailer.

•	 ULD: Unit Load Devices are pallets and containers used by aircrafts for air cargos. ULDs have 
angled ceiling and/or floors and are defined using the Drop off section. Popular ULD types as 
illustrated below can be easily defined in MaxLoad.



64 | MaxLoad®Pro User Guide v4.0

•	 SideBay: Sidebay trucks are commonly used for deliveries in the beverage industry and these are 
the parameters:
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»» Number of Bays:  Selects from the drop down list the number of bays inside the truck, from 2 
up to 32 bays.    

»» Bay Width:  Enters the width of each bay for the vehicle.  The default value is the total length 
of the truck divided by the number of bays on each side.  In this preceding example, the 
default bay width is 600 inches divided by 5 (number of bays on each side) which equals 120 
inches.

»» Bay Depth:  This is the depth of each bay, defaulted to half the width dimension of the truck. 
To define uneven bay depth on each side, enter a value less than half of the Bay Width.

»» Short Bays:  Specifies the bays which have shorter loadable height than the rest.  You can 
enter multiple short bays by separating the bay numbers with a comma.  For example, 
entering 2,5 as in the example will set bay locations 2 and 5 to short bays.

»» Short Bay Height:  Enters the loadable height of the short bays.

Axles Tab (Define Vehicle)
The Axles Tab allows you to enter parameters that are essential to calculating axle weights for a 
loaded container.

•	 Axle Count: Enter the number of axles for the vehicle.  You can enter a maximum of three axles 
in this field.  MaxLoad Pro will calculate the estimated weight carried by each axle tare weight: 
Enter the tare weight of the vehicle – the weight of the vehicle when it is empty.  Consult your 
transportation provider for this information.

•	 Tare Weight: Specify the tare weight of the vehicle. 

•	 King Pin/Front Axle: Specify the type of front reaction point (weight bearing point) for the 
vehicle.  This field does not affect the estimated axle weight calculation for the front reaction 
point.  That is, you’ll get the same answer, assuming you define either the first axle or the king pin 
in the identical location.  This option is primarily used to draw the vehicle accurately.

•	 Dist From (Front): Enter the distance from the front of the vehicle to the various positions of the 
king pin and axles.  If you select Front Axle in the King Pin/Front Axle option, the King Pin field 
changes to Front Axle.  Contact your transportation provider for more information on this subject.
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•	 Wgt: Enter the tare weight of the king pin and axles.  If you select Front Axle in the King Pin/Front 
Axle option, the King Pin field changes to Front Axle.  Contact your transportation provider for 
more information on this subject.

Axles Tab – Special Vehicles

•	 Truck Wheel Well

 

»» Distance From Front:  Specifies the distance from the front of the vehicle location of the 
wheel wells.

»» Height:  Enters the height of the wheel well.

»» Width:  Enter the width of the wheel well

»» Height:  Enter the height of the wheel well.

•	 Rail Car and Rail Wagon

   

»» Split Railcar (Split Thickness):  If Split Railcar is selected, enter the split thickness of the side 
cargo door (the thickness of the wall in the center of an open rail car).  Enter this value in 
inches or millimeters, depending on the Units selected.

»» Distance From Front:  If Side Cargo Door is selected, enter the distance between the side 
cargo door and the front of the vehicle.  Enter this value in inches or millimeters, depending 
on the Units selected.

»» Door Width:  For Side Cargo Door, enter the width of the side cargo door.  Enter this value in 
inches or millimeters, depending on the Units selected.



                                                                                                                          Chapter 3: Defining MaxLoad Pro Databases | 67

Advanced Tab (Define Vehicle)
The Advanced Tab allows you to specify corner boxes commonly found in sea van or containers. You 
can define up to four identical areas along the top area of the vehicle that will be unavailable for 
loading.

•	 Corner Boxes: Corner boxes of dimension 12 inches by 12 inches are commonly found at the four 
corners of sea vans.

»» Length:  Enters the length of the corner box along the length of the vehicle.  

»» Width:  Enters the width of the corner box along the width of the vehicle.

»» Height:  Enters the height of the corner box along the height of the vehicle.

»» Distance from Front (Location 1):  Enters the distance from the front of the vehicle for the 
location of the first set of corner boxes.

»» Distance from Front (Location 2):  Enters the distance from the front of the vehicle for the 
location of the second set of corner boxes.

�� Note:  Enter the same distance for location 1 and 2 will give only 2 corner boxes; and 
combining the use of corner boxes with wheel well will allow you a define areas along both 
the top and bottom of the vehicle to be blocked off for loading.
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•	 Weight Segments: This function establishes weight limits for up to 24 segments inside the vehicle 
and gives better control over weight distribution of the load.

»» Number of Segments:  Use the drop down list to select the number of segments for the 
vehicle. Each segment will be of equal length.

»» Max Weight:  Enter the maximum weight allowable for each segment of the vehicle.

�� Note:  To use, enable the option “Segment Wgt Limit” of Weight Limit under the Weight 
tab in the Manifest Pick List screen.

Shelf Tab (Define Vehicle)
This tab is active only when vehicle type Shelf is selected.

•	 Number of Section:  Use the drop down to select the number of sections where shelves are 
defined.

•	 Number of Shelf:  Select from the drop down list the number of shelves for the current 
section. A total of 2 shelves can be added to each section.

•	 Start Pos:  This is the start position of the shelf section from the front of the vehicle.

•	 End Pos: This is the end position of the shelf section from the front of the vehicle.

•	 Hgt: This defines of the height of the shelf in the current section.

•	 Thick:  This is the thickness of the shelf in the section.

•	 Wgt: This is the weight of the shelf in the section.
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Modify an Existing Vehicle
To modify an existing vehicle, follow these instructions:

1.	 Click on the down arrow to the right of the Description field.  The drop-down list displays a list of 
existing vehicles.  

2.	 Select the vehicle you want to modify. The Define Vehicle screen redisplays with information for 
the selected vehicle.  

3.	 Modify information on the screen as necessary.

4.	 If your vehicle parameters are correct, click on the Save button.  

If you want modify the vehicle and give it a different name, simply type over the existing description 
(using standard windows conventions), and click on the Save button.

MaxLoad Pro saves the modified vehicle record to the vehicle database.

Delete a Vehicle from the Database
To delete a vehicle from the database, follow these instructions:

1.	 Use the Description drop-down list to select the vehicle you want to delete.

2.	 Click on the Delete button on the middle portion of the screen.  A dialog box appears with the 
name of the selected vehicle and asks “Are you sure you want to continue?”

3.	 To delete the vehicle, click on the Yes button.  MaxLoad Pro deletes the selected vehicle from the 
vehicle database.

Tote Database
Start from the Menu Bar and open the Define menu and select Tote.  The Define Tote Screen 
appears, as pictured below.

Note the following about the Define Tote screen:
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•	 Description: Enter a description (name) of the tote. You can enter a total of 32 characters in 
this field, including any spaces between words. To select an existing tote to check or modify its 
parameters, click the down-arrow to select the tote from the list.

•	 Dimensions:  For a new tote, you are required to enter values for Length, Width, and Height for 
the tote you’re defining.  Enter inside and outside dimensions along with slack.

»» I.D.:  Refers to the inside measurement/dimension of tote

»» O.D.: Refers to the outside measurement of tote.

»» Slack:  Refers to the space taken up by packing material and will be available for loading.

�� Note:  The packaging industry defines height as the dimension that runs through the 
case flaps.  If tote height is set as the vertical dimension, the case flaps will always be facing 
up or down.  Extending this definition, length is defined as the largest dimension of the 
remaining two dimensions.  Width would then be the last dimension undefined.  Keep 
in mind that this is a general rule used in the packaging industry; your industry may be 
different.

•	 Weight:  This is the weight of the empty tote.

•	 Max Weight: The maximum weight the tote can hold with SKUs in it.

�� Note: Weight fields are optional and can be set to zero.  Be aware that if you choose to 
do so, MaxLoad Pro will not calculate accurate weight values – total weight, weight efficiency 
and estimated axle weights – for your load.

•	 Color: The Color dialog box allows you to define a custom color for the tote. To change the color 
of a tote, click on the color box and make a color selection.

•	 Load Into Vehicle: MaxLoad Pro gives you options as to how a tote may be loaded into a vehicle.  
For example, certain totes can be loaded only by a forklift from one direction.

You have three choices as to how a tote is loaded into the vehicle:

»» By Length:  Loads the length of the tote parallel with the length of the container.

»» By Width:  Loads the width of the tote parallel to the length of the container.

»» Best Fit:  Shows no preference; loads the tote using the best orientation in relation to other 
items being loaded.

•	 Stack Rules: Stack Rules are guidelines for how MaxLoad Pro will load totes into a container when 
they’re not placed on a pallet (sometimes referred to a floor-loading).  

»» Must Be Stacked on Floor:  MaxLoad Pro will disregard any solutions in which the tote is not 
placed on the floor. 

»» Must Not be Stacked on Floor:  MaxLoad Pro will disregard any solutions in which the tote is 
placed on the floor.

»» Best Fit:  MaxLoad Pro will disregard the two options above and place the tote where it is 
most efficient in relation to other items in the load.

•	 Stack Code: The Stack Code designates the stackability for a class of totes.  This field contains 10 
characters.  Whenever you add a new tote to the database, you’ll need to assign a new or existing 
stack code to the tote.  Most likely, you’ll have one stack code that represents a group of totes.  
However, if each product you ship is unique in regard to how it can be stacked, you may want to 
define a unique stack code for each individual tote.
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MaxLoad Pro treats all totes with the same stack code in the same manner regarding (1) which 
totes can be loaded on top of other totes and (2) which totes can be placed under other totes.

For example, your company ships five different types of lampshades, all identical except for 
color.  In this case, you’d group these five SKU’s together using the same stack code.  However, 
if you manufacture another type of lampshade made of paper mache, you’d assign a stack code 
different from the other five lampshades because the paper mache would change the stacking 
characteristics.

The totes that have no stacking restrictions, we recommend that you use the default stack code 
“All/All.”  When you define a tote and click on OK to save it, the stack code will automatically 
appear in the Stack Matrix.

If you can’t find a stack code that suits your needs, you can define a new stack code.  To define a 
new stack code for the stack matrix, follow these instructions:

1.	 Click on the New button located to the left of the Stack Code field. The Define New Stack 
Code dialog box appears.

	
2.	 In the Stack Code field, enter a new stack code.  You can key in any alpha/numeric 

combination up to 10 characters long.

3.	 In the Default Value field, specify – Yes or No – whether other totes can be placed under or 
on top of this tote.  Use these guidelines:

»» This can stack on others:  Can this tote stack on top of other totes?  If so, select Yes, else 
select No.

»» Other can stack on this:  Can other totes stack on top of this tote?  If so, select Yes.  If 
no other totes can be stacked on top of this tote (as in the case of the paper mache 
lampshade), select no.

Keep in mind that you’re deciding how this tote relates to all other totes.  You may find it 
necessary to make changes in the stack matrix if a tote relates differently to other totes on a 
case-by-case basis.

4.	 If all your stack code information is correct, click on OK. MaxLoad Pro saves the new stack 
code to the tote database.

•	 Max Stack Height Cases: The Maximum Stack Height is defined as the number of layers high 
MaxLoad Pro can safely stack a tote on top of itself.

•	 Max Stack Weight (units): The Maximum Stack Weight is defined as the maximum weight 
that can be placed on an individual tote.  This field is defined in units (either English or Metric) 
representing weight, and also compliments the stack code.  Even though the stack code allows 
one item to be placed on top of another item, this field will override the stack code to limit the 
weight of a placement on top of a particular tote.  By the nature of this calculation, a stack of 
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totes will always be limited to the maximum stack weight of the product on the bottom of the 
stack.

�� Note: When building a stack of like totes, Maximum Stack Height takes precedence over 
Maximum Stack Weight.  That is, when building a placement of like totes, MaxLoad Pro will 
only take the defined Maximum Stack Height into consideration when determining how to 
build the placement.  However, if there is space for a different tote to be placed on top of 
the stack, MaxLoad Pro will then consider the Maximum Stack Weight to determine the new 
placement.

Maximum Stack Height also takes precedence over the stack matrix.  For example, we define a 
tote and assign it a new stack code.  In the stack matrix, we specify that this tote cannot stack 
on top of itself.  However, if when defining the tote we also say that the tote can stack three 
layers high, this parameter will take precedence over the stack matrix, which says that the tote 
cannot stack on itself.  This rule was made in an effort to help users limit the number of stack 
codes within the stack matrix.

Let’s see another example, my Computer Monitors weigh 30 pounds each.  I define the 
maximum stack height of a computer to be five units tall and the maximum stack weight to be 
100 pounds. Is a stack of five computers a legal placement?  Yes – regardless of the fact that 
the bottom computer will be supporting 120 pounds.

Further if I stack three computers on top of one another, meaning that the bottom tote 
(computer) is supporting 60 pounds.  I notice that there is room to load a 60-pound box of 
stereos on top of the computers.  Is this stack of three computers and one stereo a legal 
placement?  No!  Why not?  Because the maximum stack weight of 100 pounds will be violated 
when the stereo is loaded.

•	 g.o.d Window: Displays a 3-dimensional graphic image of the tote.

•	 Close button: Closes the Define Tote screen and returns you to the previous screen.

•	 Save button:  Allows you to save changes to an existing or a new tote.

•	 New button:  Allows you to create a new tote.

•	 Delete button:  Allows you to delete a tote from the database.

Modify an Existing Tote
To modify an existing tote, follow these instructions:

1.	 Click on the down arrow to the right of the Description field.  The drop-down list displays a list of 
existing totes.

2.	 Select the tote you want to modify.  The Define Tote Screen redisplays with information for the 
selected tote.  

3.	 Modify information on the screen as necessary.

4.	 If your tote parameters are correct, click on the Save button.

If you want to modify the tote and give it a different name, simply type over the existing 
description (using standard windows conventions), and click on the Save button.  MaxLoad Pro 
saves the modified tote record to the tote database.
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Delete a Tote from the Database
To delete a tote from the database, follow these instructions:

1.	 Use the Description drop-down list to select the tote you want to delete.

2.	 Click on the Delete button on the middle portion of the screen. A dialog box appears with the 
name of the selected tote and asks “Are you sure you want to continue?”

3.	 To delete the tote, click on the Yes button. MaxLoad Pro deletes the selected tote from the tote 
database.

Using Multiple Databases
MaxLoad Pro saves all data, including SKUs, vehicles, manifests and more within the program in a 
Microsoft Access database file in the ...\TOPSAPPS\Max2Pro\Data\ folder.  However, you are not 
limited to just one database when using MaxLoad.  Sometimes, it makes sense to create separate 
database, for example, to hold data for different customers or departments.  Follow these steps to 
add two (2) database within MaxLoad Pro:

�� Note: Please consult your company’s IT department if you are not familiar with the use 
of Windows Explorer or functions related to file operation. 

1.	 Install MaxLoad Pro.

2.	 Open Windows Explorer by clicking the mouse’s right bottom and select “Explore”.

3.	 Browse to the location where MaxLoad Pro was installed.  The default location is in the C:\
Program Files\TOPSAPPS\Max2Pro\ folder.

4.	 Make two copies of the “Data” folder. 

5.	 Rename the “Copy of Data” folder to “Company1” (or any name of your choice).

6.	 Rename the “Copy (2) of Data” folder to “Company2” (or any name of your choice).

7.	 Open Maxload2.ini (in the C:\Program Files\TOPSAPPS\Max2Pro\ folder) in Windows Notepad 
by double clicking on the file.  Add two new “DBPATH=” statements as highlighted in the dialog 
box below. 

 
8.	 Go to File | Save in Windows Notepad to save and close the file.

9.	 If you have a MaxLoad shortcut on the desktop, right click on the shortcut  and select 
“Properties”.
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10.	 In the MaxLoad Properties dialog box as shown below, go to the Target field and add the 
following “-MultiDb=on” switch like  …\TOPSAPPS\Max2Pro\Maxload.exe -MultiDb=on”.  This 
switch enables the multiple database function within MaxLoad.

  
11.	 Click on OK to save the MaxLoad Properties.

12.	 Run MaxLoad Pro by using the MaxLoad shortcut that you’ve just edited.  You will see a screen 
similar to the following, prompting you to select the database from the three available.  Select 
the database you’d like to use and click on OK.

  

13.	 Login and now you should be working with the specific data saved in the selected database.

�� Note:  Since the new database is created from copies of the original database, the 
contents will be identical.  Delete the SKUs and manifests that you don’t need and import 
new data as required.
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4 Loading a Truck Manifest

This chapter explains how to use MaxLoad Pro to load a truck manifest with multi-size cases or 
multiple SKUs into a container, the most commonly used function in MaxLoad Pro.

�� Note:  If you are loading single-SKUs into a container, you can use either the Truck 
Manifest or the Single SKU Manifest.  The difference between the two for single SKU loading 
is provided at the end of this chapter.

For more information on Single-SKU Manifest, please refer to the next chapter.

This chapter walks you through the process you’d most likely follow when building a load with multi-
size cases, including the following topics:

Truck Manifest Pick List Screen

•	 Vehicle Tab
•	 Options Tab
•	 Algorithm Options
•	 Truck Weight Limit
•	 Mixed Pallet Tab
•	 Comments Tab
•	 Weight Tab
•	 SKU List
•	 Manifest List
•	 SKU Addition and Update

Changing the Display of the SKU and Manifest List

Defining a Truck Manifest

Truck Manifest versus Single SKU Manifest for Single SKU Loads
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Truck Manifest Pick List Screen
Once you’ve logged into MaxLoad Pro, the first screen that appears is the Control Center.  To start 
a new truck manifest, start from the Control Center and click on the New button under the Truck 
Manifest icon.  The Truck Manifest Pick List screen appears, as pictured below.

With the Truck Manifest Pick List screen displayed, you’re ready to begin defining the components 
of a new manifest.  This screen is the basis for collecting data for building a new manifest.  The Truck 
Manifest Pick List screen is comprised of the following components:

•	 Vehicle Tab: Allows you to select the type of vehicle and the specific vehicles to be used for the 
manifest

•	 Options Tab:  Allows you to fine-tune your load parameters to get optimum results.

•	 Mixed Pallet Tab:  Work performed under the Mixed Pallet tab allows you to select and set 
defaults for loading mixed pallets.

•	 Comments Tab:  Allows you to enter comments and customer information for the manifest.

•	 Weight Tab:  Allows you set weight limits for the different axles for different regions. 

•	 g.o.d. Window:  The graphics section on the upper right hand side of the screen displays a 
3-dimensional graphical image of the vehicle.

•	 SKU Input:  Allows you to enter SKU, quantity and other load parameters in the manifest list.

•	 SKU List:  Displays a list of all available SKUs (shipcases, drums, etc.) in the database.  All SKUs in 
this list are available for loading into a vehicle, onto a pallet or into a tote.

•	 Manifest List:  Displays a running list of all SKUs to be loaded into the vehicle.  As you select SKUs 
from the SKU List, they will automatically appear in the Manifest List.  You will define specifics 
about the load in this list.

•	 View Button:  Allows you to view a load without recalculating it.  This feature works only if you’ve 
previously built a load and is used primarily after you’ve made changes to a load in the Editor 
screen.

•	 Calculate Button:  Allows you to calculate a load.
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Vehicle Tab (Truck Manifest)
The Vehicle tab, allows you to select the type of transit vehicle for a manifest.

The Vehicle tab contains the following components/fields:

•	 Vehicle Type:  Displays the various kinds of vehicles defined in MaxLoad Pro.  You can narrow 
down the list of available vehicles by choosing a Vehicle Type.  This action will filter the Available 
Vehicles list to display only one type of vehicle.

•	 Available Vehicles:  Displays the list of all vehicles available in the database for the Vehicle Type 
specified.  In order to build a load, you will need to either choose an existing vehicle or define a 
new one through the Define menu.

Double click on a vehicle in Available Vehicles list to move it to the Selected Vehicles list.  Also 
notice that as a vehicle name is highlighted, a representation of that vehicle displays in the g.o.d. 
(graphical on-line drawing) window.

MaxLoad Pro allows you to use multiple vehicles at one time.  To do so, select more than one 
vehicle to be analyzed when calculating a manifest.  Simply follow the procedure described above 
to select multiple vehicles.  

•	 Selected Vehicles:  This section displays the vehicles selected from the Available Vehicles list, for 
a particular manifest.  You can have multiple vehicles selected for each truck manifest.

When MaxLoad Pro calculates solutions for a manifest, it uses only those vehicles listed in the 
Selected Vehicles list.  To remove a vehicle from this list, double-click on the vehicle you wish to 
remove, in the Selected Vehicle list.  This will remove the vehicle from the Selected Vehicles list 
and place it back in the Available Vehicles list.  

A representation of the selected vehicle will appear in the g.o.d. window.  If you select multiple 
vehicles, the highlighted vehicle will appear in the g.o.d. window.  

•	 View Button:  The View Button is active if you’ve opened an existing analysis or a new analysis 
has been calculated. It opens the Manifest View screen.

•	 Calculate Button:  The Calculate button will instruct MaxLoad Pro to find loading solutions based 
on the parameters entered in the analysis. When the calculation is complete, MaxLoad Pro opens 
the Manifest View screen.
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Options Tab (Truck Manifest)
The Options tab, allows you to further customize your manifest by setting various loading 
parameters.

The Options tab contains the following fields:

•	 Use Unit Loads:  Check the box to turn on the Unitload (UL) column in the Manifest List.  When 
you turn on this column, you can designate a SKU to be loaded onto a pallet as a completed 
unitload which is represented by a checked box (x).

In order for MaxLoad Pro to actually load the SKUs as unitloads, a unitload pattern needs to be 
pre-defined for the selected SKU using the “Create UL” function under the Define | SKU function.  
If no pattern has been defined, the check box under the UL column in the Manifest List will 
remain blank despite clicking on the box to change its state.

�� Note:  A unitload differs from a mixed pallet.  A unitload is comprised of identical SKUs, 
while a mixed pallet is comprised of multiple kinds of SKUs.

•	 Use Mixed Pallets:  Check the box to turn on the Mixed Pallets (MP) column in the Manifest List.  
Mixed Pallets are pallet loads consisting of multiple kinds of SKUs. 

Unitloads are labeled with SKU names while Mixed Pallets are labeled with MP-N where N is the 
mixed pallet number.

•	 Priority Loading: Specify if priority or stop off will be used for this truck manifest and enter the 
values under the Manifest List.

»» Load By Priority:  When a SKU is assigned a high priority number, it will be loaded before a 
SKU with a lower priority number.  Priority 1 will be loaded before priority 2, which will be 
loaded in front of priority 3.

�� Note: Load By Priority and Load By Stop Off determine which column is displayed in the 
Manifest List:  Priority or Stop-Off.  You can select either Load By Priority option or Load By 
Stop Off, but not both.   

»» Load By Stop Off:  When you load by stop-off, the loading method is just the opposite:  Stop-
off 1 is loaded after stop-off 2, and therefore closest to the rear door; stop-off 2 is loaded after 
stop-off 3, etc.

»» Stop & Priority:  MaxLoad Pro also supports priorities within each stop. Check this option to 
enforce this functionality.
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The following two options (Keep Same Orders Together and Keep Like SKUs Together) work in 
conjunction with the stop-offs and priorities.  In other words, if you build a load with two stop-offs, 
MaxLoad Pro will keep like SKUs or orders together within the individual stop-off number.

Bear in mind that using either of these options could potentially result in less cubic utilization.  While 
we can’t definitely say how these options will affect a load, it’s safe to say that these options will 
affect MaxLoad Pro’s calculations, thus making it possible that the load will be affected negatively.  

•	 Keep Same Orders Together:  Check the box to keep the same orders together when loading.  
This field is directly linked to the Order# field in the Manifest List.  When you key in an order 
number, MaxLoad Pro gives you the option to group SKUs from the same order together.  If you 
do not choose to input order numbers, this field will be meaningless; activating the checkbox will 
not affect the placement of SKUs within your manifest.  

•	 Keep Like SKUs Together:  This option is very similar to the Keep Same Orders Together option.  
Activating this option tells MaxLoad Pro to load all products with the same SKU number together.  
The Keep Like SKUs Together option takes precedence over the Keep Orders Together checkbox, 
thus answering the question of what happens when both boxes are checked.

•	 Load by SKU Ratio: This option loads the container with the specified ratio of SKUs in the 
Manifest List. When this option is checked, enter the ratio of the respective SKUs in the Qty 
column.

For example, to load the container with SKUs A, B and C in the ratio of 2:3:1, enter in the Qty 
column 2, 3 and 1 for SKU-A, SKU-B and SKU-C respectively.

�� Note:  When this option is checked, all SKUs in the Manifest List will be loaded in the 
ratio specified in the Qty column.  You will not get a solution if MaxLoad cannot load all SKUs 
in the lowest multiple of the specified ratios.

•	 Minimum Ceiling Clearance:  Minimum ceiling clearance is the minimum amount of air space 
allowed between the top of the cargo and the ceiling of the vehicle.  This option was designed 
with refrigeration and frozen shipments in mind, which require “breathing” space for freight 
so that a consistent temperature will remain throughout the vehicle.  You can also use this to 
accommodate the distance needed to maneuver forklifts when loading the vehicle.

Enter a number that represents the minimum amount of empty space required above the cargo.  
Keep in mind that this space starts at the point above the tallest SKU in the load.  If your cargo 
does not require a clearance between it and the top of the transit vehicle, you can tab through 
this option and go with the default of zero inches.

•	 Maximum Vertical Gap:  This option lets you control which spaces MaxLoad Pro joins together for 
the purpose of loading other items on top.  

In the process of loading SKUs and pallets into a transit vehicle, MaxLoad Pro accumulates a list 
of “leftover” spaces.  Whenever possible, MaxLoad Pro will combine neighboring leftover spaces 
to make bigger spaces.  Ideally, these neighboring spaces present a level surface.  If they do not 
present a level surface, you can enter a value in this field that artificially “joins” the two uneven 
surfaces together, thus creating a larger level surface.  

If the difference in height of the two spaces is less than or equal to this value (in English or Metric 
units), MaxLoad Pro joins together the offending gap, assuming that you will pad or brace the 
shorter space to bring it up to the height of the taller space.

•	 Maximum Priority Overlap:  MaxLoad Pro uses this option to determine the placement of the 
next priority or stop-off.  This field allows you to define the distance inside the container that 
MaxLoad Pro will “mix” items of a different priority or stop-off.  This field determines how far 
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forward into another priority or stop-off the front of an item with a lower priority number will be 
placed.  

For example, if maximum priority overlap set to 30 inches, MaxLoad Pro will place the next 
priority on top of the previous priority, with the front of the lower priority protruding past the 
end of the higher priority freight by a maximum of 30 inches.

Some shippers cannot mix stop-offs and will build a physical bulkhead of plywood bracing 
between SKUs of two separate stop-offs.  In this case, you would key in a value of zero in this 
field, which tells MaxLoad Pro to place the next stop-off on the floor, regardless of the fact that 
there is enough room to load on top.

•	 Maximum Overhang: This option is only available for flatbed trucks which allow overhang in the 
length dimension. This is useful for long SKUs commonly hauled with flatbeds like lumber and 
other construction materials.  The value entered is the total overhang allowed for the load.

�� Note: If overhang is only allowed at the end of the flatbed, click the Weight button in the 
Solution View screen to move the load to align load with the front of the truck.

•	 Days Range: This option is not implemented. Please contact TOPS Tech Support team for more 
information or assistance.

SKUs in the pick list can be assigned a date and items within the Days Range will be loaded on a 
transit vehicle and the rest of them goes to the next truck for the next number of days set in the 
Days Range field.

•	 Algorithms Button:  This button displays the Algorithm Options dialog box which allows you to 
determine how MaxLoad Pro will load a manifest.  For more information, please refer to the next 
section.

Algorithm Options
The Algorithm Options dialog box, allows you to determine how MaxLoad Pro will load a manifest.

The Algorithm Options dialog box contains the following features:
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Algorithms

•	 Load Front to Back:  Check the box to load the manifest as high as possible and as far forward as 
possible.  This option is useful if you put together a quote for a customer and want to show the 
amount of empty floor space available in the vehicle.

Loading front to back may use only half the available floor space, thereby placing most of the 
loaded weight on the vehicle’s drive axles.  The overall cubic efficiency of the trailer will likely 
be very similar, but the difference will be in the placement of the unused cubic space (above 
the freight with the Load Front to Back option, behind the freight with the Load Floor to Ceiling 
option).  

This option loads the container, starting at the front edge of the container and working towards 
the opposite edge, stacking mixed or identical SKUs or pallet loads.  

•	 Space Evenly:  Check the box to spread a load over the entire surface area of the container in 
order to make a more secure load.  

Whenever the cubic measurement of the cargo is less than the available cubic capacity of the 
load – remember that you define parameters of height and weight to define the cubic capacity – 
an artificial “ceiling” will be created.  This lowers the maximum height of the load and forcing it to 
be spread as equally as possible over the surface area of the vehicle.

•	 Load Floor to Ceiling:  Check the box to distribute the load evenly across the entire floor space of 
the transit vehicle, thus balancing the load more evenly between its axles.  This algorithm option 
minimizes unused floor space, making for a more stable load.

•	 Flatbed:  Check the box to distribute the load as if loading a flatbed truck. Loading starts from the 
center and spread outwards. The height of the SKUs will also be even out to create a stable load.

•	 Layers:  The Layers option is only available for Pallet Manifest and is checked by default.  This 
enables MaxLoad to build the mixed pallets with the goal to create stable layers.

Loading Rule

•	 The Loading Rule option allows users to select a specific load rule profile for the current manifest. 
This is a complex feature and not recommended to be attempted without guidance. Please 
contact TOPS Tech Support team for assistance if you are not setting desired loading results.

Optimize

•	 Left-to-Right Optimization:  Check the box to have MaxLoad Pro look for the best combination of 
two placements in order to maximize the space across the width (i.e. left-to-right) of the vehicle

When this box is checked, MaxLoad Pro will attempt to find some combination of two placements 
to optimize the width of the vehicle.  If the box is not checked, MaxLoad Pro will strive to place 
the largest placement possible in the vehicle, but will not necessarily attempt to maximize the 
space across the width of the trailer.  

It’s important to understand that this algorithm does not always provide the best solution, 
even though the logic behind the algorithm would suggest that it would.  Why?  Because of 
the physical dimensions of the SKUs being loaded into a vehicle, there simply may not be a 
combination of two placements that can maximize the width.  

�� Note:  When you select multiple algorithms, MaxLoad Pro will display at least one 
solution for each algorithm chosen.  Additionally, whenever Left-to-Right Optimization is 
turned on, MaxLoad Pro will calculate two solutions for each algorithm chosen; that is, Front 
to Back, Floor to Ceiling and Space Evenly.
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•	 Pinwheel Optimization for Pallets:  Check the box to have MaxLoad Pro load pallets in a pinwheel 
pattern in a container. 

•	 Speed-Space Tab:  Move the sliding bar to optimize the calculation for speed (flush left) or for 
efficiency (flush right).

The For Speed option tells MaxLoad Pro to calculate solutions as quickly as possible.

The For Space option tells MaxLoad Pro to take more time and calculate the most space-efficient 
solutions.

In addition to using the sliding bar, you can also enter a number between 1 (speed) and 200 
(space) in the box and click the Set button.

When you click OK, in the Algorithms dialog box, MaxLoad Pro saves your algorithm options to 
memory and returns you to the Truck Manifest Pick List Screen.  

The next time you calculate solutions for this manifest, MaxLoad will display a progress dialog 
box, as pictured below.

Notice the following about this dialog box:

»» The dialog box displays a running count of the following parameters for the current 
calculation:  quantity, cubic efficiency, cut list count, solution count, truck number and time 
elapsed.

»» A Stop button allows you to stop the calculation at any time and gives you the best solution 
found so far.

Staggered

The staggered pattern is used to load round shape SKUs, like drums, pipes, etc. into a container.  
MaxLoad Pro gives the following options to load cylindrical SKUs into a container.  

•	 None:  This option assumes that cylindrical objects are rectangular SKUs and loads them in a 
linear fashion as a shipcase.  

•	 Tight:  Loads as many cylindrical SKUs as possible along the width.

•	 Spread:  This is to spread the round SKUs during loading.

•	 Pyramid:  This is for loading the cylindrical SKUs lying in length orientation in the truck, stacking 
in a pyramid shape.
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Unitload Options

These options control how the unitloads will be loaded inside the transit vehicle.

•	 Smart Pallet Placement:  Check this box to have MaxLoad Pro place stable unitloads and mixed 
pallets on the floor of the container and then load the uneven palletloads as part of the top layer.  

•	 Optimize Height for Top Layer:  Checking this option gives the software the ability to load partial 
unitloads, thus more efficiently utilizing the container space.  

For Example, suppose you are loading a 48 Ft. Dry Van with 60 inches high unitloads.  A 48 Ft. 
Dry Van is 110 inches in height and you have set a Minimum Ceiling Clearance of 10 Inches.  
This leaves behind 40 inches of wasted space.  Now, with checking the “Optimize Height for Top 
Layer”, MaxLoad Pro will create unitloads with height in the range of 40 inches for the top layer, 
thus utilizing the container overhead space.

Pallets created under this algorithm will be labeled with SKU name.

•	 Allow Loose fill on sides:  Checking this option allows MaxLoad Pro to load the selected SKUs as 
fill items.  The SKUs which are left behind as they do not form a complete unitload can be used as 
fill items, to fill the empty available space in the container.

•	 Allow Partial Unitloads:  Check this option to place same SKUs not enough to make a full unitload 
on their own pallets (instead of as loose items) but not mixing them together with other SKUs to 
create mixed pallets. Pallet loads created under this algorithm will be labeled “PUL-N”.

Keep Order on Same Truck

When this option is checked, MaxLoad Pro will keep SKUs with the same order number on the same 
truck.

Mixed Pallet Tab (Truck Manifest)
The Mixed Pallet tab, allows you to select the pallet to be used to create mixed pallets and to set 
defaults when loading SKUs onto them. In order for MaxLoad Pro to use the information you enter 
on this tab, you must first activate the MP column in the Manifest List by checking the “Use Mixed 
Pallets” option under the Options tab.

�� Note:  The work you do in this tab is not to be confused with the work you do when 
you click on the Pallet Manifest icon in the Control Center screen.  The Pallet Manifest 
asks MaxLoad Pro to load the SKUs in the Manifest List onto selected pallet(s).  Here, you 
ask MaxLoad to place the SKUs on the same type of pallet which then be loaded into the 
selected vehicle(s).
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The Mixed Pallet tab contains the following fields.

•	 Pallet: Allows you to select from various types of pallets and slipsheets already defined in the 
Pallet database.  Click on the check box the pallet(s) you’d like to use. Selected pallets are shown 
with the þ marks. You can select multiple pallets but MaxLoad will start using the one with 
the largest available footprint unless the load fails certain parameter requirements including 
maximum height or overhang.

MaxLoad Pro is shipped pre-loaded with a range of popular pallet styles.  However, if you can’t 
find a pallet or slipsheet that you want to use for this manifest, you can always define a new one.  

For more information, please refer to Chapter 3, Defining MaxLoad Pro Databases.

•	 Maximum Height Incl. Pallet:  Enter a value representing the maximum height the mixed-pallet is 
allowed to be.  Reminder:  the height value includes the pallet height.  

•	 Maximum Weight Incl. Pallet:  Enter the maximum allowable weight of the mixed-pallet.  
Reminder:  the weight value includes the pallet weight.  

•	 Maximum Length and Width Overhang:  These values represent the maximum distance a SKU 
can hang over the edge of the pallet.  The overhang dimension is illustrated below.

           

For the purposes of building a stable load, we recommend that you limit the maximum overhang 
to at least one-half the length of the smallest SKU to be used in this manifest.  This will ensure 
that no SKU will have the majority of its mass hanging off the edge of the pallet.

When MaxLoad Pro builds a mixed-pallet load, it will use as much of the “available” space on the 
pallet as possible.  The amount of usable space is determined by the pallet size, the amount of 
overhang allowed, and the maximum height allowed to build a load.  

In effect, MaxLoad Pro uses this information to build invisible “walls” representing the absolute 
parameters of the mixed-pallet load.  In fact, when viewing a load you’ll notice that the usable 
area is shaded a different color to differentiate it from the background of the diagram.

•	 Maximum Vertical Gap:  Enter the maximum distance that MaxLoad Pro will artificially raise 
an SKU when it is placed next to a taller SKU.  By raising the height of the SKU, MaxLoad Pro 
combines two separate “spaces” (level surface) on top of each individual SKU into one larger 
space on top of both SKUs.  The larger space gives MaxLoad Pro more freedom when determining 
which SKU to load next.  

•	 Stack Code: Specify stacking property for the mixed pallets created on the fly for truck manifests.

•	 Dead Stacking:  Select how the mixed pallets will be loaded inside the vehicles related to floor 
loading:

»» Must be Stacked On Floor:  Select this option if the mixed pallets are not allowed to be 
stacked directly on floor.

»» Must Not be Stacked On Floor:  Select this option if the mixed pallets can only be stacked on 
floor.

»» Best Fit:  Select this option to load the mixed pallets in the vehicles where it is most efficient 
with regards to floor usage. 
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•	 Load into vehicle:  Select from one of the options as how the mixed pallets will be loaded into 
the vehicle:

»» By Length:  Select this option to load the mixed pallets such that they are placed with the 
pallet length along the length of the vehicle.

»» By Width:  Select this option to load the mixed pallets such that they are placed with the 
pallet width along the length of the vehicle.

»» Best Fit:  Select this option to load the mixed pallets in the vehicles where it is most efficient 
in relation to the other items in the manifest. 

Comments Tab (Truck Manifest)
The Comments tab, allows you to enter different information or comments regarding the truck 
manifest.

The Comments tab contains the following fields.

•	 Customer:  If desired, enter the name of the customer for the current Truck Manifest.  This 
information will appear in the File Open Dialog box as well as in the Load and Load Front/Back 
reports.

•	 Address:  If desired, enter the address of the customer for the current Truck Manifest.  This 
information will appear in the File Open Dialog box as well as in the Load and Load Front/Back 
reports.

•	 Status:  Select a status among Error, Fixed, Open and Shipped from the drop-list.  This status 
information will be included in the File Open Dialog Box.

•	 Delivery Date:  For reference, enter the promised delivery date for the order, represented 
as Truck Manifest in MaxLoad Pro.  You can click to drop-arrow to select the date from the 
calendar or use the up/down arrow key to select the month, day and year after the parameter is 
highlighted.

•	 MFT Comments 1:  Enter comments regarding the truck manifest. Comment 1 appears in the title 
section of all printouts.  

•	 MFT Comments 2 & MFT Comments 3:  Enter comments regarding the truck manifest to appear 
on Load and Load Front/Back view printouts only. Comments 2 appear in the header section 
while Comments 3 appear in the footer section above the customer information.
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Weight Tab (Truck Manifest)
To set up weight limits for king pin and axles based on different regions of the country.

•	 Weight Limit: Specify whether to enable weight limit option and pick the criterion if enabled. 

»» None: Weight limit option will not be enforced.

»» Weight Limit:  Select to use weight limit based on pre-defined weight data based on regions. 
Users can set weight limits for the kingpin and axles based on different regions of the country. 
See the next section.

»» COG Deviation:  Select this option to generate loads such that the center of gravity (COG) falls 
within a specified region, e.g. within a certain distance from the center of the vehicle along 
the length, width and height dimensions.

»» Segment Wgt Limit:  Select this option if you are using a vehicle with pre-defined weight 
segments.  See page 68 on how to create weight segments for vehicles and upcoming 
section.

Using Weight Limit

•	 Region: This option is active when Weight Limit option is selected. Use the drop-down list to 
select a region of the country.  If no regions are available from the drop list, click on the Edit 
Regions button to create new regions.

•	 King Pin: Enter the weight limit for the king pin – based on regulations in the selected region – in 
pounds or kilograms, depending on the Units selected.

•	 Axles: Enter the weight limit for the axles based on regulations in the selected region.

•	 Edit Regions Button: The Edit Region allows you to set up new regions, edit or delete existing 
regions. 

To create a new region, start from the Region dialog box and follow these instructions
1.	 Click on the Edit Regions button and the Region dialog box appears, as pictured here. 
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2.	 Click on the New button.

3.	 Enter information in the following fields:

»» Region: Enter the name of the new region e.g. Texas.

»» King Pin: Enter the weight limit for the king pin.

»» Axles: Enter the weight limit for the axles.

»» Tractor Weight: The tractor weight is not implemented. Please disregard steer axle, drive axle 
and tractor selection.

4.	 If all the new region information is correct, click on the Save button. MaxLoad Pro saves the new 
region to the database.

To edit a region, start from the Region dialog box and follow these instructions:

1.	 Use the Region drop-down list to select the region you want to edit.

2.	 Edit king pin, trailer axle, tractor steer and drive axle weights as necessary.

3.	 If all the updated weights are correct, click on the Save button.

To delete a region, start from the Region dialog box and follow these instructions:
1.	 Use the Region drop-down list to select the region you want to delete.

2.	 Click on the Delete button

Using COG Deviation

The COG deviation option allows you to generate loads such that the center of gravity (COG) falls 
within a +/- distance along the length, width and height dimensions from the center of the vehicle.
This feature is not implemented. Please contact TOPS for latest update.  

Using Segment Wgt Limit

This weight limit option only works with vehicles with pre-defined segment weights (under Define | 
Vehicles | Advanced option) and gives better control over weight distribution of the load.
To use this function, follow these steps:

1.	 Set up weight limit for different segments of the vehicle as described on page 68 in Chapter 3.

2.	 Turn on Weight limit by Segment (Segment Wgt Limit) under the Weight tab in the Truck 
Manifest Pick List.

3.	 Click Calculate and see the results.
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In the Solution View, the resulted weight per segment is provided on the upper left hand corner. Any 
segment with weight over the limit will be highlighted in red.

SKU List (Truck Manifest)
The SKU List, as pictured below, displays a list of all SKUs (shipcases, drums, etc.) in the SKU 
database.  This includes SKUs defined using the Define SKU function as well as SKUs imported with 
the import function.  All SKUs in this list are available for loading into a vehicle, onto a pallet or into a 
tote.  SKUs will automatically appear in this list as they are defined. 

When you click on a SKU, a blue bar highlights it.  The gray vertical scroll bar to the right of the box 
scrolls through the list and allows you to view more SKUs.

This SKU List contains useful information about all the SKUs.  All of this information is designed to 
help you make quick and easy decisions about the items you’re shipping.

•	 SKU Type:  This column contains graphical icons representing the SKU Type: palletload, shipcase, 
drum, tote or mixed pallet.
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•	 SKU:  This column contains the SKU Number, as defined in the Define SKU screen. This serves as 
the unique identifier for each of the product items in the database.

•	 Description:  This column displays the full description of the SKU.  As with the SKU column, 
contents of this column appear exactly as they are defined in the Define SKU screen.

•	 Dims:  This column displays the dimensions of each individual SKU.  The dimensions will appear 
either in English or Metric units, depending on which units are selected in the Toolbar.

•	 Wgt:  This column displays the defined weight of the SKU.  As with the dimensions column, this 
column will either appear in English or Metric units, depending on which units are selected in the 
Toolbar.

•	 SKU Info 1, SKU Info 2, & SKU Info 3:  These fields display the information saved under the 
Graphics tab while defining the SKU.

SKU List Local Menu

With the mouse cursor in the SKU List section, click the right mouse button to open the local menu 
as shown here. 

•	 Properties: Used to specify the SKU properties to be displayed under the SKU List.  You can also 
access the Properties dialog using the Edit | Properties menu.

•	 Edit:  This will bring you to the Define | SKU screen for the highlighted SKU.

•	 Copy to clipboard:  Copy the entire contents of the SKU list to the system clipboard. 
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Manifest List (Truck Manifest)
The Manifest List, displays a running list of all the selected SKUs to be loaded into the container.  As 
you select SKUs from the SKU List (by double clicking the SKU), they automatically appear in the 
Manifest List.  The Manifest List allows you to define specifics about the load; it contains both input 
fields and checkboxes that help tailor this load to your particular needs.

Let’s take a look at the Manifest List.

•	 SKU Type:  This column contains graphical icons representing the SKU Type: palletload, shipcase, 
drum, tote SKU or Pallet SKU.

•	 SKU:  This is the SKU Number, as defined in the Define SKU screen.

•	 Qty: The Quantity column displays the number of a specific SKU or palletloads to be loaded in the 
container(s).

If a palletload SKU is added to the Manifest List, the quantity will represent the number of 
palletloads but not the number of individual cartons on this palletload, which in turn will be 
displayed under the Piece Count column as described later.

�� Note: If the option “Load by SKU Ratio” under the Options tab is checked, the Qty 
column will represent the ratios of quantities of all the respective SKUs in the Manifest List.

•	 SO/Prior:  This column serves a dual purpose, allowing you to build a load using either Priority 
Numbers or Stop-Offs in the calculations.  The Manifest List shows one field or the other – Stop-
Offs or Priority – at all times.  To specify loading method to use, go to the Options tab and select 
one or the other.  If you don’t need to use either loading method, simply leave all numbers in this 
column the same; that is, all a stop off or priority of “1”. 

The Stop-Off function allows you to consider the loading sequence when various drop-shipments 
need to be made.  If you enter “1” in this column, MaxLoad Pro will place this item at the end of 
the trailer, where it can be easily reached at the first stop.  A stop-off value of “2” places the item 
further forward in the vehicle, accessible at the second stop-off.

If there’s not enough room to load the entire stop-off onto the vehicle, MaxLoad Pro will remove 
all SKUs that made up the stop-off, and will place all SKUs for the stop-off onto the Cut List.  
MaxLoad Pro will not partially load a stop-off.  

However, there is one exception to this functionality:  If the first stop-off will not fit into the 
selected vehicle, MaxLoad Pro will break up the stop-off in an effort to load something.  While we 
understand that this functionality does sacrifice cubic utilization, our customers have indicated 
that this is the preferred way to handle this situation.

The Priority function allows you to define the relative importance of a particular SKU when 
loading into a vehicle. All SKUs with a priority of “1” will be loaded before SKUs with a priority of 
“2,” which are loaded before SKUs with a priority of “3,” and so on.  This means that all SKUs with 
a Priority of “1” will generally be loaded before (and therefore in the front of the vehicle) SKUs 
with a lower priority value.
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If there’s not enough room to load all SKUs with a particular priority value, MaxLoad Pro will load 
as much of the priority as possible, leaving the remaining SKUs to be placed on the Cut List.  In 
other words, priorities can be split-up, unlike stop-offs.  

•	 UL: Allows you to place an SKU onto a unitload “on the fly.”  If you’ve previously created a 
unitload for a particular SKU, you can simply activate this checkbox and move on to the next field.  
MaxLoad Pro will load these SKUs using the pallet pattern you selected in the Create Unitload 
screen when you defined the SKU.  If you’ve not created a unitload for this SKU, the field will 
be grayed out, meaning that you cannot activate this field.  In this case, you’ll need to create a 
unitload in the Define SKU screen, then come back and activate the field.  

For more information, please refer to Chapter 3, Defining MaxLoad Pro Databases.

Checking this box does not guarantee that all SKUs will be loaded as part of a unitload.  How it is 
loaded will depend on the number of SKUs that make up a complete unitload as defined in the 
Create Unitload screen.  

For example, suppose you’ve created a unitload that consists of 44 cases of peanut butter.  If 
you want to load 88 cases of peanut butter, MaxLoad Pro will load all cases onto two complete 
unitloads.  However, if your order calls for 70 cases of peanut butter, MaxLoad Pro will load one 
complete unitload (44 cases), and will either load the remaining 26 cases on the floor or as part of 
a mixed-pallet (if the Mixed Pallet column is checked).  

The Unitload functionality allows you to either floor load a selected SKU or load it as a unitload.  
You may find that this feature comes in handy when you have products destined for two 
customers, but one requires SKUs to be shipped on pallets, while the other does not.  

If you want to do this, simply select the SKU twice from the SKU List box.  This action will create 
two separate line items in the Manifest List.  Enter a quantity to be loaded as part of a unitload, 
then check the UL box.  Do the same for the second line item of the SKU, but this time do not 
check the UL box.  This will designate this group of SKU to be floor-loaded. 

You’ll notice that this field may already be activated when you select a SKU from the SKU List.  
This occurs when you activate the “Unitize” field when you define a SKU.  Remember, that you’ll 
need to check this box even if only one SKU is to be shipped as part of a unitload.  The column 
must be displayed in order to activate the UL field.

�� Note:  UL and MP columns appear in the Manifest List only if the “Use Unitloads” and /
or “Use Mixed Pallets” options are checked under the Options tab, respectively.  

•	 MP: MP stands for Mixed Pallet i.e. a palletload consisting of multiple kinds of SKUs.  Creating a 
mixed-pallet on the fly allows you to choose a pallet type and have MaxLoad Pro load SKUs onto 
that pallet using either default parameters or the options you select through the Mixed-Pallet tab.  

MaxLoad Pro builds a default mixed pallet by layers, meaning that it will first look for full layers of 
SKUs before mixing and matching those layers.  MaxLoad Pro will not build a default mixed pallet 
using a column-building method.  Why not?  The results of this method are not always considered 
to be very stable.

When you check the MP box, you assign all SKUs in this row to either a unitload (if the UL box is 
checked) or to a mixed pallet.  When the MP box is checked, this particular SKU will not be floor-
loaded.  (unless you are using the Fill Item option) Using the scenario in the Unitload section, if 
26 cases of peanut butter remain, all 26 cases would be loaded onto a mixed pallet when this 
column is checked.

MaxLoad Pro builds a default mixed pallet by first looking to see if a unitload has been created 
for the SKU in question.  It will also determine if any parameters are similar – pallet, overhang, 
maximum height, etc.  If a unitload has been created and the parameters are the same, MaxLoad 
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Pro will build full layers based on the patterns used when creating the unitload.  Once full layers 
have been built, the remaining items will be loaded loosely on top of the mixed-pallet.  

Example:  Suppose we’ve created a unitload that consists of four layers of peanut butter cases; 
each layer consists of 11 cases.  Taking into consideration the remaining 26 cases that are to be 
placed onto a mixed pallet, and assuming all parameters are the same, MaxLoad Pro will load two 
layers of peanut butter (using the same pallet pattern as the complete unitload), comprising 22 
cases.  Then MaxLoad Pro will load the remaining four cases loosely on top of the mixed pallet.  

If any parameters have changed, this loading philosophy is thrown “out the window,” and MaxLoad 
Pro will determine the most efficient way to load the mixed pallet, taking into consideration the 
new loading parameters.

•	 Order #: You have the option of assigning an order number to each SKU or group of SKUs that 
you ship.  This column simply provides information that may be useful to your logistics staff.  
Information keyed into this field will be available on certain printouts, which in turn can be used 
when loading the vehicle or pallet.  

On the Options tab, you can then tell MaxLoad Pro to keep items within the same order together.  
If you do not use order numbers, you can uncheck the “Keep Same Orders Together” option under 
the Options tab.   

•	 % Cube: This field specifies the total volume of the specified quantity of that particular SKU, UL, 
or MP will occupy in the container.  You can use this number to get an “estimate” of how many 
vehicles you will need. 

•	 % Wgt: This field specifies the total weight of the specified quantity of that particular SKU, UL, or 
MP will weight with respect to the container.

•	 SKU Info 1, SKU Info 2, & SKU Info 3:  These fields display the information saved under the 
Graphics tab while defining the SKU.  

•	 Extra1 & Extra2: Not implemented.

•	 Piece Count: This field displays the total number of items which is contained within a given SKU, 
if a piece count has been provided during the SKU definition process.  For example, if you have 
told MaxLoad SKU Shampoo has a piece count of 24 (meaning each box of SKU Shampoo contains 
24 bottles of shampoo), then when you enter a quantity of 50 for SKU Shampoo, the Piece Count 
column will give a number of 1200.

•	 Fill Item:  When checked, this option instructs MaxLoad Pro to use the referenced SKU as fill items, 
meaning this SKU will be used to fill all available empty space in the container after the other SKUs 
(non fill items) are loaded.  

Add the SKU to be used as fill item to the Manifest List in the usual manner and enter the quantity.  
If there is still available space, increase the quantity of the fill item or select a second SKU as fill 
item.

However, if you specify more fill items than required to fill the void space, they will be placed in the 
CutList BUT the Next Truck button will not be available.

•	 Site 1, Site 2, Site 3 & Site 4:  These fields display cost related parameters, please contact TOPS for 
more information.

•	 Point Value:  This field displays cost related parameters, please contact TOPS for more information.

•	 Cube: This field specifies the total volume of the specified quantity of that particular SKU, UL, or 
MP.

•	 Wgt: This field specifies the total weight of the specified quantity of that particular SKU, UL, or MP.
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Adding or Updating SKUs to the Manifest List
You can add SKUs to the Manifest List by double clicking the SKU in the SKU list or use the SKU input 
list shown below to add the SKU information.

Type in the first few characters of the SKU Number in the field below will quickly bring you to the 
SKU in the list for selection. Enter the quantity and other information including priority, UL, MP (if 
enabled) and order number, then click on the Add>> button to add the SKU to the Manifest List.

To update existing SKU information in the Manifest List, highlight the SKU in the list. Make any 
corresponding changes and click on the Update>> button.

To quickly enable Use Unitload or Use Mixed Pallets for all SKUs in the Manifest List, click the right 
mouse button to access the context menu as shown below and select the corresponding option.

Changing the Display of the SKU and Manifest List
•	 List Items:  You can control what type of SKU data or Manifest information will be displayed in the 

SKU or Manifest List via the Edit | Properties menu function by following these steps:

1.	 Activate the SKU List or the Manifest List by clicking and highlight any one of the SKU item in 
the list.

2.	 Go to the Edit Menu in the menu bar and select Properties, which opens the Properties 
dialog box.
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1.	 Click the box to remove or add items that you would like to be included in the SKU List and 

Manifest List respectively.

�� Note: A short cut to access the Properties dialog box is to click the right mouse button 
while the mouse cursor rests inside the respective area.

•	 Sort Order:  The SKU and Manifest List appears in ascending or descending order, first numerically 
then alphabetically, with respect to the selected SKU field.  To sort on a particular filed, simply 
click on the corresponding column heading (SKU, Description, Dims, Wgt, or SKU Info) in the SKU 
List.  To sort the list in the reverse order, click on the same column heading again. 

For the Manifest List, you can only sort on SKU, Qty, Prior(ity)/SO or Order #.

•	 Column Width:  You can adjust the width of each column in the SKU or Manifest List to 
accommodate all the information in each column.  To expand a column, follow these instructions:

1.	 Position the mouse pointer on the edge of the column heading you want to expand.  For 
example, if you want to expand the Description column, place the mouse pointer (arrow) at 
the divider line between the Description and Dims columns, as pictured below. 
 
The mouse pointer changes shape from a single arrow to a double-ended arrow, as pictured 
below.

		
2.	 With the cursor as a double-ended arrow, now click on the left mouse button and drag the 

column to the desired width.  You can either expand or contract the width of the column.

3.	 Once the column is expanded to the desired width, release the left mouse button. The 
double arrow disappears, replaced with the standard mouse pointer.  When you release the 
mouse button, the new column width will be set.
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•	 View Size of the Lists:  The position of the SKU and Manifest List is fixed and always displays in 
the lower portion of the screen.  Regardless of the manifest or the tab selected, the SKU List and 
Manifest List will always appear.  However, you can adjust the view size of the two lists using 
these methods.

»» Split View :  By placing the mouse cursor on the vertical bar dividing the two lists, the cursor 
will change to a .  Now click on the left mouse button to move the dividing bar to adjust the 
size of the views for the two lists.

»» Full Width View  & : By clicking on the title bars of the two lists, the List will change its 
size to display all selected fields for the List as illustrated below.

 

 

»» Full Screen View : By clicking on the full screen icon  to the right of the Manifest List 
title bar, this will bring both lists to full screen size.  This will give you a better view to add SKUs 
to the Manifest List.  To restore the Tab view and the g.o.d. graphics window, click the restore 

icon  to the right of the Manifest List title bar.



  
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Manifest List Local Menu

With the mouse cursor in the Manifest List section, click the right mouse button to open the local 
menu as shown here. 

•	 Properties: Used to specify the Manifest list items to be displayed under the Manifest List.  You 
can also access the Properties dialog using the Edit | Properties menu.

•	 Check All UL:  Click this option to quickly enable Use Unitload for all SKUs in the Manifest List. 
Note that only SKUs with a previously defined UL pattern will be enabled.

•	 Uncheck All UL:  Click this option to quickly disable Use Unitload for all SKUs in the Manifest List. 

•	 Check All MP:  Click this option to quickly enable Use Mixed Pallets for all SKUs in the Manifest.

•	 Uncheck All MP:  Click this option to quickly disable Use Mixed Pallets for all SKUs in the Manifest.

•	 Copy to clipboard:  Copy the entire contents of the SKU list to the system clipboard. 

•	 Paste from clipboard:  Copy the contents of the system clipboard to the Manifest List.  This is a 
quick way to add SKUs to the manifest.  See page 211 for more details.

Defining a Truck Manifest
To define a truck manifest, start from the Control Center and follow these instructions:
1.	 Under the Truck Manifest box, click on the New button. The Manifest Pick List Screen appears.

2.	 Double click on the vehicle from the list of Available Vehicles. The selected vehicle(s) display in 
the Selected Vehicles list. 

3.	 Select the SKUs to be loaded from the SKU List by double clicking the SKUs.

4.	 In the Manifest List, enter a quantity and specify other parameters like stop-off/priority, order 
number, etc.

5.	 On the Options tab, designate which SKUs are to be loaded as part of a unitload or together on a 
mixed-pallet.

6.	 If everything is correct, click on the Calculate button. MaxLoad Pro calculates solutions based on 
your input.

7.	 Select the truck manifest solution from the Sol List that best meets your needs.

8.	 From the Menu Bar, open the File menu and select Save As and the File Save As dialog box 
appears.

9.	 In the blank line at the top of the box, replace the word “Untitled” with the name of this truck 
manifest and click Save.

�� Note:  Chapter 8, Viewing a Solution, describes in detail the options you have once a 
manifest has been calculated.  Chapter 9, Editing a Solution, discusses how to use the Editor 
to customize a solution.  Refer to those chapters for more details.
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Truck Manifest versus Single SKU Manifest for Single SKU Loads
If you’re loading only single-SKUs into a container, you can use either the Truck Manifest or the 
Single-SKU Manifest as described on chapter 7.  The major differences between the two functions 
are briefed as below:

•	 Quantity Specification:  In Single-SKU Manifest, it is not necessary to enter a quantity for the 
SKU to be loaded.  MaxLoad Pro will cube out the vehicle using as many of the specified SKU as 
possible.  You can however, tell MaxLoad Pro whether to load as SKU as floor loads or unitloads. 

With Truck Manifest, you must provide a quantity for the SKU in order for MaxLoad Pro to find a 
load solution.  If the solution calls for more than one vehicle, adjust the quantity accordingly.

•	 Load Editing:  There is no edit function for Single-SKU loads. You can select the different loading 
pattern styles (under the Options Tabs) only but with Truck Manifest, you have full 3D drag-and-
drop edit  capabilities.

•	 Algorithm Fine Tuning:  With Single-SKU loads, SKUs can only be loaded as unitloads or straight 
floor loads.  But with Truck Manifest, the single SKUs can be loaded in combination of unitloads, 
partial unitloads (Optimize Height for Top Layer) or loose items.

•	 Ceiling Clearance Requirement:  With Truck Manifest, you can specify a minimum ceiling 
clearance to accommodate forklift or other maneuvers but with Single-SKU, your work around is 
to reduce the loadable height of the vehicle.
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5 Loading a Pallet Manifest

This chapter explains how to use MaxLoad Pro to load a pallet manifest.  This chapter walks you 
through the process you’d most likely follow when building a palletload, including the following 
topics:

Pallet Manifest Pick List Screen

•	 Mixed Pallet Tab
•	 Options Tab
•	 Algorithm Options
•	 Comments Tab
•	 SKU List
•	 Manifest List

Defining a Pallet Manifest

Printing a Pallet Manifest
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Pallet Manifest Pick List Screen
Start from the Control Center and click on the New button under the Pallet Manifest icon.  The Pallet 
Manifest Pick List Screen appears as show here.

This screen is comprised of the following components:

•	 Mixed Pallet Tab:  Allows you to select the pallet(s) and enter the overall allowable height, 
weight, and overhang factors for the load.

•	 Options Tab: Allows you to enter parameters for loading the pallet(s).

•	 Comments Tab:  Allows you to enter comments regarding the pallet manifest, which appear on 
the printed reports.

•	 g.o.d. Window:  Displays a 3-dimensional graphic image of the pallet.

•	 SKU Input:  Allows you to enter SKU, quantity and other load parameters in the manifest list.

•	 SKU List:  Displays a list of all SKUs available for loading onto a pallet.

•	 Manifest List:  Running list of selected SKUs to be loaded onto pallet(s).  Here you even define the 
specifics about the load, like priority, quantity, etc.

•	 View Button:  Allows you to view a load without recalculating it.  This feature works only if you 
have previously built a load and is used primarily after you have made changes to the load in the 
Editor screen. 

•	 Calculate Button:  Allows you to calculate a pallet manifest.
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Mixed Pallet Tab (Pallet Manifest)
The Mixed Pallet tab, pictured below, allows you to select a pallet and enter the overall height, 
weight and overhang data for the load.

The Mixed Pallet tab contains the following fields:

•	 Pallet:  Allows you to select from various types of pallets and slipsheets already defined in the 
Pallet database.  You can select multiple pallets for the manifest and evaluate which one works 
the best for you.

MaxLoad Pro is shipped pre-loaded with a range of popular pallet styles.  However, if you can’t 
find a pallet or slipsheet that you want to use for this manifest, you can define a new one as 
described in Chapter 3.

�� Note: Similar to using multiple vehicle types in Truck Manifests, turn off CalcAllTrucks if 
you want to see solutions for each selected pallet types.

•	 Maximum Height Incl. Pallet:  Enter the maximum height of the mixed pallet load.  Remember 
to include the height of the pallet in this value.  MaxLoad Pro will not calculate any solution that 
violates this maximum height.

Theoretically, there’s no limit to the height to which MaxLoad Pro can build a mixed pallet.  The 
only limit is the value that you enter into this field.  Most mixed pallets are built to a height of 40-
70 inches.

•	 Maximum Weight Incl. Pallet:  MaxLoad Pro will not calculate any solutions that violate the 
defined maximum weight for the mixed pallet.  As with the Maximum Height field, remember 
that this value includes the weight of the pallet too.  You can verify the defined weight through 
the Define Pallet screen.  For more information, please refer to Chapter 3, Defining MaxLoad Pro 
Databases.

Again, there’s no theoretical limit to the amount of weight you can enter in this field.  However, 
you may want to check with the pallet manufacturer or shipping personnel to determine the 
maximum weight your pallet can handle.

•	 Maximum Length and Width Overhang:  These values represent the maximum distance a SKU 
can hang over the edge of the pallet.  The overhang dimension is illustrated here.
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For the purposes of building a stable load, we recommend that you limit the maximum overhang 
to at least one-half the length of the smallest SKU to be used in this manifest.  This will ensure 
that no SKU will have the majority of its mass hanging off the edge of the pallet.

When MaxLoad Pro builds a mixed-pallet load, it will use as much of the “available” space on the 
pallet as possible.  The amount of usable space is determined by the pallet size, the amount of 
overhang allowed, and the maximum height allowed to build a load.  

In effect, MaxLoad Pro uses this information to build invisible “walls” representing the absolute 
parameters of the mixed-pallet load.  In fact, when viewing a load you’ll notice that the usable 
area is shaded a different color to differentiate it from the background of the diagram.

Options Tab (Pallet Manifest)
The Options tab, pictured below, allows you to further customize your mixed pallet manifest by 
setting various loading parameters.  To access this screen, use the mouse to click on the Options tab 
button found at the top of the Mixed Pallet Manifest Pick List screen.

Note that options not available to the Pallet Manifest will be grayed out.

The Options tab contains the following fields:

•	 Load By Priority:  When a SKU is assigned a high-priority number, MaxLoad Pro loads it before 
loading a SKU with a lower priority.  MaxLoad Pro loads priority 1 before priority 2, which is 
loaded before priority 3.  

•	 Load By Stop Off:  When you load by stop off, the loading method is just the opposite of Load By 
Priority.   Stop off 1 is loaded after stop off 2, and therefore closest to the rear door; stop off 2 is 
loaded after stop o-ff 3, etc. 

�� Note: The following two options (Keep Same Orders Together and Keep Like SKUs 
Together) work in conjunction with stop-offs and priorities.  In other words, if you build 
a load with two stop-offs,  MaxLoad Pro will keep like SKUs or orders together within the 
individual stop-off or priority number.
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Bear in mind that checking either one of these boxes could potentially result in loss of cubic 
utilization.  While we can’t definitively say how these options will affect a load, it’s safe to say that 
these options will affect MaxLoad Pro’s calculations, thus making it possible that the load will be 
affected negatively.

•	 Stop & Priority:  Check this option when you want to add priority to each Stop Off.

•	 Keep Same Orders Together:  This option is linked directly to the Order # field in the Manifest 
List.  When you key in an order number, MaxLoad Pro gives you the option to group SKUs from 
the same order together when loading.  If you do not choose to input order numbers, this field 
will be meaningless, and activating the checkbox will not affect the placement of SKUs within 
your manifest.

•	 Keep Like SKUs Together:  This option is very similar to the Keep Same Orders Together option.  
Activating this option tells MaxLoad Pro to load all products with the same SKU number together.  
The Keep Like SKUs Together checkbox takes precedence over the Keep Orders Together 
checkbox, thus answering the question of what happens when both boxes are checked.

•	 Load by SKU Ratio: This option loads the pallet with the specified ratio of SKUs in the Manifest 
List. When this option is checked, enter the ratio of the respective SKUs in the Qty column.

For example, to load on the same pallet with SKUs A, B and C in the ratio of 2:3:1, enter in the Qty 
column 2, 3 and 1 for SKU-A, SKU-B and SKU-C respectively.

�� Note:  When this option is checked, all SKUs in the Manifest List will be loaded in the 
ratio specified in the Qty column.  You will not get a solution if MaxLoad cannot load all SKUs 
in the lowest multiple of the specified ratios.

•	 Maximum Vertical Gap:  This option allows you to control which spaces MaxLoad Pro joins 
together for the purpose of loading other items on top.  

In the process of loading SKUs onto a mixed pallet, MaxLoad Pro accumulates a list of “leftover” 
spaces.  Whenever possible, MaxLoad Pro combines neighboring leftover spaces to make larger 
spaces.  Ideally, these neighboring spaces present a level surface.  If they do not present a 
level surface, you can enter a value in this field that artificially “joins” the two uneven surfaces 
together, thus creating a larger level surface.

If the difference in height of the two spaces is less than or equal to this value (in English or Metric 
units), MaxLoad Pro joins together the offending gap, assuming that you will pad or brace the 
shorter space to bring it up to the height of the taller space.

•	 Maximum Priority Overlap:  MaxLoad Pro uses this option to determine the placement of the 
next priority or stop-off.  This field allows you to define the distance on the pallet that MaxLoad 
Pro will “mix” items of a different priority or stop-off.  This field determines how far forward into 
another priority or stop-off the front of an item with a lower priority number will be placed.  

For instance, if the value in this field is 30 inches, MaxLoad Pro will place the next priority on top 
of the previous priority, with the front of the lower priority protruding over the top of the higher 
priority by a maximum of 3 inches.  This would leave a 3 inch gap between the two loading of two 
priorities 

•	 Days Range: Not implemented.

•	 Algorithms Button:  This button displays the Algorithm Options dialog box, which allows you to 
determine how MaxLoad Pro will load a manifest
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Algorithm Options
The Algorithm Options dialog box, allows you to determine how MaxLoad Pro will load a manifest.  
The sliding calculation bar allows you to calculate loads based on speed or efficiency.  MaxLoad 
also features a progress bar and dialog box that display how your load is being configured while it is 
calculating.

The Algorithm Options dialog box contains the following features:

Algorithms

•	 Load Front to Back:  Loads a pallet starting at one edge of the pallet and working toward the 
opposite edge, stacking mixed or identical-sized SKUs in columns.

•	 Space Evenly:  Essentially spreads a load over the entire surface area of the pallet in order 
to make a more secure unitload.  Whenever the cargo’s cubic measurement is less than the 
unitload’s available cubic capacity – remember that you define parameters of height, weight and 
overhang to define the cubic capacity – MaxLoad Pro creates an artificial “ceiling.”  This lowers 
the maximum height of the load, forcing it to be spread as equally as possible over the surface 
area of the pallet.

•	 Load Floor to Ceiling:  MaxLoad Pro first takes the largest, strongest SKU it can find, starting at 
the base of the pallet and builds the load upwards. It always loads the larger boxes first, with 
smaller boxes on top. This loading method may result in mixed layers of products, depending on 
the quantities chosen and other parameters (e.g. stacking strength).

•	 Flatbed: Not applicable for Pallet Manifest.

•	 Layers:  The Layers algorithm will be checked automatically by default for Pallet Manifest.  When 
Enabled, MaxLoad Pro will group SKUs of similar heights to form stable layers for the entire pallet.
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Optimize

•	 Pinwheel Optimization for Pallets:  This feature is not available for loading pallet.

•	 Left-to-Right Optimization:  Check the box to optimize the manifest load from left to right.

Looks for the best combination of two placements in order to maximize the space across the 
width of the pallet.  When you use this option, MaxLoad Pro attempts to find some combination 
of two placements to optimize the width of the pallet.  If the box is not checked, MaxLoad Pro 
will strive to place the largest placement possible in the pallet, but won’t necessarily attempt to 
maximize the space across the width of the pallet.  

It’s important to understand that this algorithm does not always provide the best solution, 
even though the logic behind the algorithm would suggest that it would.  Why not?  Because 
of the physical dimensions of the SKUs being loaded onto a pallet, there simply may not be a 
combination of two placements that can maximize the width.  

•	 Speed-Space Tab: Move the sliding bar to optimize calculation for speed (flush left) or for 
efficiency (flush right)

The For Speed option tells MaxLoad Pro to calculate solutions as quickly as possible.

The For Space option tells MaxLoad Pro to take more time and calculate the most space-efficient 
solutions.

In addition to using the sliding bar, you can also enter a number between 1 (speed) and 200 
(space) in the box and click the Set button.

When you click OK, in the Algorithms dialog box, MaxLoad Pro saves your algorithm options to 
memory and returns you to the Pallet Manifest Pick List Screen.

The next time you calculate solutions for this manifest, MaxLoad will display a progress dialog 
box.  

�� Note:  When you select multiple algorithms, MaxLoad Pro will display at least one 
solution for each selected algorithm.  Also, whenever Left to Right Optimization is turned on, 
MaxLoad Pro will calculate two solutions for each selected algorithm.

    

Notice the following about the Progress Dialog Box:

•	 The dialog box displays a running count of the following parameters for the current calculation:  
quantity, cubic efficiency, cut list count, solution count, container number and time elapsed.

•	 A Stop button allows you to stop the calculation at any time and gives you the best solution 
found so far.
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Staggered

This algorithm is used to load round shape SKUs.  Due to the cylindrical shape, MaxLoad Pro gives 
the following options to load the SKUs onto a pallet.

•	 None: This option assumes that cylindrical objects are rectangular SKUs and loads them in a 
linear fashion as a shipcase

•	 Tight:  Loads as many cylindrical SKUs as possible along the width.

•	 Spread:  This to spread the round SKUs during loading

•	 Pyramid: This is for loading the cylindrical SKUs on their side, in horizontal orientation, stacking in 
a pyramid shape.

Unitload Options

These are available for Truck Manifest only and are grayed out for Pallet Manifest.  Refer to Chapter 
4, Truck Manifest for more details.

Comments Tab (Pallet Manifest)
The Comments tab provides the same fields as in the Truck Manifest.  For more information, please 
refer to Chapter 4, Loading a Truck Manifest on page 4.15.

SKU List (Pallet Manifest)
The SKU List, displays a list of all SKUs available in the SKU database.  For more information, please 
refer to Chapter 4, Loading a Truck Manifest, on page 4.18.

Manifest List (Pallet Manifest)
The Manifest List displays the SKUs onto the pallet.  As you select SKUs, by double clicking in the SKU 
List, they automatically appear in the Manifest List.  For more information, please refer Chapter 4, 
Loading a Truck Manifest, on page 4.19.
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Defining a Pallet Manifest
To define a new pallet manifest, start from the Control Center and follow these instructions: 

1.	 Under the Pallet Manifest box, click on the New button. The Manifest Pick List Screen appears

2.	 Select the pallet(s) from Pallet list to be used for the manifest by clicking against the pallet types 
you’d like to evaluate.

�� Note: Uncheck the CalcAllTrucks option under the Tools>  Configuration>Global menu in 
order to evaluate one pallet load at a time. You will need to login as Supervisor (password = 
tops software) in order to access the Global menu.

3.	 Enter values for maximum height, weight and overhang. The maximum height and weight values 
include the pallet. Maximum overhang must be defined for both the length and width of the 
pallet.

4.	 Select the SKUs to be loaded from the SKU List by double clicking the item.  The selected SKUs 
display in the Manifest List.

5.	 In the Manifest List, enter a quantity and stop-off/priority number for each SKU.  You can 
designate which loading method (i.e. by stop-off or priority) to use under the Options tab.

6.	 In the Manifest List, key in an order number, if applicable.

7.	 If everything is correct, click on the Calculate button.

8.	 Select the solution that best meets your needs from the Sol List.

9.	 To save the Manifest, go to File | Save As at the menu bar.

10.	 In the blank line at the top of the dialog box, replace the word “Untitled” with the name of this 
mixed pallet manifest.

11.	 You have the option to also save this mixed pallet manifest as a SKU in the database to be used 
in a Truck Manifest by checking the Save As SKU box.  See “Save as SKU” on page 29 for more 
information.

�� Note:  Chapter 8, Viewing a Solution, describes in detail the options you have once a 
manifest has been calculated.  Chapter 9, Editing a Solution, discusses how to use the Editor 
to customize a solution.  Refer to those chapters for more details.



108 | MaxLoad®Pro User Guide v4.0

Printing a Pallet Manifest
To see a report of the new mixed pallet manifest, open the File menu and select one of the Print 
Preview options.

In the Mixed Pallet analysis, the normal Print and Print Preview functions are available.  Further, 
if you’re working with a Truck analysis in which one or more mixed pallet SKUs are loaded onto a 
vehicle, you can print reports for those mixed pallet SKUs that are part of the truck manifest.  From 
the Truck analysis, follow these instructions:

1.	 Open the File Menu, select Print Preview, then select Unitload. The Print Preview window 
displays a report for the first mixed pallet SKU loaded onto the vehicle.

2.	 If the truck manifest includes more than one mixed pallet SKU, click on the Next Page button. 
The Print Preview window displays a report for the next mixed pallet SKU in the manifest.
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6 Loading a Tote Manifest

A tote manifest is a specific collection of SKUs placed into a shipcase.  For example, suppose you ship 
snack products to a small grocery store on a routine basis.  This shipment always includes cases of 
cookies, potato chips and saltines.

The tote manifest allows you to place these various items, or SKUs, into a tote (shipcase) and load it 
onto a vehicle.  MaxLoad Pro allows you to create this tote manifest, save it to the SKU database and 
use it as a SKU in a vehicle analysis.

This chapter walks you through the process you’d follow when building a tote, including the 
following topics:

Tote Manifest Pick List Screen

•	 Tote tab
•	 Options tab
•	 Algorithm Options
•	 Comments tab
•	 SKU list
•	 Manifest list

Defining a Tote Manifest

Printing a Tote Manifest
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Tote Manifest Pick List Screen
Start from the Control Center and click on the New button under the Tote Manifest icon. The Tote 
Manifest Pick List screen appears.

This screen is comprised of the following components:

•	 Tote Tab: Lists the available totes/shipcases that can be used for a manifest.

•	 Options Tab:  Allows you to enter parameters for loading the totes.

•	 Comments Tab:  Enter comments regarding the tote manifest.

•	 g.o.d. Window:  Displays a 3-dimensional graphic image of the tote.

•	 SKU List:  Displays a list of all SKUs available in the SKU database.

•	 Manifest List:  A running list of selected SKUs for a tote manifest.

•	 View Button:  Allows you to view a load without recalculating it.  

•	 Calculate Button:  Allows you to calculate a tote manifest.
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Tote Tab (Tote Manifest)
The Tote tab, pictured below, allows you to select a shipcase to be used with the tote.

The Tote tab contains the following features:

•	 Tote List:  Displays a list of available shipcases in the tote database.  In order to build a load, you 
will need to either choose an existing tote or define a new one through the Define menu. 

Double click on a tote in Tote List to move it to the Selected Totes list.  Also notice that as a tote 
name is highlighted, a representation of that tote appears in the g.o.d. (graphical on-line drawing) 
window.

MaxLoad Pro allows you to load multiple totes at one time.  To do so, select more than one tote 
to be analyzed when calculating a manifest.  Simply follow the procedure described above to 
select multiple totes.

•	 Selected Totes:  Displays the totes selected from the Tote List, for a particular manifest.        

When Maxload Pro calculates solutions for a manifest, it uses only the totes listed in the Selected 
Totes list.  To remove a tote from this list, double click on the tote in question, in the Selected 
Tote list.  This will remove the tote from the Selected Tote list and place it back in the Tote List.  A 
representation of the selected tote will appear in the g.o.d. window.

Options Tab (Tote Manifest)
The Options tab, pictured below, allows you to further customize your tote manifest by setting 
various loading parameters.  To access this screen, use the mouse to click on the Options tab button 
found at the top of the Tote Manifest Pick List screen.
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The Options tab contains the following fields, though these might not be very relevant for a tote 
manifest:

•	 Load By Priority:  When a SKU is assigned a high priority number, it will be loaded before an SKU 
with a lower priority number.  Priority 1 will be loaded before priority 2, which will be loaded in 
front of priority 3.

�� Note: Load By Priority and Load By Stop Off options determine which column is 
displayed in the Manifest List: Priority or Stop-Off.  You can select either Load By Priority 
option or Load By Stop Off, but not both.

•	 Load By Stop Off:  When you load by stop-off, the loading method is just the opposite: Stop-off 1 
is loaded after stop-off 2, stop-off 2 is loaded after stop-off 3, etc.

�� Note: The following two options (Keep Same Orders Together and Keep Like SKUs 
Together) work in conjunction with stop-offs and priorities.  In other words, if you build 
a load with two stop-offs, MaxLoad Pro will keep like SKUs or orders together within the 
individual stop-off or priority number.

Bear in mind that checking either one of these options could potentially result in the loss of cubic 
utilization.  While we can’t definitely say how these options will affect a load, it’s safe to say that 
these options will affect MaxLoad Pro’s calculations, thus making it possible that the load will be 
affected negatively.  Load By Stop Off for totes works in conjunction with the Load Front to Back 
algorithm.  

•	 Stop & Priority: Check this option when you want to add priority to each Stop Off.

•	 Keep Same Orders Together:  This option is linked directly to the Order # field in the Manifest 
List.  When you key in an order number, MaxLoad Pro gives you the option to group SKUs from 
the same order together when loading.  If you do not choose to input order numbers, this field 
will be meaningless, and activating the checkbox will not affect the placement of SKUs within 
your manifest.

•	 Keep Like SKUs Together:  This option is very similar to the Keep Same Orders Together option.  
Activating this option tells MaxLoad Pro to load all products with the same SKU number together.  
The Keep Like SKUs Together option takes precedence over the Keep Same Orders Together 
checkbox, thus answering the question of what happens when both boxes are checked.

•	 Load by SKU Ratio:  Selection of this option directs MaxLoad Pro to load a tote with a given ratio 
of SKUs instead of quantities.  

For example, you can instruct MaxLoad to load a container with double the quantity of SKU-A 
than SKU-B; or have the quantity of three selected SKUs in the ratio of 3:2:1. 

•	 Minimum Ceiling Clearance:  This feature is available only for Truck Manifest analysis.  For more 
information, please refer Chapter 4, Loading a Tote Manifest

•	 Maximum Vertical Gap:  This option lets you control which spaces MaxLoad Pro joins together for 
the purpose of loading other items on top.  

In the process of loading SKUs into a tote, MaxLoad Pro accumulates a list of “leftover” spaces.  
Whenever possible, MaxLoad Pro combines neighboring leftover spaces to make larger spaces.  
Ideally, these neighboring spaces present a level surface.  If they do not present a level surface, 
you can enter a value in this field that artificially “joins” the two uneven surfaces together, thus 
creating a larger level surface.

If the difference in height of the two spaces is less than or equal to this value (in English or Metric 
units), MaxLoad Pro joins together the offending gap, assuming that you will pad or brace the 
shorter space to bring it up to the height of the taller space.
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•	 Maximum Priority/Stop-Off Overlap:  MaxLoad Pro uses this option to determine the placement 
of the next priority or stop-off.  This field allows you to define the distance inside the tote that 
MaxLoad Pro will “mix” items of a different priorities or stop-offs.  This field determines how far 
forward into another priority or stop-off the front of an item with a lower priority number will be 
placed.  

For instance, if the value in this field is 30 inches, MaxLoad Pro will place the next priority on top 
of the previous priority, with the front of the lower priority protruding over the top of the higher 
priority by a maximum of 30 inches.  

•	 Days Range: Not implemented.

•	 Algorithms Button:  This button displays the Algorithm Options dialog box, which allows you to 
determine how MaxLoad Pro will load a manifest.  

Algorithm Options
The Algorithm Options dialog box, allows you to determine how MaxLoad Pro will load a manifest.  
The sliding calculation bar allows you to calculate loads based on speed or efficiency.  MaxLoad Pro 
also features a progress bar and dialog box that display how your load is being configured while it is 
calculating.

The Algorithm Options dialog box contains the following features:

Algorithms

•	 Load Front to Back:  Loads a tote, starting at one edge of the tote and working toward the 
opposite edge, stacking mixed or identical-sized SKUs in columns.

•	 Space Evenly:  Essentially spreads a load over the entire surface area of the tote.

•	 Load Floor to Ceiling:  MaxLoad first takes the largest, heaviest SKU it can find, starting at 
the base of the tote and moving upwards.  MaxLoad Pro always loads larger SKUs first, with 
smaller SKUs on top.  This loading method may result in mixed layers of products, depending on 
quantities chosen and other parameters (e.g., stacking rules).
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•	 Layers:  Available to pallet manifests only and is grayed out for Tote Manifest, this will load SKUs 
with similar heights to form stable layers.

Optimize

•	 Pinwheel Optimization for Pallets:  This feature is not available for loading totes

•	 Left-to-Right Optimization:  Check the box to optimize the manifest load from left to right.

Looks for the best combination of two placements in order to maximize the space across the 
width of the tote.  When you use this option, MaxLoad Pro attempts to find some combination 
of two placements to optimize the width of the tote.  If the box is not checked, MaxLoad Pro 
will strive to place the largest placement possible in the tote, but won’t necessarily attempt to 
maximize the space across the width of the tote.  

It’s important to understand that this algorithm does not always provide the best solution, even 
though the logic behind the algorithm would suggest that it would.  Why not?  Because of the 
physical dimensions of the SKUs being loaded into a tote, there simply may not be a combination 
of two placements that can maximize the width.  

•	 Speed-Space Tab:  Move the sliding bar to optimize calculation for speed (flush left) or for 
efficiency (flush right).

The For Speed option tells MaxLoad Pro to calculate solutions as quickly as possible.

The For Space option tells MaxLoad Pro to take more time and calculate the most space-efficient 
solutions.

In addition to using the sliding bar, you can also enter a number between 1 (speed) and 200 
(space) in the box and click the Set button.

When you click OK, in the Algorithms dialog box, MaxLoad Pro saves your algorithm options to 
memory and returns you to the Tote Manifest Pick List Screen.

The next time you calculate solutions for this manifest, MaxLoad will display a progress dialog 
box, as pictured on the next page.  

�� Note:  When you select multiple algorithms, MaxLoad Pro will display at least one 
solution for each selected algorithm.  Also, whenever Left to Right Optimization is turned on, 
MaxLoad Pro will calculate two solutions for each selected algorithm.

Notice the following about the Progress Dialog Box :

•	 The dialog box displays a running count of the following parameters for the current calculation:  
quantity, cubic efficiency, cut list count, solution count, container number and time elapsed.

•	 A Stop button allows you to stop the calculation at any time and gives you the best solution 
found so far.
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Staggered

This algorithm is used to load round shape SKUs.  Due to the cylindrical shape, MaxLoad Pro gives 
the following options to load the SKUs in a container.

•	 None: This option assumes that cylindrical objects as rectangular SKUs and loads them in a linear 
fashion as a shipcase

•	 Tight:  Loads as many cylindrical SKUs as possible along the width.

•	 Spread:  This to spread the round SKUs during loading

•	 Pyramid: This is for loading the cylindrical SKUs on their side, in horizontal orientation, stacking in 
a pyramid shape.

Unitload Options

These are available for Truck Manifest and are not applicable for Tote Manifests. 

Comments Tab (Tote Manifest)
The Comments tab provides the same fields as in the Truck and Pallet Manifest.  For more 
information, please refer to Chapter 4, Loading a Truck Manifest.

SKU List (Tote Manifest)
The SKU List, displays a list of all SKUs available in the SKU database.  For more information, please 
refer to Chapter 4, Loading a Truck Manifest, on page 4.18.

Manifest List (Tote Manifest)
The Manifest List displays the SKUs onto the pallet.  As you select SKUs, by double clicking in the SKU 
List, they automatically appear in the Manifest List.  For more information, please refer Chapter 4, 
Loading a Truck Manifest, on page 4.19.

Defining a Tote Manifest
To create a new tote manifest, start from the Control Center and follow these instructions:
1.	 Under the Tote Manifest box, click on the New button. The Manifest Pick List Screen appears

2.	 From the Tote List, select the tote (shipcase) that you want to use to create the new tote 
manifest.  You’ll place your SKUs into this tote (shipcase).  To select a tote from the Tote List, 
double-click on it. The selected tote appears in the Selected Totes list. 

3.	 From the SKU List, select the specific SKUs that will be placed into the tote.  To select a SKU, 
double-click on it. The selected SKUs appear in the Manifest List.

4.	 Define the quantity of each SKU, in the Manifest List, that will be placed into the tote.  When 
you’re finished defining SKU quantities, click on the Calculate button.

MaxLoad Pro calculates various solutions for the tote manifest and displays the first of the 
solution from the Sol List in the View Screen

5.	 Select the tote manifest solution from the Sol List that best meets your needs.

6.	 From the Menu Bar, open the File menu and select Save As.  The File Save As dialog box appears. 

7.	 In the blank line at the top of the box, replace the word “Untitled” with the name of this Tote 
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manifest.  

8.	 Check the Save As SKU box, if you want to save the manifest as SKU to be used in a Truck 
Manifest and click OK. The Save Manifest as SKU dialog box appears, as pictured below.

  

9.	 In the blank SKU field, give the tote manifest a SKU name and click OK.  

MaxLoad Pro saves the new tote manifest/SKU to the SKU database and returns you to the View 
Screen.  See “Save as SKU” on page 29 for more information.

Printing a Tote Manifest
To see a report of the tote manifest, open the File menu and select one of the Print Preview options.   
Also, suppose you’re working with a truck manifest that has one or more tote SKUs loaded onto a 
vehicle.  From the truck analysis, you can print reports for those tote SKUs that are part of the truck 
manifest.  From the truck analysis, follow these instructions:

1.	 Open the File Menu, select Print Preview, then select Totes. The Print Preview window displays a 
report for the first tote SKU loaded onto the vehicle.

2.	 If the truck manifest includes more than one tote SKU, click on the Next Page button. The Print 
Preview window displays a report for the next tote SKU in the manifest.
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7 Loading a Single-SKU Manifest

This chapter explains how to load a single-sized case manifest using MaxLoad Pro.  All you have to 
do is to pick a transit vehicle and the SKU to be loaded, MaxLoad will show you the different ways to 
cube out the vehicle with the selected SKU.

The topics outlined in the chapter are as follows:

Single-SKU Manifest Pick List Screen

•	 Vehicle Tab
•	 Options Tab
•	 Comments Tab
•	 SKU Addition and Update
•	 SKU List
•	 Manifest List

Defining a Single–SKU Manifest
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Single-SKU Manifest Pick List Screen
Once you’ve logged into MaxLoad Pro, the first screen that appears is the Control Center.  This 
screen, described in detail in Chapter 2, The Basics, contains icons representing each of the various 
types of problems you can solve using MaxLoad Pro.  To start a new Single-SKU Manifest, start from 
the Control Center and follow these instructions:

Click on the New button under the Single SKU icon. The Single-SKU Manifest Pick List screen appears.

The Single-SKU Manifest Pick List Screen is comprised of the following components:

•	 Vehicle Tab:  Allows you to select the type of transit vehicle to be used for a manifest.

•	 Options Tab:  Allows you to define the pattern in which the SKU will get loaded in the transit 
vehicle.

•	 Comments Tab:  Allows you to enter comments to be displayed on the Single-SKU printouts.

•	 g.o.d. Window:  Displays a 3-dimensional graphic image of the selected transit vehicle.

•	 SKU List:  Displays a list of all SKUs (PalletLoads, Shipcases, Drums, Tote SKUs, and Pallet SKUs) 
available in the SKU database. 

•	 Manifest List:  Displays the single SKU selected to be loaded into the transit vehicle, particular to 
a manifest.  As you select the SKU from the SKU List it automatically appears in the Manifest List.  

�� Note:  For Truck Manifest, Pallet Manifest, and Tote Manifest the Manifest List can 
contain more than one SKU.

•	 View Button:  Allows you to view a previously calculated load, without recalculating it.  This 
feature works only if you’ve previously calculated a load and is used primarily after you’ve made 
changes to a load in the Editor screen.

•	 Calculate Button:  Allows you to calculate a load/manifest.
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Vehicle Tab (Single-SKU Manifest)
The Vehicle tab, allows you to select the type of transit vehicle (Truck, Sea Van, Rail Car, etc.) for a 
manifest.

The Vehicle tab contains the following components/fields:

•	 Vehicle Type:  Displays the various kinds of vehicles defined in MaxLoad Pro.  You can narrow 
down the list of available vehicles by choosing a Vehicle Type.  This action will filter the Available 
Vehicles list to display only one type of vehicle.

•	 Available Vehicles:  Displays the list of all vehicles available in the database for the Vehicle Type 
specified.  In order to build a load, you will need to either choose an existing vehicle or define a 
new one through the Define menu.

Double click on a vehicle in Available Vehicles list to move it to the Selected Vehicles list.  Also 
notice that as a vehicle name is highlighted, a representation of that vehicle displays in the g.o.d. 
(graphical on-line drawing) window.

•	 Selected Vehicles:  Displays the vehicle selected from the Available Vehicles list, for a particular 
manifest.

When MaxLoad Pro calculates solutions for the Single-SKU manifest, it uses only the vehicle listed 
in the Selected Vehicles list.  To select another vehicle, simply double-click a different vehicle 
under the Available Vehicle list, the current selection will be update to reflect the new selection.

A representation of the selected vehicle will appear in the g.o.d. window. 

•	 View Button:  The View Button is active if you’ve opened an existing analysis or a new analysis 
has been calculated. It opens the Manifest View screen.

•	 Calculate Button:  The Calculate button will instruct MaxLoad Pro to find loading solutions based 
on the parameters entered in the analysis. When the calculation is complete, MaxLoad Pro opens 
the Manifest View screen.
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Options Tab (Single-SKU Manifest)
The Options tab, as pictured below, allows you to further customize your manifest by defining 
pattern styles for the load.

MaxLoad Pro allows you to analyze a number of pattern styles when loading a SKU into a vehicle.  
When loading SKUs into a vehicle, MaxLoad Pro will attempt to calculate at least one solution for 
every pattern style you’ve chosen.  Keep in mind, however, that MaxLoad Pro may not find a solution 
that utilizes every pallet pattern chosen.  This is especially true for some of the less common pattern 
styles, such as Soldiered, Multi Layer, Multi Dim, etc.  The characteristics of the SKU will ultimately 
determine whether or not a pattern style can be used to develop a solution.

Below are images of two unitloads, displayed in plan view for each pattern type.  Each image uses 
the depth dimension as the vertical dimension.  

•	 Block1:  The Block1 pattern is also known as column stack pattern.  It is 
simple pattern with all of the shipcases stacked in the same orientation. 

•	 Block2:  A bi-block pattern is formed by the shipcases stacked in two 
different orientations.  Also known as an interlock pattern, when used in 
conjunction with layer rotation.  

•	 Block3:  In a tri-block pattern the SKU blocks are stacked in three 
different orientations.

•	 Block4: A Block4 pattern, is made up of four blocks of shipcases that 
form a pinwheel-like figure.

•	 Block5: A penta-block pattern is made up of five blocks of shipcases.  
Four blocks of shipcases form a pinwheel configuration; the fifth block 
of shipcase is positioned in the middle.

•	 Block5 Plus: The Block5 Plus pattern has another Block5 pattern 
in the middle of the configuration. Four blocks of shipcases form a 
pinwheel configuration; a separate 5-block configuration of shipcases is 
positioned in the middle. 
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•	 Soldiered: In a Soldiered pattern the cases are spaced apart so 
that other cases can be turned on their sides and fit into the 
space. 

•	 Diagonal: The diagonal pattern has alternating blocks of shipcases that form 
a diagonal configuration.  

•	 Staggered:  The staggered pattern is used to load round containers onto a 
pallet.  As you can see, the round containers mean the configuration will have a 
staggered, rather than linear, pattern. 

•	 Multi Layer:  In the two unitloads pictured on next page, the top layer is 
lifted to show that different layers have different patterns.  With a multi-
layer pattern, MaxLoad Pro configures the unitload with the vertical 
dimension specified by the user, with the exception of the top layer.  (The 
top layer is not affected by stacking strength).Multi Dim:  In a Multi Dim 
pattern, each layer has a different vertical dimension.

•	 Multi Dim: In a multi Dim pattern, each layer has a different vertical 
dimension.

•	 Multi Surface:  The figure here shows a multi-surface pattern.  
With this pattern, MaxLoad Pro turns the pallet on its side, loads 
the pallet, configures the pattern, then turns the pallet upright 
again.  In the figure below, the arrows indicate the side on which 
MaxLoad Pro loaded the pallet.  To use a multi-surface pattern, it’s 
necessary to select at least two dimensions as vertical dimensions.  
When you use a multi-surface pattern, MaxLoad Pro automatically 
calculates other multi-patterns.

Comments Tab (Single-SKU Manifest)
The Comments tab provides the same fields as in the Truck, Pallet and Tote Manifest.  For more 
information, please refer to Chapter 4, Loading a Truck Manifest, on page 85.

Adding or Updating SKUs to the Manifest List
You can add SKUs to the Manifest List by double clicking the SKU in the SKU list or use the SKU input 
list shown below to add the SKU information.

Type in the first few characters of the SKU Number in the field below will quickly bring you to the 
SKU in the list for selection. Enter any quantity (it will not be used but we will need a number here) 
and whether it is loaded as UL, then click on the Add>> button to add the SKU to the Manifest List.

Options Tab (Single-SKU Manifest)
The Options tab, as pictured below, allows you to further customize your manifest by defining 
pattern styles for the load.

MaxLoad Pro allows you to analyze a number of pattern styles when loading a SKU into a vehicle.  
When loading SKUs into a vehicle, MaxLoad Pro will attempt to calculate at least one solution for 
every pattern style you’ve chosen.  Keep in mind, however, that MaxLoad Pro may not find a solution 
that utilizes every pallet pattern chosen.  This is especially true for some of the less common pattern 
styles, such as Soldiered, Multi Layer, Multi Dim, etc.  The characteristics of the SKU will ultimately 
determine whether or not a pattern style can be used to develop a solution.

Below are images of two unitloads, displayed in plan view for each pattern type.  Each image uses 
the depth dimension as the vertical dimension.  

•	 Block1:  The Block1 pattern is also known as column stack pattern.  It is 
simple pattern with all of the shipcases stacked in the same orientation. 

•	 Block2:  A bi-block pattern is formed by the shipcases stacked in two 
different orientations.  Also known as an interlock pattern, when used in 
conjunction with layer rotation.  

•	 Block3:  In a tri-block pattern the SKU blocks are stacked in three 
different orientations.

•	 Block4: A Block4 pattern, is made up of four blocks of shipcases that 
form a pinwheel-like figure.

•	 Block5: A penta-block pattern is made up of five blocks of shipcases.  
Four blocks of shipcases form a pinwheel configuration; the fifth block 
of shipcase is positioned in the middle.

•	 Block5 Plus: The Block5 Plus pattern has another Block5 pattern 
in the middle of the configuration. Four blocks of shipcases form a 
pinwheel configuration; a separate 5-block configuration of shipcases is 
positioned in the middle. 
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SKU List (Single-SKU Manifest)
The SKU List, displays a list of all SKUs available in the SKU database.  For more information, please 
refer to Chapter 4, Loading a Truck Manifest, on page 88.

Manifest List (Single-SKU Manifest)
The Manifest List displays the SKUs onto the pallet.  As you select SKUs, by double clicking in the SKU 
List, they automatically appear in the Manifest List.  For more information, please refer Chapter 4, 
Loading a Truck Manifest, on page 90.

Defining a Single-SKU Manifest
To define a Single-SKU Manifest, start from the Control Center and follow these instructions:

1.	 Under the Single-SKU Manifest box, click the New button or go to the File Menu, select New and 
then Single SKU Load from the submenu. The Manifest Pick List Screen appears

2.	 Select a vehicle from the list of Available Vehicles by double clicking on the vehicle. The selected 
vehicle displays in the Selected Vehicles list. 

3.	 Select the SKU to be loaded from the SKU List by double clicking on the SKU. The selected SKU 
displays in the Manifest List pane.

4.	 If a unitload pattern has been defined previously for the selected SKU, the UL option in the 
Manifest List will be enabled (x); MaxLoad will fill the vehicle with the selected SKU in 
unitloads.  

To cube out the vehicle with floor-loaded SKUs (not unitloads), click on the UL icon to remove 
the cross mark.

5.	 If everything is correct, click on the Calculate button.

MaxLoad Pro calculates solutions based on your input and displays them in the solution view screen.

Printing a Single-SKU Manifest
To see a report of the Single-SKU load, which basically is Load or Manifest reports, open the File 
menu and select one of the Print or Preview options. 

Single-SKU vs. Truck Manifest
You can use either manifest types to calculate vehicle load for a single SKU but here are the major 
differences between the two manifest type.  Please see “Truck Manifest versus Single SKU Manifest 
for Single SKU Loads” on page 97 for details.
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8 Viewing a Solution

This chapter discusses the various ways in which you can view a completed manifest.  You will learn 
ways to progressively load or unload the vehicle to see how the load is constructed.  This chapter will 
also discuss in detail the various text reports that are available after calculating a solution.

Though the process of building the various types of manifests is dramatically different, the options 
provided when viewing a solution are generally quite similar.  The majority of what we discuss in this 
chapter applies to the solutions calculated when building all four manifest types (truck, pallet, tote, 
single SKU).  Any differences will be highlighted.

The various topics outlined in this chapter are as follows:

Manifest View Screen

•	 Toolbar
•	 View Buttons
•	 Other View Options
•	 Additional Viewing Options
•	 Action Buttons
•	 Load Statistics
•	 Tabs

Viewing Items on the Cut List

SKU Information
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Manifest View Screen
To view a load, follow these instructions:

Key in all of the necessary parameters in the Manifest Pick List screen and click on the Calculate 
button.

If the load has been previously calculated, open the manifest from the File menu and click on the 
View button.  The software will redraw what has already been calculated and saved rather than 
recalculating the solution.

The View screen appears.  The MaxLoad Pro Manifest View screen, as pictured below, contains 
the primary results of your loaded manifest.  This screen includes both the loading diagram and all 
information associated with the manifest.

The Menu Bar is essentially the same in this screen as it was in the Manifest Pick List screen, but 
notice the following differences:

•	 Toolbar :  Icons, lists, and buttons below the Menu bar.  

•	 Action Buttons : Buttons used to recalculate load, go to a next or different truck.

•	 Load Statistics :  Brief load statistics displayed under the view Buttons

•	 Solution Tabs :  A series of tabs/buttons, located at the bottom of the screen, displaying a 
number of lists with information about the load.

•	 g.o.d. Window :  Displays a 3-dimensional graphic image of the container or pallet

Toolbar (View Screen)
The Toolbar on the View Screen is significantly different from the Toolbar on the Manifest Pick List 
screen.  It consists of various icons, lists, and buttons that are designed to make it easier to perform 
certain functions.   Items in the Toolbar are described in detail below:










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Icon Function
New:  Displays the Manifest Pick List, where you can start a new manifest 
file.

Open:  Displays the File Open dialog box, which allows you to open an 
existing manifest.

Save:  Saves the active manifest.  

Print:  Prints a hard copy of the active manifest.

Split Edit:  Displays the Split Editor screen, where you can edit the solution 
in two different views of the solution.

View:  Clicks the drop down arrow to select the view of the vehicle or pallet 
in the g.o.d. window.

Remove All:  Completely unloads the vehicle or pallet. MaxLoad Pro 
automatically transfers all SKUs in the load to the Cut List.

Remove Placement:  Removes one placement, section or stop-off/priority 
from the vehicle or pallet,

Remove SKU:  Removes one SKU from the vehicle of pallet.

Reject:  Grayed out in the View screen but available in Edit mode, this 
function rejects the current placement and asks MaxLoad Pro to try the 
next placement.

Put SKU:  Adds one SKU to the vehicle or pallet.

Put Placement:  Add one placement, section or stop-off/priority to the 
vehicle or pallet, depending on the selection under the View Menu | View 
by option (placement, leading edge or priority).

Put All:  Completely loads the vehicle or pallet.  

Labels:  Turns SKU labels on and off.

Outline:  Turns on the wire frame view for SKU placements or toggle display 
of the wall of the vehicle.

Violations:  Displays a report highlighting all current stacking violations.

Help:  Clicks to open the on-line help documentation.

Custom:  For special implementation only - accesses the customized 
function.  Contact TOPS for more information.

Units:  Switches measurement units from English to Metric and vice versa.
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Pick List:  Displays the Manifest Pick List screen, where you can change the 
parameters of the manifest.

 
Edit:  Displays the Editor screen, where you can edit the solution.

View Button  
The View buttons allow you to view the loaded container, pallet, or tote from different angles:  Top, 
Side, Front and 3D Front or Back Views.  Click the drop down arrow to select the desired view from 
the list.

•	 3D Front View:  Displays a standard 3D view of the diagram.

•	 3D Back View: Displays the 3D back view of the current load.

•	 Top View:  Displays the load from the top, looking down into the diagram.

•	 Side View:  Displays the load from the right side of the diagram.

•	 Front View:  Displays the load looking forward from the rear of the diagram.

Other View Options
•	 Rotate:  In addition to the standard views described above, you also have the option of viewing 

the load diagram from additional angles.  Any conceivable angle is possible.

To rotate the diagram, follow these instructions:
1.	 Use the mouse to click anywhere on the diagram portion of the screen.  This action makes 

the diagram portion of the screen active, thus making it available to be rotated.

2.	 Use the arrow keys on your keyboard to rotate the diagram to the desired position for 
viewing.  All four arrow keys are available to you, allowing you to rotate the diagram to view 
from the front, rear, top, bottom, right side, and left side (and any angle in between) of the 
vehicle.

When rotating the solution diagram, it will appear as if the diagram is stationary, and you are 
moving.  For instance, when using the up arrow, it will appear as if you are being raised up and 
over the diagram, allowing you to see the top of the solution.  When you click the right arrow, it 
will appear as if you are moving around the solution to the right.  The same is true of the other 
two arrow keys (down and left).  

•	 Zoom In and Out: MaxLoad Pro also allows you to zoom in and out of a solution diagram.  
Zooming in gives you a more detailed view of the load.  Zooming out gives you a “big picture” 
perspective. 

To zoom in or “zoom out” on the vehicle diagram, use one of these methods:
1.	 Use the scroll button the mouse.

2.	 While holding down the [Ctrl] key on the keyboard, press the “+” key to zoom in and the “-” 
key to zoom out of the graphics.

3.	 Press on the “T” key on your keyboard to zoom in and the “Y” key to zoom out.  Continue to 
press on the respective key until the diagram is sized to your liking.

•	 Pan Control: While holding down the [Shift] button, press the arrow keys to move the image 
within the graphics window.

•	 Show Tool Tip: When enabled, hovering the mouse over SKUs in any graphic view to get SKU 
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and placement details. To enable Tooltips, check the option Show ToolTip under the Tools | 
Configuration menu.

Additional Viewing Options
Three more viewing options are available via the View Menu in the Menu Bar: By Placement, By 
Leading Edge, or By Priority/Stop-Off.  These options work in conjunction with the placement arrow 
buttons (  & ) to put or remove placements according to the viewing options described below:

•	 View by Placement:  Allows you to load or unload a manifest “by placement.”  A placement is a 
group of like SKUs loaded with the same dimension vertical and with the same dimension parallel 
to the vehicle or pallet.

•	 View by Leading Edge:  Allows you to view the load one section at a time. MaxLoad Pro will 
load the first placement of cargo, as defined above.  Other SKUs will be loaded around the first 
placement, but will not extend beyond the leading edge of the first placement.  Once the first 
section of SKUs are loaded, another placement is loaded as far forward as possible up against the 
leading edge of the prior section, and up against the left wall of the vehicle, or left edge of the 
pallet.   

•	 View by Priority/Stop-Off:  Allows you to view the load one priority or stop-off at a time.  
Remember that you can build a load by priority or stop off when defining your manifest in the 
Manifest Pick List screen.

Action Buttons (View Screen)
There are several action buttons beneath the Tool Bar which allow you to recalculate the solution for 
the current vehicle or, if the load requires more than one vehicle, allows you to go to the next one.

•	 ReCalculate:  Allows you to re-calculate the load solution for the SKUs, using the same vehicle 
or select a new one.  MaxLoad Pro will prompt you to select another vehicle if the option “Show 
next vehicle dialog” (found under Tools | Configuration) is enabled.  Else, it will use the same 
vehicle to re-calculate the load.  This button serves the same function as clicking on the PickList 
button to return to the manifest screen to select another vehicle and click Calculate again.

•	 Delete Next:  If the solution calls for the use of two or more vehicles, this button will be active 
and allows you to delete the solution for the next vehicle.  You will see the following message:

Click OK to confirm deletion of the load in the next vehicle.

•	 Prev Truck:  If available, click to view the solution for the previous truck.

•	 Next Truck:  If available, click to view the solution for the next truck.  If the solution had been 
deleted with the “Delete Next” button as described earlier, you will be prompted to select a 
vehicle to load the items in the Cut List if the “Show next vehicle dialog” (found under Tools | 
Configuration) is enabled.  Else, it will use the same vehicle to calculate the solution.

•	 Go to container:  If your Manifest contains multiple vehicles, for example, 10 vehicles, this button 
allows you to quickly go to the designated vehicle instead of clicking the Next Truck button many 
times.
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•	 Weight:  Access the weight distribution dialog box where you can move the entire load towards 
the front or back of the trailer. You can also move the individual axle to better accommodate axle 
weight limits. Click the drop down to select the element to move.

Click the  button to move the entire load one inch towards the tail of the trailer and  one 
inch towards the front. Clicking the  or  buttons to move the entire loads to the end of front 
of the trailer respectively. Note that all weight information will be updated accordingly.

The axles can only be moved one inch at a time using the   and  buttons.

To save the redistributed load, click the EXIT button.

Load Statistics (View Screen)
Load Statistics, as pictured below, are displayed on the left side of the Manifest View screen, just 
below the Action Buttons. 

Following are some of the fields available under the load statistics section:

•	 Wgt: Total weight and percentage weight of the load.

•	 TareWgt: The weight of empty container.

•	 TotalWgt: Sum total of Wgt. and Tare Wgt.
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•	 King Pin, Axle 1 and 2: Total load weight on king pin and each axle.

•	 Cube:  The percentage volume of the container filled with product

•	 End Gap: The distance between the last loaded SKU from the end of the container.

•	 COG: Center of Gravity.

�� Note:  For Single SKU the information provided in the Load Statistics is the SKU and 
Container’s length, width, height and weight information.

Tabs (View Screen)
The List Tabs, at the bottom of the View Screen, allow you to see various statistics regarding the load 
that you are viewing.

You can specify what statistics to display via the right click Properties menu.  To access this function, 
place the mouse cursor within the statistics area and click the right mouse button. At the pop-up 
menu, select Properties. Remove the check marks against the fields you want removed from the 
solutions.

Sol List
The Sol List or the Solution List, as pictured below, appears whenever multiple solutions are 
calculated for the manifest, depending upon multiple container sizes or loading algorithms.

MaxLoad Pro even calculates multiple solutions when performing a Single-SKU loading analysis.  For 
more information, please refer to Chapter 7, Loading a Single-SKU Manifest.

•	 Truck / Tote: Lists the selected containers for a particular manifest 

•	 Algorithm:  Displays the loading algorithm for the solution.

•	 Qty: The count of SKUs loaded in to the container or on the pallet

•	 Cube: The total volume of the loaded SKUs 

•	 %Cube: The percentage of the container or pallet’s volume that loaded SKUs occupy

•	 Wgt: Total weight of the product

•	 %Wgt: The percentage of the maximum weight that the SKUs weighs

•	 CutList Cnt: The total number of the SKUs which could not be loaded in to the container or pallet

Use the scroll bar to scroll through the list.  Also, you can use the mouse to highlight a different 
solution.  Notice that each time you select a different solution, the manifest solution diagram 
redraws to reflect the selected solution.
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Placement List
The Placement List, as pictured below, displays the information for each SKU, accordingly to the 
placement sequence of the load.

•	 Ref / No: Reference number or the Placement number for the SKU

•	 Color: The color assigned to the SKU

•	 SKU: SKU Number

•	 Qty: Quantity of SKUs loaded for that particular placement in the load.

•	 ULCnt: Unitload count (if applicable) is the number of whole unitloads for the corresponding SKU 
for that placement in the load.

•	 Priority/Stop-Off number: Displays the priority or stop-off assigned to that SKU in the Manifest 
List.

•	 Cube: The volume of that particular SKU placement.

•	 %Cube: The percentage of the total volume of that container that total volume occupied by that 
particular SKU placement.

•	 Wgt: Weight of each SKU times Qty for the placement weight.

•	 %Wgt: The percentage of total weight limit (for the vehicle) taken up by the SKU placement.

•	 XFront, XSide, & XFloor: The location the SKU placement from the  front, side, and floor of the 
container or pallet.

If you have the Outline option   enabled for Load Items, highlighting each placement is the list 
will show the selected placement in color while the rest of the SKUs in wire frames. This allows you 
to easily view selected placement with respect to the rest of the placements.

�� Note: You can print this report through the File | Print | Placement List Menu.  This 
report can even be exported through the Tools menu.
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Load List 
The Load List, as pictured below, provides a summary of all SKUs in the current vehicle load, totaled 
for each SKU on one line.  The information (column headings) provided in Load List is identical to 
that provided in the Placement List.  Like Placement List this list can also be printed or exported.

Cut List 
The Cut List is the list of SKUs that did not fit into the selected container or the pallet, when 
CalcAllTrucks feature is turned off.  The information (column headings) displayed in this list is 
identical to that of the Load List (with the addition of a Unitload Count column).

If you do not want any SKUs to appear in the CutList, enable the CalcAllTrucks feature in the Global 
Configuration Settings (under Tools | Configuration Menu).  For more information on Calculate All 
Trucks feature, please refer to Chapter 11, Configuration.

Cut List can also be printed through the File menu. 
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Cost
The Cost tab is not implemented at this time and is grayed out.

Air Bag / Dunnage
To ensure transit loads are secure during transport, dunnage materials like air bags can be added 
in between SKUs to minimize or prevent product damage.  This function, when enabled, highlights 
spaces among SKU placements meeting the specified dimension criteria.

At the Solutions view, click on the Air Bag / Dunnage tab at the bottom to bring up Air Bag/Dunnage 
Dimension dialog box as shown below.

Enter the minimum value along the three dimensions to highlight any void space for dunnage.  Any 
space meeting the criteria will be highlighted in the g.o.d. window with their respective dimensions 
and locations detailed in the table. The added airbags are also included under the Placement and 
Load Lists in the Solution View screen.

You can display the list of airbags/dunnage in the Load report by checking the Show Airbag option in 
the Print Parameters dialog box. 
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Viewing Items on the Cut List 
Once a solution has been calculated, if MaxLoad Pro determines that the entire manifest will 
not fit in the selected vehicle, you have the option to take items from the Cut List and load them 
into another vehicles.  This assumes you are not using the CalcAllTrucks feature which will place 
remaining items in the next vehicle of same truck type.

To determine if the entire manifest fits into the vehicle, simply look at the Cut List.  If there are any 
SKUs in the Cut List, then the entire manifest did not fit.  If the Cut List is empty, then everything in 
this manifest fits on the selected vehicle.  Another way to determine if all SKUs fit is to check the 
Next Truck button, which is located under the View buttons.  If the Next Truck button is “grayed out,” 
then all SKUs fit into one container.  If the Next Truck button is activated, then this manifest requires 
additional vehicles.  

To view items on the Cut List and load them into another container, follow these instructions:

1.	 Click on the Next Truck button. The New Truck dialog box appears, as pictured below.

�� Note:  In situations where you chose to analyze more than one loading algorithm or 
selected more than one vehicle to calculate, MaxLoad Pro will warn you that “All solutions 
other than the one currently being viewed will be deleted.” If this is acceptable, click on OK.  
If deleting the additional solutions is not acceptable, click on the Cancel button.

2.	 You will next be asked to select another vehicle from a Next Truck dialog box.  You can either 
select the same vehicle or choose a new one.

�� Note:  If you only load one type of vehicle and do not want to see this dialog box to 
select another vehicle, you can turn it off by checking the “Don’t Show This Again” option 
in the dialog box or through the Tools | Configuration menu (disable “Show next vehicle 
dialog”).  For more information, please refer to Chapter 11, Configuration.

3.	 Click on OK. MaxLoad Pro draws a new solution with the items previously on the Cut List.  
MaxLoad Pro updates the Cut List to reflect that fewer items (if any) remain to be loaded as part 
of this manifest.  If the Cut List still contains freight, repeat this procedure until all items from the 
manifest have been loaded onto a vehicle.

�� Note:  If at any time you wish to see the previous vehicle in the sequence, click on the 
Prev (Previous) Truck button.  The previous solution will appear.  
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During the process of loading items from the Cut List, the page title will list container or pallet – 
first, second, etc. – you’re currently viewing.  This will prevent you from “getting lost” when viewing 
multiple vehicles in sequence.

SKU Information
MaxLoad Pro provides a right-click function that displays properties information for a selected SKU.  
To display SKU information, start from the View Screen and follow these instructions:

1.	 Position the mouse pointer over the SKU for which you want to display information and right-
click on the SKU. A pop-up menu appears.

2.	 Click on Properties. The Properties window appears, as pictured here.

  

The Properties window displays a range of basic properties for the selected SKU:  name, length, 
width, height, etc. Click on the EDIT button to go to the Define SKU dialog to change SKU 
properties.

3.	 Additional SKU properties are also found in the Status Bar at the bottom of the screen.

  
4.	 You can edit the selected SKU via the Define | SKU menu by clicking on the Edit button.  

Note that any changes made in SKU properties will only be reflected in the manifest after a 
recalculation.

SKU Placement information Using Tool Tips
When ShowToolTip option is enabled under the Tools | Configuration menu, hovering the mouse 
over a SKU in any graphics view will provide information for the SKU and current placement.
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9 Editing a Solution

MaxLoad Pro Editor can be used to edit a solution built by MaxLoad Pro, manually build a load 
starting with an empty container or a pallet, and manually edit a partially-built manifest.  

�� Note:  MaxLoad Pro does not allow you to edit Single-SKU manifest.

The various topics outlined in this chapter are:

Editor Screen

•	 Split Edit Screen
•	 Toolbar
•	 Cut List
•	 Orientation Box
•	 View Buttons/View Options
•	 Load Statistics
•	 Snap Buttons
•	 Status Bar
•	 SKU Information

Editing a Load

•	 Placing a SKU
•	 Moving a SKU
•	 Removing a SKU
•	 Breaking a Placement

Editing Mixed Pallets in the Vehicle

Stacking/Loading Violations

Saving the Edited Load
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Editor Screen
To work with the Editor, start from the Manifest View screen and click on the Edit button on the Tool 
Bar to access the Edit Screen as shown here.

The Editor Screen is divided into two separate sections, a Cut List on the left and 3D load diagram 
solution on the right. To return to the Manifest View screen, click the View icon button on the Tool 
Bar.

•	 Toolbar :  Contains a number of icons and buttons that allow you to execute routine editing 
commands.

•	 Cut List :  List of SKUs that did not fit into the selected container or on a selected pallet.

•	 Orientation Box :  Displays a 3-dimensional image of a selected SKU.  The Orientation Box 
allows you to change both the orientation and dimension vertical of the SKU.

•	 Load Statistics :  Displays a different statistics for a load.

•	 Snap Buttons :  Assists you in manually placing SKUs by forcing a SKU you are moving as far as it 
can go in the direction you’ve selected on the Snap button. 

•	 Status Bar :  Displays constraint messages, which let you know you’ve violated a stacking or 
placement rule for an SKU.

Split Edit Screen 
When you click on the Split Edit    icon on the Tool Bar, you will see a very similar edit screen 
except that there are two 3D views of the load diagram, one on top of the other. You can change one 
of the displays to a different vehicle and/or a different view so you can have two perspective of the 
same or different vehicle load during editing.

To change either view, you need to first click on the view pane you are changing and then go to the 

View icon on the Tool Bar to select a different view.  The Flip button in each view pane allows 



 






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you quickly change the 3D view from front to back or vice versa.

The load is edited in exactly the same way as in the regular edit screen but now you can initiate the 
edit from either view.  Any changes to the load will be updated in both views simultaneously.

To exit Split Edit screen back to the Manifest View, click on the View button on the Tool Bar or click 
the PickList icon button to return to the Manifest Pick List screen.

Concurrently Edit Two Vehicles in Split Edit Screen 
When in split-screen editing, this function allows users to drag and crop SKUs between two selected 
vehicles.
1.	 At the Solutions View, click the Split Edit button  on the toolbar to access the split view edit 

screen.

2.	 For each view, use the drop down list to select te vehicle to be edited.

3.	 Click the SKU to be moved from one vehicle, drag and drop it directly into the available space of 
the other vehicle.

�� Note: The SKUs to be moved have to be placed directly inside the vehicle, but not in any 
area outside the vehicle.
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Toolbar (Editor Screen)
The Toolbar contains a number of icons and buttons that act as shortcuts for executing routine edit 
commands.  Most commands also have a corresponding menu option in the Menu Bar. 

The following table outlines the various Toolbar options.

Icon Function

 
New:  Displays the Manifest Pick List Screen, where you can start a new 
manifest.  

 
Open:  Displays the Open Manifest dialog box, which allows you to select and 
open an existing manifest.

 
Save:  Saves the active manifest.  

 
Print:  Prints the active manifest

Split Edit:  To access the Split Edit screen.  This option is grayed out when you 
are in the Editor screen.

View:  Clicks the drop down arrow to select the view of the vehicle or pallet 
in the g.o.d. window.

 
Unload Vehicle:  Completely unloads the container or pallet.  MaxLoad Pro 
automatically transfers all SKUs in the load to the Cut List.

Unload Placement:  Unloads the next placement of SKUs.

Unload SKU:  Removes a selected SKU from the container or pallet.

Reject:  Rejects a computer-chosen placement and instructs the computer 
to try another one.  You can perform this action repeatedly until you find a 
suitable placement.  This button is grayed out when the last placement has 
been loaded.

Load SKU:  Adds a selected SKU to the container or pallet.

Load Placement:  Loads the next placement of SKUs.

Load Vehicle:  Completely loads the container or pallet.  If you’ve 
partially edited the load, MaxLoad Pro will determine the rest of the load 
mathematically, based on the placement of existing SKUs.

Labels:  Turns SKU labels on and off.

Outline:  Turns on the wire frame view for SKU placements.
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Violations:  Displays a report highlighting all current stacking violations.

Help:  Clicks to open the on-line help documentation.

Units:  Switches measurement units from English to Metric and vice versa.

Pick List:  Displays the Manifest Pick List screen, where you can change the 
parameters of the manifest.

 
View:  Returns to the Manifest Solution view screen.

Rotate Right:  Rotates the orientation box to the right.

Rotate Left:  Rotates the orientation box to the left.

Rotate Down:  Rotates the orientation box downward.

Rotate Up:  Rotates the orientation box upward.

Align Up:  Aligns selected SKUs flush up in the container or on the pallet or 
tote.

Align Down:  Aligns selected SKUs flush down in the container or on the pallet 
or tote.

Align Left:  Aligns selected SKUs flush left in the container or on the pallet or 
tote.

Align Right:  Aligns selected SKUs flush right in the container or on the pallet 
or tote.

Center Horizontally:  Centers selected SKUs horizontally in the container or 
on the pallet or tote.

Center Vertically:  Centers selected SKUs vertically in the container or on the 
pallet or tote.

Undo:  Allows you to cancel the previous edit command.

Redo:  Allows you to override the undo command.

SKU:  Displays the SKU List dialog box, which allows you to select one or more 
SKUs to add to the load.

Quantity:  Displays the SKU Quantity dialog box, which allows you to specify 
the number of SKUs to add to the load.

Air Bag/Dunnage:  Adds air bags to the load’s void space to secure the load.
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�� Note:  Although the Toolbar in the Editor screen looks similar to the Toolbar in the 
Manifest View screen, the Load Buttons behave differently.  In the Manifest View screen, 
you can use the Load Buttons to view the load “by placement,” “leading edge” or “stop-off/
priority.” In the Editor screen, the Load Buttons allow you to view the load “by placement” 
only.  You cannot use the Load Buttons to view the load in any other manner.

The Reject button is also active in the Editor screen so you can reject the current placement 
suggested by MaxLoad Pro.  You can keep hitting the reject button until you are satisfied with the 
current SKU placement.

Cut List (Editor Screen)
The Cut List, is a listing of all SKUs that did not fit into the selected transit container or a pallet. The 
Cut List contains an icon representing the SKU shape, SKU Name, Quantity, Unitload Count, etc.

When you click on a SKU in the Cut List, the information will be highlighted with a blue highlight bar.  
Below the Cut List, at the bottom of the screen, you’ll see a field that displays the dimensions and 
weight of the selected SKU as in the figure above.

Items in this list are stored in text form in alphabetical order.  As you’re editing, when you select an 
SKU from the Cut List to add to the load, the SKU will appear to scale in the 3-dimensional shape it 
was defined in the orientation box.  As you remove a SKU from the diagram and drag it to the Cut 
List, MaxLoad Pro transforms the SKU from the 3-dimensional shape to text form and moves it into 
the Cut List.

There is a splitter bar between the Cut List and the Solution View, you can adjust the width of the 
Cut List by placing the mouse cursor on the splitter bar.  When the cursor changes its shape, click on 
the left mouse button to size the Cut List.

Editing the Cut List
You can add and remove items to the Cut List for placement into the edited load or modify the 
quantity for any SKU currently in the Cut List.  To modify the Cut List, follow these instructions:
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1.	 Right-click over the Cut List. A small box appears, as pictured below, with options – SKU List, 
Remove SKU, Quantity and Create Mixed Pallet.

   
2.	 To add SKU items to the Cut List, select SKU List. The SKU List dialog box appears, as pictured 

below.

   
3.	 Select the SKU you want to add to the Cut List and click on OK. The SKU Quantity dialog box 

appears, as pictured on the next page.  The dialog box displays the name of the selected SKU 
item.

   
4.	 Enter the quantity desired and click on OK.

5.	 To change the quantity of an existing SKU item in the Cut List, highlight the SKU item in the list.

6.	 Right-click over the Cut List.

7.	 Select the Quantity option. The SKU Quantity dialog box appears, as pictured above.  The dialog 
box displays the name of the selected SKU item.

8.	 Enter the new quantity for the selected SKU.

9.	 Click on OK. The Cut List redisplays with the updated quantity of the selected SKU.

10.	 To remove a SKU item from the Cut List, click on the SKU which becomes highlighted.

11.	 Right-Click over the highlighted SKU and select the Remove SKU option. The selected SKU will be 
removed from the Cut List.

�� Note: Unitized SKU cannot be removed from the Cut List in this manner. You will have to 
do this in the Manifest List.
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Create Mixed Pallet from the Cut List
You can manually create mixed pallets using the SKUs in the Cut List and place them inside the truck. 
To create mixed pallets in this manner, follow these steps.

1.	 Right-click over the Cut List and select Create Mixed Pallet in the pop-up dialog box. The Select 
Pallet dialog box will open.

2.	 Select the pallet style you will use for the mixed pallet and click OK.

3.	 The Mixed Pallet Edit screen will open.

4.	 Create the mixed pallet by dragging and dropping SKUs onto the pallet area as described in the 
next section.

5.	 When done, click on the Truck icon button on the Tool Bar.

6.	 A new SKU with name MP-1 will be added to the Cut List.

7.	 To place this mixed pallet into the truck, highlight MP-1 on the Cut List.  When the mixed pallet 
appears in the orientation box, click, drag and drop the pallet inside the truck. 
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8.	 You now have a mixed pallet created on-the-fly placed inside the truck. You can edit this pallet 
again by clicking on it (inside the truck).

After editing the mixed pallet, click on the Truck button on the Tool Bar to place the edited pallet 
back inside the truck.

Orientation Box (Editor Screen)
The Orientation Box displays a 3-dimensional representation of the SKU you have chosen from the 
Cut List.  This box appears in the upper left-hand corner of the Editor Screen, only after you have 
selected a SKU.

To activate the Orientation Box, select an SKU from the Cut List. To remove it, simply press the [Esc] 
button on your keyboard.

The Orientation Box allows you to perform the following tasks:

•	 Change the Orientation of the SKU:  To change the orientation of the SKU, click on the face of the 
SKU that currently faces up. MaxLoad Pro rotates the SKU 90 degrees.  The figure below shows a 
visual illustration.

Clicking Here … Changes the Orientation of the SKU Like This
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•	 Change the Vertical Dimension of the SKU:  To change the vertical dimension of the SKU, click on 
the face of the SKU that you want to position against the floor (that is, the new base of the SKU).  
The figure below shows a visual illustration.

Clicking Here … Changes the Vertical Dimension of the SKU Like This

If you need to change both the vertical dimension and the orientation of a SKU, it’s easy to change 
the vertical dimension first, and then change the orientation.  

Helpful Hint:  Make any changes necessary to the vertical dimension and the orientation of the 
SKU before you drag the SKU into the vehicle.  Once the SKU has been placed into the vehicle, you 
cannot make changes to the loading orientation.  If you need to change the loading orientation of a 
SKU once it has been placed, you must first drag the SKU to the Cut List, then select the SKU again, 
following the procedure outlined above.

If the SKU is too small, it will be difficult to click on its face change the orientation via this box.  In 
such a case, resize the box by dragging its lower right hand corner or use the rotation icons on the 
Tool Bar.

View Options (Editor Screen)

To change the view of the editing load, click on the down arrow of the View icon on the Tool 
Bar and select a different view from the drop list.  The Flip button also allows you quickly change the 
3D view from front to back or vice versa.

The different view may come in handy during the edit process.  For example, if you’re using the 3D 
view and can’t see a SKU that you want to remove, simply choose another view that will help you get 
a clear picture of that SKU.

In addition to the standard views – Top, Side, Front and 3D – you can also view the load diagram 
from other angles.  Following are some other view options available in the Editor Screen:

•	 Zoom Control:  To zoom in or zoom out on the load diagram, use one of these options at the 
active graphics window:
1.	 Use the scroll wheel of the mouse.

2.	 While holding down the [Ctrl] key on the keyboard, press the “+” key to zoom in and the “-” 
key to zoom out of the graphics.

3.	 Press the “T” key on your keyboard to zoom in and the “Y” key to zoom out.
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•	 Pan Control: While holding down the [Shift] key on the keyboard, press the arrow keys to move 
the vehicle within the graphic window.

•	 Rotate the Load Diagram:    You can rotate the diagram to view it from any angle, giving you 
360-degree freedom to view the diagram from any conceivable angle.

To rotate the load diagram, follow these instructions:
1.	 Click anywhere in the diagram portion of the screen.  This makes the diagram “active,” thus 

allowing it to be rotated.

2.	 Use the arrow keys on your keyboard to rotate the diagram to the desired position.  All four 
arrow keys are available to you, allowing you to rotate the diagram to view from the front, 
rear, top, bottom, right side and left side of the vehicle.

�� Note:  You can edit a load from any angle.  Once you’ve rotated the diagram to the 
preferred viewing angle, you can proceed with editing. 

Load Statistics (Editor Screen)
Load Statistics is displayed above the 3D truck graphics.  It displays some of the important 
information for the loaded container like cargo weight, cube, tare weight, weight and cube efficiency, 
end gaps and COG, etc.

Snap Buttons (Editor Screen)
The Snap buttons, as pictured below, assist you in manually placing SKUs by forcing a SKU you are 
moving as far as it can go in the direction you’ve selected the Snap button. 

When the Snap feature is on, MaxLoad Pro automatically places objects as far as possible in the 
selected direction, regardless of where you initially place the object in the container or pallet.  When 
the Snap feature is off, an object will remain where you initially place it.

To turn the Snap feature on, click on the center button. The center button displays a green check 
mark; all snap buttons become activated.

To turn the Snap feature off, click on the center button again. The center button displays a red “X” 
mark; all snap buttons become deactivated.

�� Note:  The Snap feature can even be accessed from the Menu Bar, from the Layout 
menu option.
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Status Bar (Editor Screen)
The status bar is located at the bottom of the Editor screen.  When you select a SKU that has already 
been placed in a solution, the status bar displays the SKU number, along with the quantity of SKUs in 
the selected placement.  Below is the SKU information for the first placement inside the vehicle for 
the Appliance Load Manifest.

The status bar also displays constraint messages, which let you know when you’ve violated a stacking 
or placement rule after you’ve finished moving an SKU.  Once you release a SKU or group of SKUs at 
its new placement, the status bar will turn red if you’ve violated a stacking rule.  The error message 
will display until you click the mouse on another SKU. 

�� Note:  Keep in mind that the Editor will allow you to violate any previously defined 
orientation or vertical dimension parameters.  However, the status bar at the bottom of the 
screen will warn you of any loading violations that have occurred during the edit process.  To 

view existing violations in the current load, clip on the  button in the tool bar.  

SKU Information
MaxLoad Pro provides a right-click function that displays properties information for any selected 
SKU.  This function is available for truck, pallet and tote manifests but not available for a single SKU 
manifest.  To display SKU information, start from the View or Edit Screen of a truck, pallet or tote 
manifest and follow these instructions:

1.	 Position the pointer over the SKU for which you want to display information.

2.	 Right-click on the SKU. A dialog box as shown below appears.

   

�� Note: The above dialog box with all functions available appears if you’re right-clicking in 
the Edit screen. If you right-click the SKU in the View Screen, only the Properties and Export 
options are available.

3.	 To export the current view of the load solution (in the View or Edit screen), select Export in the 
right click menu.  Specify the format of the output graphics and enter a filename at the Save As 
dialog box.

SKU Information via Tooltips
When Show Tool Tip option is enabled under the Tools > Configuration menu, hovering the mouse 
over the SKU in any graphic view will provide SKU and placement details.
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Editing a Load
Before you begin the edit process, it’s important to understand how the Editor is designed to work.  
In most cases (though not all), MaxLoad Pro loads a SKU together with other identical SKUs to form a 
large placement.

A placement is defined as a block of identical SKUs loaded with the same dimension vertical and 
oriented in the same direction in the container.  MaxLoad Pro loads the largest placement possible of 
a SKU before loading smaller placements or single SKUs.  MaxLoad Pro uses this method of loading 
because of the ease of loading and unloading.

Therefore, considering how MaxLoad Pro groups like SKUs together while loading, understand that, 
in order to select an individual SKU (or layer or column of SKUs), you must first select the entire 
placement of the SKU in question. 

�� Note: To edit a load diagram, you must first create a new manifest or open an existing 
manifest.  In this section, any reference to SKU also applies to unitload unless otherwise 
noted.

Placing a SKU
Discussed below are some ways of placing SKUs in the Editor: 

•	 Placing a SKU into a container or on a pallet:
1.	 Select a SKU from the Cut List. The Orientation Box displays to the right of the Cut List with 

a 3-dimensional image of the selected SKU.  Notice that the mouse pointer is attached to a 
miniature box.  

2.	 Make changes to the vertical dimension and/or the orientation of the SKU.  

3.	 Once you’ve made changes to the loading parameters, hold down the left-click button on 
your mouse and drag the SKU to the desired position in the vehicle.  When you’re satisfied 
with the placement of the SKU, release the mouse button.  

MaxLoad Pro adds the selected SKU to the load.  If the SKU is too large for the desired space, 
you’ll hear a beep, and nothing will be drawn.  The SKU will remain in the Orientation Box. 

4.	 If the selected SKU is too big to fit into the space, you may want to specify another 
dimension vertical, change the orientation of the SKU or make changes to both parameters.  

5.	 Repeat steps 1-3.  Keep in mind that there may be instances where the object simply will not 
fit in the intended space.  

�� Note:  The Status bar will turn red whenever a stacking code is violated.  
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Building a Placement: 
1.	 Load the first SKU in the container or on the pallet..  

2.	 Hold down the Shift key and click on the side of the SKU where you want to place another SKU.  
See the graphic below for an illustration of this procedure.

1. 2. 3.

To add a second SKU to 
the right of the SKU, click 

here…

To add a third SKU to the first 
two SKUs (2), click here…

To add a second row of SKUs (3), 
click here…

4. 5. 6.

To add another layer of 
SKUs (4), click here…

To add another two-layer row 
of SKUs (5), click here…

You now have a two-layer 
placement; each layer has three 

rows of three SKUs (6).

3.	 As you can see by the graphic, you can add another row, column or layer to the placement using 
the Shift/Click combination.  You can achieve these results by clicking anywhere on the face of 
the SKU group to which you want to add another row, column or layer.  

For example, in frame number 5, you can get the result displayed in frame number 6 by clicking 
on the designated face of any of the six SKUs in that row.

4.	 If you don’t want to add an entire row, column or layer to the placement, re-select the SKU 
from the Cut List, and then place the SKU in the desired location (just as you would if you were 
starting a new placement).  You are not required to use the Shift key to begin a new placement.

Moving a SKU
Discussed below are some ways of moving SKUs in the Editor Screen.   

•	 Moving a SKU within a container or on a pallet: 

1.	 Position the mouse pointer over the SKU that you want to move.

2.	 Left-click on the SKU and move it to the desired position.  You’ll see an outline of the SKU as 
you begin to move it, though the SKU will remain in its original place.  Continue depressing 
the mouse button until you reach the new location for the SKU.
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3.	 When you’ve moved the SKU to the desired position, release the mouse button. MaxLoad 

re-draws the SKU in the new location. 

•	 Moving one SKU on top of another SKU:

1.	 Position the mouse pointer over the SKU you want to move.

2.	 Left-click on the SKU and begin dragging it to its new position on top of the second SKU.  An 
outline of the SKU will appear 

3.	 Using the outline of the SKU as a reference point, move the SKU to the desired position.

4.	 Release the mouse to release the SKU in its new position.  MaxLoad Pro re-draws the SKU in 
the new location.

         

 

 

•	 Moving a SKU using the Top View: This view is useful especially when want to move a SKU on 
another.  As this view provides a unique perspective on the placement of a SKU, allowing you to 
ensure that the SKU is placed in the intended position.  

1.	 Click on the Top button. The 3-dimensional view of the load redisplays to show you a view 
from the top of the container or pallet.

2.	 Select the SKU you want to move, then left-click and drag the SKU anywhere within the 
space provided. MaxLoad Pro re-draws the object in the new location.  

         

 

 •	 Moving a SKU from above the floor to a new position on the floor:

1.	 Position the mouse pointer over the SKU you want to move.

2.	 Left-click on the object and begin dragging it to its new position on the floor.  An outline of 
the SKU will appear and move with your mouse.
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3.	 Using the outline of the object as a reference point, move the object to the desired position, 
as pictured below.

4.	 Release the mouse to release the SKU in its new position. MaxLoad Pro re-draws the SKU in 
the new location.  

    

If there’s not enough room to place the SKU release it in its new position, the Editor will try to 
find an eligible placement as close as possible to the intended placement.  If the Editor cannot 
find a suitable placement, it will return the SKU to its original placement (that is, where it was 
before you attempted the move).

•	 Temporarily moving SKUs out of the way while Editing: 

1.	 Relocate the SKU within the vehicle.

2.	 Drag the SKU or group of SKUs to the Cut List, where it will be stored in text form. 

�� Note: The placement group will be broken down into individual items when moved back 
to the Cut List. 

Relocate the SKU to the empty space under the load diagram.  Be sure to drag the SKU completely 
off the vehicle; make sure no part of the SKU remains touching the vehicle.  

�� Note:  If the Snap feature is turned on, the SKU will move in the direction programmed 
by the Snap.

Removing a SKU

•	 Removing a SKU off the pallet or a container: 

1.	 Select the SKU to be removed and drag it off the g.o.d. window.  

MaxLoad Pro takes the SKU off the container or pallet and add it to the Cut List, thus 
increasing the cut list quantity.

•	 Removing a Layer/Column SKUs from a larger Placement: 

1.	 Remove the entire placement to the Cut List.  The figure on the next page shows a 
placement being moved off of the vehicle.

2.	 Return the individual SKUs back onto the vehicle, placing the desired layer, column or row in 
its new position.

3.	 Remember the “shortcut” method of building a placement.  
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Breaking a Placement 
You can break a placement of shipcases as well as drums. To break a placement into its individual 
items, follow these instructions:

1.	 Right click on the placement block. A pop-up menu appears

2.	 Select Break Placement in the pop-up dialog box.

MaxLoad Pro re-draws the solution with the selected SKU broken into individual items.  Note that 
the each SKU now has its own label, versus only one label for the entire placement.

�� 	 Note: You cannot break a single unitload into individual SKUs.

   

Editing Mixed Pallets in the Vehicle
MaxLoad Pro allows you to edit a mixed pallet inside a loaded vehicle or create a new mixed pallet 
from the Cut List as described in an earlier section.  The following steps illustrate how to move SKUs 
from one mixed pallet and place them on another mixed pallet on the same vehicle.

�� Note that the edit function is available to mixed pallets only, unitloads are not editable.

1.	 At the vehicle editor screen, place the mouse cursor over the mixed pallet you want to edit and 
click the right mouse button. A pop-up menu appears. 
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2.	 Select Edit.  Note that you can select Properties to view the contents of the mixed pallet.

A new editor screen containing just the mixed pallet opens.  Note that you can go to this same 
screen directly by double clicking the mixed pallet inside the vehicle.

  
3.	 The Mixed Pallet editor works the same way as the vehicle load editor.  You can click, drag and 

move selected SKUs to a different location on the pallet or remove them altogether from the 
pallet by bringing them to the Cut List.

Here, the entire top layer has been removed and placed in the Cut List.  
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4.	 Click the Truck button on the Tool Bar to bring the edited mixed pallet back to the vehicle edit 

screen.  The SKUs from the mixed pallet are now in the Cut List.

  
5.	 You can add the items on the Cut List as floor items by dragging and dropping them into the 

truck in the vehicle edit screen.

6.	 Double click on another mixed pallet if you want to place the SKUs on the Cut List to a different 
pallet.  You might want to turn off the Snap function in order for the SKUs to be centered on the 
pallet.

7.	 To create a new mixed pallet for the SKUs on the Cut List, right click the mouse button within the 
Cut List area and select Create Mixed Pallet in the pop-up dialog. 
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8.	 Select the pallet you’d like to use and a new editor screen containing the specified pallet opens.

9.	 Place the SKUs onto the pallet as desired and click on the Truck button when done.

  
10.	 Back at the Vehicle Edit screen, you will see a new SKU MP-5 on the Cut List. This is the new 

mixed pallet you’d just created. You can see the pallet in the Orientation box if you highlight it on 
the Cut List as shown below.
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11.	 To place this new pallet inside the truck, just drag and drop it inside the vehicle.

  
12.	 When you are done with editing, click the View button to go back to the Manifest View screen, 

or click the PicList button to go all the way back to the PicList screen.

�� Note: Unlike editing for vehicle loads, you cannot add SKUs or quantity to the Cut List 
when editing mixed pallets. 
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Stacking/Loading Violations
The MaxLoad Pro Editor allows you to override stacking rules during the edit process.  In other 
words, though you may have designated that peanut butter cannot be stacked on top of cotton balls, 
the Editor will allow you to place a case of peanut butter on top of a case of cotton balls.

However, when you release the object in its new position, you’ll notice that the status bar turns 
bright red, alerting you of the stacking violation.  The status bar will remain red until you select 
another object to edit.  In addition to the status bar, you can also access a report that provides a 
cumulative listing of all stacking violations.  To display this Stacking Violation Report, click on the 
Stacking Violations icon  in the Toolbar.

Clicking on the stacking violation icon will display the stacking violation messages.   Each message 
tells you when you’ve violated certain load parameters of the container, the stacking rules of the SKU 
that you recently moved, or if a SKU is affected by the SKU that you recently moved.

The common stacking violations are as follows:

•	 (SKU Number) must be stacked on floor

•	 (SKU Number) must not be stacked on floor

•	 (SKU Number) violates stacked (Stack Code) of (other SKU Number)

•	 (SKU Number) is carrying (X lbs/kg).  Its maximum weight allowed is (X lbs./kg.)

•	 (SKU Number) is allowed only (length, width, height) orientation

•	 (SKU Number) is stacked (X units) high.  Its maximum stack height is (X units)

•	 Maximum vehicle weight has been exceeded

•	 Minimum ceiling clearance has been exceeded

Example:  I want to load a grandfather clock into a sea van.  The grandfather clock must be stacked 
on floor.  However, the only place I can see to stack the grandfather clock is on top of a desk.  When 
I drag the clock to the desk and release the mouse button, the status bar turns red, announcing that 
I’ve violated the “Must be Stacked on Floor” rule.  It is now up to you to correct this violation. 
The Edit Stacking Violations screen appears, as pictured below, with all the stacking violations found 
within the load. 

This list identifies which stacking rules have been violated, thus allowing you to go back and correct 
the load.  This list is included with the Placement List when it comes time to print the manifest.
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Saving the Edited Load
To save the edited manifest, click on the Save icon  on the Tool Bar. As an option, you can open 
the File menu and select Save.  If you’re saving the solution for the first time, MaxLoad Pro asks you 
to name the manifest.
MaxLoad Pro saves your changes as part of the manifest file.  To view the edited changes later, 
remember to click on the View button rather than the Calculate button.  Clicking on the Calculate 
button will recalculate the entire load based on the parameters you’ve assigned.  Clicking on the 
View button simply calls up the manifest that you last saved, preserving any changes that were 
previously made.

�� Note: For MaxLoad Pro to replicate the edited load and make it available in the Solution 
List, save the edited load to library by clicking the “Save To Lib” checkbox in the Save As 
dialog box.

Save to Lib
The Save to Lib option under the File | Save As dialog box allows you to save an edited solution 
to the manifest.  While a saved manifest can be overwritten by accident when a new Calculate 
command is issued, the Save to Lib solution will remain as one of the solutions for the manifest.
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10 Reports and Printing

This chapter presents the various options available when you’re ready to print in MaxLoad Pro.  
MaxLoad Pro allows you to print various databases and multiple reports, each giving specific 
information regarding the load.  You can preview your work before printing, which allows you to 
make adjustments before actually sending your work to the printer. 

As with viewing and editing, printing is a standard function that does not change regardless of the 
type of manifest.  We’ve attempted to make the print process as generic as possible; thus, this 
chapter covers printing in a generic manner.  Whenever we reference printing a truck manifest, the 
same principles apply to a pallet manifest, single-SKU manifest or tote.

The various topics outlines in this chapter are: 

Printer Setup

•	 Print to File/Create PDF Documents

Printing Options

•	 Reports/Solutions
•	 Report Types
•	 Databases

Print Preview

•	 Report Exports

Annotate Printouts 

•	 Adding Text
•	 Adding Arrows
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Printer Setup
The first step to printing in MaxLoad Pro is to find which is your default printer and where it is 
printing.  This information is available through the Print Setup Dialog Box. 

Click on Print Setup under the File menu. The Print Setup dialog box appears.

This dialog box allows you to set a default printer and other print parameters, which are inherent 
to your Windows operating system.  The Orientation setting is not relevant as MaxLoad has preset 
orientation for each report.

Select the local or network printer and click OK. The software prints the selected report or database.  

Print to a File/Create PDF Documents
You can create PDF outputs directly from MaxLoad Pro using TOPS PDF Printer.  Start at the Print or 
Print Preview Screen, then go to the Export Menu and select Export PDF.  You will be prompted to 
enter the name and location where the PDF output will be saved.

If you prefer to use other PDF writers available in your list of printers, then select Print instead of 
Export to PDF. 

Printing Options
MaxLoad Pro allows you to print a number of diagram views, reports, and databases. 

Reports/Solutions
You can print a report/solution at any time, provided you’ve already opened an existing manifest.  To 
print a new manifest, you first have to calculate the load before printing.  Regardless of the type of 
report you wish to print –– the same procedures will apply. 

Depending on the manifest, there are two ways a solution can be printed.  

•	 Print: Print feature from the File menu is used when you have a manifest that fits in one 
container or on one pallet.  
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To print a solution, follow these instructions:

1.	 From the Menu Bar, open the File menu and select Print A submenu appears with a list of 
print options – Load, Manifest, Summary, etc.

2.	 Select the type of report or diagram view you want to print.  The contents of the dialog box 
appears next vary depends on report type.  For example, to print the load diagram, select 
Load.  

3.	 The Print Parameters dialog box for a Load report appears. 

         
4.	 Select the view you want to use in your printout – 3D Back, Top, etc.  You can select more 

than one view option.  Each view will be printed on a subsequent page.

5.	 Select the print color: Black & White, Color (Solid), or Color (Outline).

6.	 For the Load Summary section of the Load report, tick the check boxes the data to be 
included.  If dunnage is used for the load, the Show AirBag option can be checked to list each 
air bag used together with its dimensions.

7.	 Click on OK.

8.	 At the Print dialog box, select the printer and click OK.  The software prints the selected 
report. 

•	 Multi Print: Multi Print option is useful in analyses which have big manifests going in more than 
one container or on more than one pallet.  Similar to the Print option this option can also be 
accessed from the File menu.

To multi print, follow these instructions:

1.	 From the Menu Bar, open the File menu and select Multi Print. The Multi Print Parameters 
dialog box appears.



162 | MaxLoad®Pro User Guide v4.0

          
2.	 Use the Report Profile to select the general reports for print.

3.	 To select additional reports, check against the report names.

4.	 Click Select All button to select all reports and Clear All button to undo report selection. 

5.	 Select Print View(s): Black & White, Color Solid, or Color Outline.

6.	 Select containers.  Select All for all containers for that manifest or Current to print report for 
a selected container and click on OK.

7.	 The Print dialog box appears. Select the printer and click OK. The software prints the 
selected report(s). 

Report Types
The views allow you to view the load at various stages of the loading process, while the reports 
display relevant information regarding the active manifest.  The various printing options that you can 
preview or print from the File menu is as listed below:

Load
Prints the load diagram of the current solution together with a load summary and Cut list.  For the 
graphics, select from among 3D front, 3D back, top, side and front views.  If dunnage is used for the 
load, the Show AirBag option can be checked to list each air bag used together with its dimensions.
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If “Color Stop Off” option for Print View is checked, the SKUs will be colored accordingly to stop off 
number as shown next.
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Load Front/Back View
Prints a report with both the front and back view of the loaded container or pallet. Select from 
options of Top-Bottom direction or Left-Right direction as illustrated below.
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Manifest:  
Prints the manifest pick list and associated options selected for each SKU specified via the Properties 
function.  The Properties sheet can be accessed via the right click local menu or under Edit | 
Properties function.

(Load) Summary:  
Prints a summary of the load.  If there are stop offs or priorities in your load, the SKUs are grouped 
by stops or priorities in the summary.
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Load By Placement
Prints a report of the vehicle/pallet being loaded one placement at a time.  This report indicates 
SKUs, SKU quantities, and the load configuration for each step.

   

Load By Layer
Available only for pallet manifests and with solutions based on layer construction, it prints the pallet 
load showing each successive layer.
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Load By Leading Edge
Prints the load showing each successive leading edge. It shows less steps when compared to the 
Load by Placement report.

  

Load By Stop-Off
Prints a diagram of the container/pallet being loaded one stop off at a time.
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UnitLoads

This leads to the dialog with options to print each individual unitload and/or mixed pallets inside the 
vehicle. The 3D diagram of the pallet load report provides the following details.

For Unitload:

•	 SKU number and description
•	 Properties of SKU including length, width, height, weight and loading preference
•	 Pallet used for the unitload
•	 TiHi information: Cases per layer, number of layers on the pallet and total number of cases on the 

pallet.
•	 Dimension and weight of the unitload
•	 Area and cubic efficiency for the unitload
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For Mixed Pallet:

•	 Type of pallet used
•	 Length, width, height and weight of the pallet load
•	 A summary of the contents on the pallet including SKU, quantity and SKU dimension

Placement List
Prints a text report broken down by placement inside the vehicle. It contains the same information 
found under the Placement List in the Solution View.
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Data includes:
•	 Placement Number
•	 SKU Number and Description
•	 SKU Quantity in the placement
•	 Number of unitload or mixed pallet within the replacement
•	 The Stop for the placement
•	 Configuration of the placement
•	 Orientation of the placement, i.e. which dimension is loaded vertically
•	 Position of placement from the front, side and floor of the vehicle

Cut List
Prints a list of SKU’s that were not able to be loaded onto the vehicle/pallet.

 
•	 Placement Number
•	 SKU Number
•	 Order number
•	 SKU Quantity in the placement
•	 Number of unitload or mixed pallet within the replacement
•	 The Stop for the placement
•	 Total cube usage of each placement
•	 Percentage cube usage for each placement
•	 Total weight of each placement
•	 Percentage weight for each placement
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Load List
Prints a breakdown of the solution by SKU Number. It contains the same information found under 
the Load List in the Solution View including:

 
•	 Placement Number
•	 SKU Number
•	 SKU Quantity in the placement
•	 The Stop for the placement
•	 Total cube usage of each placement
•	 Percentage cube usage for each placement
•	 Total weight of each placement
•	 Percentage weight for each placement
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Mixed Pallets
This report is only available for Truck Manifest.  It lists the contents of various mixed pallets in the 
container including SKU Number and quantity, total cube and weight for the SKUs and the stop 
number for the pallet load.

Air Bag /Dunnage
This report lists the air bag / dunnage used to secure the load in the vehicle.
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Truck Summary
Prints a breakdown of SKUs and piece count in each vehicle.

Load Summary
Similar to the Load List, this report prints a detailed load summary of the current vehicle with details 
about the SKU’s stacking and loading preference:
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Data in Load Summary report:
•	 SKU Number and Description
•	 Quantity of SKU in the placement
•	 Cube and Weight of the SKU placement
•	 Dimension of the SKU
•	 Amount of overhang allowed for the SKU during stacking
•	 Dimension of the SKU that allowed to be stacked vertical and the preferred allowed vertical 

dimension
•	 Stacking preference for the SKU
•	 Loading preference for the SKU – by length, width or best fit
•	 Maximum stack height (on base and side) and stack weight for the SKU

To print Load Summary for all vehicles in the manifest, use the Multi Print or Multi Preview function.

Load By Placement Edge
Similar to the Load By Leading Edge report, this prints the load showing each successive placement 
edge, together with the placement information including SKU number, quantity and arrangement of 
SKU in that placement.

  

Customized Reports
Allows users to select the data to be included in the graphical and summary reports in MaxLoad and 
will be discussed in more details in the next section.
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Customized Reports
This print option leads to a submenu so you can customize the data to be included in the Graphics 
(Load) Report or the Summary Report.

Customize Graphics Report Setup
The customized graphics report contains a 3D view(s) of the vehicle load plus summary data 
specified by the users.

•	 Report Profile: Creates and saves the report setup to a template for quick retrieval. 

»» Drop down:  Click the drop down list to select a previously defined profile for editing.

»» Save: Click to save the current profile.

»» New: Click to create a new report profile.

»» Delete: Click to delete the current report profile.

•	 Header Details:  Allows users to select what data to be included in the Summary report in 
MaxLoad.

•	 Summary Details: This section gives users control over what portion of the page will be used for 
summary and what data go into that section.  If you uncheck the Report Summary, the graphics 
report will only give the 3D Load view of the vehicle, without any data.

»» Report Size: Specify what percentage of the page will be used for summary data. Select the 
percentage from the drop down list. The bigger the number, the more the page will be made 
available for the summary.

»» List Option:  Specify whether the report will contain Load summary or Placement summary.
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»» Select Options:  Check against the data you’d like to be included in the summary port of the 
graphics report.

»» Length:  Click the drop down list to specify the field length for the selected data.

»» Report Preview: Provide a preview of the data summary and a preview of the complete report 
including the 3D graphics. 

�� Note: The data summary is for preview only, adjusting the width of the columns will not 
change the column width of the corresponding data.

»» Usage Status Bar:  Provide a summary on how much of the space assigned to the summary 
section has been used up by the current selections.

»» Print Font:  Select the font to be used for the custom report.

Print Customize Graphics Report
To print a customized graphics report, go to the Print or Print Preview menu, select Customize 
Reports and then Graphics Report. This leads to a dialog box to select Report Profile and other print 
parameters.

•	 Report Profile:  Select from the drop down list the report profile to be used.

•	 Print Color:  Specify if the report will be in color or black and white.

•	 Load Colors: Select the color option to be used for the load.

•	 Report Type(s): Specify the graphics to be included in the summary report.

•	 Container: Select to include All vehicles or only the Current vehicle of the manifest.
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Customize Summary Report Setup

•	 Report Profile: Creates and saves the report setup to a template for future use. 

»» Drop down:  Click the drop down list to select a previously defined profile for editing.

»» Save: Click to save the current profile.

»» New: Click to create a new report profile.

»» Delete: Click to delete the current report profile.

•	 List Options:  Specify whether the report will contain the Load summary or Placement summary.

•	 Load List Options: Available only when Load List is selected, this allows you to specify the data to 
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be included in the report and the filed length to accommodate the data:

»» (Sequence) Number

»» Order #

»» Description

•	 Placement List Options: Available only when Placement List is selected, this allows you to specify 
the data to be included in the report and the filed length to accommodate the data:

»» Placement Number

»» Front - distance of placement from the front of the vehicle

»» Floor - distance of placement from the floor of the vehicle

»» Side - distance of placement from the side of the vehicle

»» Dimensions - dimension of the SKU

•	 SKU Options 

»» Package Options: Include the selected dimensions for the SKUs in the custom load reports.

»» Allow Vertical Options: Show the Allow Vert setting, as Y for yes and N for no, of the selected 
dimension for the SKUs in the custom load reports.

»» Maximum OverHang Option:  Show the Maximum Overhang settings of the selected 
dimension for the SKUs in the custom load reports.

»» Maximum Stack Options: Show the Maximum Stack Height and Weight settings of the 
selected dimension for the SKUs in the custom load reports.

•	 General Options:  This section allows you to select additional details regarding the SKU 
placements inside the vehicle to the Load or Summary List.

»» SKU Name

»» Quantity: Total number of SKUs in the placement

»» UL Count: Total number of unitloads in the placement

»» Priority

»» Stop

»» Stack Preference

»» Preferred: preferred Vertical setting for the SKU

»» Cube

»» Percent Cube

»» Weight

»» Percent Weight

»» Loading Preference

•	 Report Preview: Provide a preview of the data summary. Note that the data summary is for 
preview only, adjusting the width of the columns will not change the column width of the 
corresponding data.

•	 Usage Status Bar:  Provide page usage summary for the current selections and field lengths.
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Print Customize Summary Report
To print a customized summary report, go to the Print or Print Preview menu, select Customize 
Reports and then Summary Report. This leads to a dialog box to select Report Profile and other print 
parameters.

•	 Report Profile:  Select from the drop down list the report profile to be used.

•	 Container: Select to include All vehicle or only the Current vehicle of the manifest.

Databases
The various databases that can be printed from MaxLoad Pro are as follows: 

•	 Manifest: Prints all saved manifests in MaxLoad Pro. Data includes manifest names and names of 
the user who created the manifests.

•	 SKUs: Prints all the saved SKUs from the database including shipcases, drums, tote SKUs, pallet 
SKUs, and palletloads.  Data include the SKU number, description, dimensions and weight.

•	 Pallets: Prints the names of all the saved pallets from the database including slipsheets, 
europallets, strings, etc.

•	 Vehicles: Prints the various containers saved in the databases.  Including trucks, sea vans, rail 
cars, etc and their dimensions and weights.
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•	 Totes: Prints the possible totes saved in the database with both inside and outside dimensions.

To print the MaxLoad Pro databases, follow these instructions:

1.	 From the File menu, click Print Databases.  

2.	 Select the database to be printed.  The Print dialog box appears.  

3.	 Select the printer and click OK.  

�� Note:  Unlike reports, the MaxLoad Pro database cannot be previewed before printing.

Print Preview
As with most other Windows programs, MaxLoad Pro allows you to preview your work before you 
actually print it.  From the Print Preview screen, you can add annotations to your printout and 
customize your work.  Remember, a diagram or report will print out exactly as it appears in the Print 
Preview screen.
  
To access the Print Preview screen, follow these instructions:

1.	 From the Menu Bar, open the File menu and select Print Preview or Multi Preview, respectively.

2.	 Select the type of report or diagram view you want to display a print preview.  Please to the 
section “Report Types” for a description of the different reports available.   

�� Note:  The print preview displays either in color or in black-and-white, depending on the 
selected printing method.

Notice the Toolbar, pictured below, at the top of the Print Preview screen.

The Toolbar contains the following buttons:

•	 Print:  Prints the diagram/report.

•	 Next Page:  Displays the second page of the printout.  If there is no next page, this button will 
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be grayed out.  The total number of pages for the preview is indicated on the top right hand 
corner of the report.

•	 Previous Page:  Displays the previous page of the printout as you view the second page.  If 
there is no previous page, this button will be grayed out.

•	 Two Page:  Displays a split-screen view of a multi-page printout to show two pages at a time.  
If there is only one page, this button will be grayed out.

•	 One Page:  Converts back to the one-page view if you are currently on the Two Page view.

•	 Zoom In:  Displays a magnified view of the previewed document.  MaxLoad Pro allows you to 
zoom in twice.

•	 Zoom Out:  Displays a reduced view of the previewed document.  This feature works if you’ve 
zoomed in.

•	 Close:  Closes the Print Preview and returns you to the point where you initiated the preview 
process.

•	 Edit:  Initiates the annotation process and makes your mouse pointer “live.” 

•	 Help:  Opens the on-line Help document within MaxLoad.

Report Exports
Under the Export Menu in the Print Preview screen, you have these export options:

•	 Export JPG:  Automatically generates JPEG files with filename ManifestName1.jpg, 
ManifestName2.jpg, ManifestName3.jpg, etc in the specified file location, one file for each page 
of the reports.

•	 Export BMP:  Automatically generates JPEG files with filename ManifestName1.bmp, 
ManifestName2.bmp, ManifestName3.bmp, etc in the specified file location, one file for each 
page of the reports.

•	 Export PDF:  Creates a single PDF file with name ManifestName.pdf in the specified location.  The 
file will include all pages of the selected reports.

E-Mail Reports
Under the E-Mail Menu in the Print Preview screen, you have these options:

•	 E-Mail JPEG:  Launches your default e-mail application and attached the current reports in JPEG 
format. This allows you to e-mail any of the print reports directly from MaxLoad. 

•	 E-Mail PDF:  Launches your default e-mail application and attached the current reports in PDF 
format. This allows you to e-mail any of the print reports directly from MaxLoad. 

Annotate Printouts
MaxLoad Pro allows you to annotate printouts by letting you add text and arrows thus making it easy 
to add last-minute notes to your diagram.

Adding Text
To add text to the output, start from the Print Preview panel and follow these instructions:

1.	 Click on the Edit button.

2.	 Click on the area of the output where you want to enter text.  MaxLoad Pro displays a four-
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cornered entry field with the cursor positioned inside the field.  Notice that you can “drag” the 
entry field to any position on the screen.

3.	 Enter the text that you want to appear in the selected area.  At this time, you cannot mix fonts 
within a single annotation.

4.	 To change the font and/or font size, open the Format menu and select Font.  The Font dialog box 
appears.

5.	 Use the Font dialog box to select the font, font style and/or size, and then click on OK.  This 
closes the Font dialog box and returns to the Print Preview panel.

6.	 Drag the text fields so they’re positioned where you want them.

7.	 If the added text is correct, click on the Print button. MaxLoad Pro sends the analysis output to 
the printer.

Adding Arrows 
From time to time, you might want to enhance a printout with some well-placed arrows.  In 
MaxLoad Pro, inserting an arrow on a printout involves a little-known keyboard trick – using the Alt 
key and the numeric keypad to insert keystrokes that are not usually available.  This method offers 
an advantage over using bitmaps – these arrows have transparent backgrounds and won’t obliterate 
the area on the printout where they’re placed.

Most fonts have more symbols than the normal 26 letters, 10 numbers and punctuation symbols.  A 
font often includes arrows, trademark symbols, accented characters, etc.  In most word processors, 
you use the application’s Insert Symbol feature and selecting from a range of symbols.  Microsoft 
Word also allows you to choose which font symbols you want to use.

At this time, MaxLoad Pro does not have an Insert Symbol feature, so in lieu of that you’ll use the 
Alt-keypad routine.  In Microsoft Word, if you open the Insert menu and select Symbol, the Symbol 
dialog box appears, as pictured on the next page.  You can also use the Windows Character Map 
feature, located in the Accessories folder.

 

If you highlight a symbol – such as the right arrow (®) – a number appears on the status bar; for 
example, 174.  This number represents the ASCII code for the selected symbol and the selected font.

The following steps allow you to insert these characters into most programs, even if they don’t have 
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an Insert Symbol feature.  To insert characters into a MaxLoad Pro printout, follow these instructions:

1.	 Go to the Print Preview Screen and zoom in.

2.	 Click on the screen to insert text.

3.	 Make sure the keyboard’s Num Lock light is on.

4.	 Go to the Format menu and select Font.

5.	 Select the font you want to use.

�� Note:  To insert arrows onto the printout, you’ll probably want to use the Symbol or 
Wingdings font.  If you want to simply bold or italicize the text, the active font should be 
sufficient.

6.	 Hold down the Alt key on your keyboard.

7.	 While holding down the Alt key, type the ASCII number for the symbol you want to insert with a 
zero (0) in front; for example, type 0172.  Use the table on the next page as a guide.

	

        Common Ascii Codes for Symbols
Symbol Font Wingdings Font

0171   ↔ 0219   ⇔ 0223   ß 0231   ç 0239   ï

0172   ← 0220  ⇐ 0224   à 0232   è 0240   ð

0173   ­↑ 0221   ⇑ 0225   á 0233   é 0241   ñ

0174   → 0222   ⇒ 0226   â 0234   ê 0242   ò

0175   ↓ 0223   ⇓ 0227   ã 0235   ë 0245   õ

1076   ° 0226    0228   ä 0236   ì 0246   ö

0227   © 0229   å 0237   í 0247   ÷

0228    0230   æ 0238   î 0248   ø

�� Note:  To change the font, you must first key in a letter or any text, and then highlight it.  
Then you’ll be able to change the font for that text and any additional text.

8.	 After you type in the ASCII number, release the Alt key.

MaxLoad Pro inserts the selected symbol onto the printout.  You might need to adjust the font 
size to make it more legible.
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11 Configuration

This chapter discusses how to define the configuration of the MaxLoad Pro System.  Configuration 
features are subject to certain authorizations.  Most Configuration features can be accessed and 
changed by any user.  Global configuration parameters are the only parameters that can be accessed 
and changed by the Supervisor alone.

This chapter is organized in to following topics:

Configuration Settings

Global Settings/Supervisor Functions

Properties

•	 Lists
•	 Measurement Input Fields
•	 Non-Measurement Input Fields
•	 Radio Buttons
•	 Check Boxes

Example 1: Changing the Default Vehicle Type

Example 2: Adding a Default Selected Vehicle

Example 3: Changing the Default Mixed Pallet Height
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Configuration Settings
MaxLoad Pro can be configured as per user needs from the MaxLoad Configuration dialog box.  The 
MaxLoad Configuration dialog box displays a range of options that define the way MaxLoad Pro 
performs its work.  This dialog box allows you to turn on and off each of these options.  To access the 
Configuration dialog box, start from the Menu Bar and follow these instructions:

1.	 Open the Tools menu and select Configuration.  The MaxLoad Configuration dialog box appears, 
as pictured below.

  

As you can see, this dialog box contains a large array of options for you to work through.  This 
section discusses each of these options in detail.

2.	 After you’ve made changes on the Configuration dialog box, you’ll want to save your work.  Click 
on OK.  MaxLoad Pro saves your Configuration changes and returns you to the previous screen. 

3.	 To exit the box without saving changes, click on the Cancel button. MaxLoad Pro ignores any 
Configuration changes and returns you to the previous screen.

•	 View On Open: If this box is checked, MaxLoad Pro will take you directly to the Manifest Solution 
screen upon opening the last saved version of the existing analysis, bypassing the Manifest Pick 
List screen. 

If this box is not checked, MaxLoad Pro will open the Manifest Pick List screen first, regardless of 
whether or not the solution has been previously calculated.  You can then click the View button to 
see the previously saved solution.  If you click on the Calculate button, MaxLoad Pro will redo the 
solution for the opened manifest.

•	 Snap Tight in Edit: This option controls the default setting for the Snap button in the Edit screen.  
When this button is checked, the Snap button will be “on” and will assist you in placing cargo 
when editing a load.  During the edit process, when you drag and drop an SKU into a vehicle 
or onto a pallet/slipsheet, MaxLoad Pro places that object into the nearest corner (i.e., as far 
forward and as far left as possible).  The corner must always be forward and to the left of the 
selected placement.

•	 Show next vehicle Dialog: This option applies when you’re loading items from the Cut List onto 
another container or click the ReCalculate button in the View Screen.  When you do that, you 
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have the option to change the type of container that was used initially.  When the option is 
checked, the Next Truck dialog box will appear that allows you to make another selection.

If this option is not checked, MaxLoad Pro assumes you would use the same type of vehicle. You 
can also check the option “Don’t Show This Again” in the above dialog to disable the Show Next 
Vehicle Dialog.

•	 Show Flaps: When this option is selected, all shipcases will appear with a case flap that 
designates the top of the box.  The case flap always runs parallel to the length of the box, thus 
giving you an easy reference point when viewing the solution.  The line on the box runs parallel 
with the length dimension of the box.

The SKUs appear as cubes when this option is unchecked.

     

•	 Show Dimensions On Solutions: When this option is selected, MaxLoad Pro displays dimensions 
of the container or pallet in the Manifest View screen.  The container dimensions appear exactly 
as you entered them when defining a vehicle.  However, the pallet/slipsheet dimensions – when 
viewing a mixed pallet manifest – are displayed using the actual dimensions of the pallet plus 
any overhang.  If no overhang is utilized, the pallet’s actual dimensions are displayed.  The height 
displayed is the actual height of the mixed-pallet load.  

No dimensions are displayed on solution, if this option is unchecked. 

•	 Show Center of Gravity: If checked, the center-of-gravity (COG)  will be displayed in the g.o.d. 
window with red triangular markers in addition to the numeric display in the load statistics 
section, in the View Screen.

•	 Show Graphics: When this option is selected, MaxLoad Pro displays any graphics that have been 
assigned to a shipcase, SKU, tote, etc.
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•	 Transparent Labels: When this box is checked, meaning to use transparent labels, MaxLoad Pro 
places the label texts directly onto the SKUs and placements (as below left), overlapping SKU 
outlines and flap indicators. 

           

If this box is not checked, MaxLoad Pro places the text of the placement numbering reference on 
a label with background of the same color as the SKU, then onto the object, therefore making it 
easier to see (figure on right).

•	 Show Pallet Details: Depending on how complicated your load may be, MaxLoad Pro is required 
to draw a very detailed solution on screen.  As a result, you may find the amount of time it takes 
to display the solution to be unacceptable.  To speed things up, MaxLoad Pro allows you to turn 
off pallet details, which is one of the most common culprits when a solution takes a long time to 
draw.  

        

When this option is selected, MaxLoad Pro draws all pallet details when displaying the solution 
(as left).  These details include all deck boards, stringers, etc.  Else, the pallet will be illustrated in 
a simpler format as on the right.

This option only applies to unitloads or mixed pallets drawn in a transit vehicle.  It does not apply 
to mixed-pallet manifests. 

•	 Show Unitload’s SKUs: When this option is selected, MaxLoad Pro displays the individual SKUs 
that comprise a unitload (below left).

Else, the unitloads appear as one large shipcase of pallet size (below right).
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•	 Extended Key Mode: This option controls the way that you enter information when building a load 
in the Manifest Pick List screen.  You have two options:  Standard Mode and Extended Key Mode.

Standard Mode provides a quick and easy way to key in quantities only.  When you select an SKU 
from the SKU List, that SKU will appear in the Manifest List with the cursor flashing in the Quantity 
field.  After you key in a quantity, pressing Enter returns the cursor to the SKU List, where you 
can select another SKU.  Repeat this process until you’ve entered quantities for all SKUs in your 
manifest.

Extended Key Mode routes the cursor through all fields in the Manifest List, as follows:
1.	 After you select an SKU from the SKU List, the cursor moves to the Quantity field of the 

Manifest List.

2.	 In the Quantity field, enter a quantity.  Press Enter.  The cursor moves to the Priority/Stop-Off 
field.

3.	 In the Priority/Stop-Off field, enter a value (if applicable).  Press Enter. The cursor moves to he 
UL (Unitload) column (if the column is turned on in Configuration).

4.	 In the Unitload (UL) field, tap the space bar to toggle this field on and off; the box shows an 
“X” when it’s on and is blank when it’s off.  Press Enter.  The cursor moves to the MP (Mixed 
Pallet) column, which works the same way as the UL column.

5.	 In the Mixed Pallet field, tap the Space Bar to toggle this field on and off; the box shows 
an “X” when it’s on and is blank when it’s off.  Press Enter.  The cursor moves to the Order 
Number column.

6.	 In the Order Number field, enter an order number (if applicable) and press Enter.  The cursor 
moves back to the SKU List where you can select another SKU and start the process all over 
again.

In Extended Key Mode, if you don’t need to enter information – a particular field is not applicable 
to your manifest – pressing Enter in that field automatically moves the cursor to the next field.  
Pressing Enter does not change any information in the field.  

For instance, the Priority field will always show a default of “1.”  If this is acceptable and you don’t 
need to change this priority value, simply press Enter to move to the next field.  The priority value 
will remain as “1.”

Check the Extended key mode option in the Configuration dialog box for extended key mode, else 
leave it unchecked for Standard Mode.

•	 Number Grid Lines: Gridlines are markers in the container spaced at a user-defined interval.  
Gridlines provide a quick and easy reference point for determining how much floor space remains 
in a loaded vehicle.  This option automatically numbers gridlines on a truck to mark specific 
distances on the floor space.  Gridlines apply only to vehicles, not to pallets or slipsheets.

�� Note:  This option works only if the Show gridlines option is checked.  
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•	 Save to Library: This feature gives the user the flexibility to save edited loads to library.  If later 
they replicate a load, MaxLoad Pro will show the saved edited load in the Sol List as shown on 
“Save to Lib” on page 157.

You will see this feature as a check box option in the File | Save As dialog box.

•	 Use European Date:  Check this option to use the European date format DD/MM/YYYY within 
MaxLoad Pro.

•	 Show Tool Tip: Check this option to have MaxLoad display SKU placement information when 
hovering the mouse pointer over the SKU in any graphics solution view.

•	 Graphics Screen Color: MaxLoad Pro allows you to control the background color of the solutions 
graphics screens.

To change the color of the solution and edit screens, follow these instructions:

1.	 Click on the color box in the Configuration dialog box to open the Color dialog box.

     
2.	 Using the mouse pointer, select a new color and click on OK to confirm.

3.	 To exit the screen and negate any changes, click on the Cancel button.

•	 G.O.D. Screen Color: MaxLoad Pro even allows you to control the color of all graphic-online-
drawing (g.o.d.) windows.

To change colors, follow these instructions:

1.	 Click on the color box in the Configuration dialog box.  

2.	 Using the mouse pointer, select a new color.  

3.	 When you’re finished, click on OK.

4.	 To exit the screen and negate any changes, click on the Cancel button.

•	 Show Gridlines: This option turns gridlines on and off in a vehicle.  Gridlines are markers in the 
vehicle spaced at a user-defined interval.  Gridlines provide a quick and easy reference point for 
determining how much floor space remains in a loaded vehicle.  Gridlines apply only to vehicles, 
not to pallets or slipsheets.  An example of a vehicle with gridlines is pictured on the next page.

�� Note:  Check the Number Grid Lines option to sequentially number the gridlines.  
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•	 Grid Interval: Once you’ve decided to show gridlines, you must decide at what interval they 
will be spaced.  You can control this through the Grid Interval field.  Simply key in a value that 
represents the desired interval.  

•	 Measurement Units: This field allows you to control the measurement unit defaults.  Whenever 
you begin a new manifest, the measurement units that initially appear in the Manifest Pick List 
screen will be controlled by this field.

To display the list – your only options are English and Metric – or change units, click on the down-
arrow on the right side of the box.  Use the mouse to click on the new selection.

For this change to be effective logout and log back into the software. 

•	 Placement Numbering: Placement numbering is an arbitrary method to identify SKUs or groups 
of SKUs in the View Screen for easy identifications.  The four placement numbering options 
available are as follows:    

»» Use Reference Number:  Refers to a computer-selected number that helps you determine 
which SKU is which, when viewing or printing a solution.  Each SKU is assigned a reference 
number when the load is calculated.  When viewing a solution, the Placement List contains a 
column that displays a key to the numbering system.

»» Use SKU Number:  Tells MaxLoad Pro to use SKU Number as a placement number.    

»» Use Placement Number:  Assigns each placement a unique number.  Because there may be 
multiple placements for different SKU Numbers, you’ll often notice that SKU Numbers are 
assigned different placement numbers as you view the load.

»» Use Custom Label:  Tells MaxLoad Pro to use the custom label that you designated when 
defining an SKU under the Stacking tab.  

•	 Print: Print defaults can be set with one of these three options:

»» Black & White:  For non-color printer users, this option allows you to print a black-and-white 
outline of the loaded vehicle, as opposed to a gray-scaled printout. If you work with a color 
printer, MaxLoad Pro will print a black-and-white printout when the option is checked.  If the 
option is not checked, the solution diagram will print using the colors assigned when defining 
an SKU.

»» Color (Solid):  In Print Preview, this option draws items on the screen in solid colors, with the 
lines on the items drawn in black.

»» Color (Outline):  In Print Preview, this option draws items on the screen with only the outline 
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of the item.  The body of the item is white, with the outline of the item drawn in color.

�� Note:  Any changes you make to the Print defaults, become active only once you log out 
of the software and then log back in again.  

•	 Printer Resolution: In an effort to speed up the printing process, MaxLoad Pro gives you a choice 
as to how “coarse” or “fine” printouts will appear.  To change the setting, simply use the mouse 
pointer to slide the handle in one direction or the other.  

You will receive printouts faster when the setting is closer to “coarse.”  Printouts will take longer 
when you set this option closer to “fine.”  

•	 Global, Defaults, Fonts and E-Mail Buttons: These buttons open dialog box for specific 
configurations and will be covered next.  

Global Settings (Supervisor Functions)
Only supervisor can enter and update global settings for the MaxLoad Pro configuration.  This 
section presents the Global Settings dialog box and each of the global configuration options.

Global Settings
To enter and update the MaxLoad Pro global settings:

1.	 Login to MaxLoad Pro as a Supervisor.  The password for supervisor is “tops software”.

2.	 At the Control Center, go to the Tools menu and select Configuration. The MaxLoad 
Configuration Screen appears.

3.	 Click on the Global button to access the Global Settings Screen appears, as pictured below.

  
The Global Settings Screen contains the following options:

•	 Show license information: This switch turns off the license information found in the bottom right 
hand corner of the Control Center screen.  When this box is checked, the license information will 
appear.  

When this box is unchecked, the license information will remain hidden.  

However, you can always access this information from the Menu Bar:  Open the Help menu and 
select About MaxLoad.
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•	 User Passwords:  Protects user logins with passwords.  If checked, users will be prompted for a 
password at the login screen.  

•	 User Modify SKU:  Allows all users to modify, add or delete SKUs from the database.

•	 User Modify Containers:  Allows all users to modify, add or delete containers from the database.

•	 User Modify Defaults:  Allows all users to modify defaults set up in the system.

�� Note:  If any of the above User Modify feature is turned off then only a user logged in as 
a Supervisor can make changes to SKUs, Containers, or Defaults, respectively.   

•	 Costing:  Activates a decision-making tool for SKU/item costing in a given manifest.  

•	 Labor Cost:  Activates a decision-making tool for costing man hours and labor involved in a given 
manifest.  

�� Note:  Costing and Labor Cost is undocumented features reserved for specific customers.  
Contact TOPS Technical Support for details.

•	 CalcAllTrucks:  Activates the Calculate All Trucks feature, which calculates solutions using as 
many trucks (the same truck currently selected) as necessary to load a manifest.  With this option 
enabled, you can quickly tell the total quantity of Vehicles or Pallets (for Pallet Manifest) needed 
to fulfill an order, as represented by the PicList.

�� This option is required to use the Preview function under File | Open menu.

•	 Share MFT:  Allows all users to see all files.  If this feature is turned off, users can only see their 
own manifests.

•	 Auto Replace Same User:  Allows the supervisor to log out a user, then automatically log in the 
same user.

•	 Force Corner Support:  Allows you to activate corner support when placing SKUs on top of other 
SKUs.  This involves defining the length and width of the corner support.

»» Support Len:  If you turn on the Force Corner Support option, this field allows you to enter the 
length of the corner post in inches or millimeters, depending on the Units selected.

»» Support Wid:  If you turn on the Force Corner Support option, this field allows you to enter 
the width, or thickness, of the corner post in inches or millimeters, depending on the Units 
selected.

•	 Show Stopoff Dividers: If this option is checked, MaxLoad Pro will draw lines/ dividers to separate 
different stop offs.  

If the overlapping between stop offs is allowed, the divider is placed at the beginning of the next 
stop as illustrated below. 
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•	 SKU Field Button:  Displays the SKU List dialog box, which allows you to display dimensions, 
weight and SKU information in the SKU List on the Manifest Pick List Screen.  If these fields are 
turned off, the startup of MaxLoad will be much faster.

Load Rules:  In order to create customized solutions, MaxLoad Pro makes use of specific loading 
algorithms or parameters specified as Load Rules.  You can create multiple sets of load rules 
emphasizing various load parameters in the Load Rules dialog box as shown below.

�� This is an advanced feature and should only be attempted with guidance from TOPS. 
Please contact TOPS tech or MVP team for its use.

•	 Default Print Layout: Select from the drop list the default MaxLoad report that will be printed 
whenever the generic print command is issued or when you press [Ctrl]+[P] in MaxLoad.

•	 Loading Railcar:  Select an option – either Use 1/3 or Use Sidedoor – to specify how a railcar will 
be loaded.

•	 Color Stop Offs: Enable color distinction for stop offs in graphics Load reports, thus making them 
easily identifiable. When enabled, SKU colors will be replaced with stop colors.
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•	 OK Button: Saves the changes made and closes the Global Settings dialog box.

•	 Cancel Button: Closes the Global Settings dialog box.

Defaults
The Defaults button opens the Defaults dialog box, as pictured below, where you can easily select 
default unit of measure, the language and the location for a graphical logo to be used in all reports 
within MaxLoad Pro. 

 

•	 Units:  Globally selects the unit of measure for MaxLoad Pro.

•	 Language: Selects from the drop list, one of the many languages supported by MaxLoad Pro. 

•	 Logo Path: Allows you to specify the location for the graphical logo to be printed on each of the 
report types from MaxLoad Pro.

•	 Apply to existing users: Check this box if the current default settings are to be applied to the all 
existing users.

•	 Apply to new users: Check this box if the current default settings are to be applied to all new 
users.  These two boxed are not mutually exclusive, you can check both options to have the new 
defaults apply to all users.
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Fonts
The Fonts button opens the MaxLoad Fonts dialog box, pictured below, where you can choose 
from multiple fonts to use when printing or viewing a solution.  MaxLoad Pro allows you to assign 
different fonts to 10 different heading/text types located throughout system.

 

To change a font, follow these instructions:

1.	 Click on the Change button next to the text/heading style that you want to modify.  

A standard Windows Font dialog box appears.  This Font dialog box is similar to that found in 
most major word processing/spread-sheet programs.  

 

2.	 Make the appropriate changes, then click on OK.  

3.	 To exit the MaxLoad Fonts dialog box without saving any changes, click on Cancel.

�� Note:  As a suggestion, we’ve found that the Arial Bold font are the easiest to view.
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E-Mail
The E-Mail button opens the Email Options dialog box where you can configure the e-mail client 
used when sending reports in MaxLoad Pro. Select your client from the list and provide SMTP server 
information accordingly if this option is selected.

•	 Microsoft Outlook: Select this option if you are using Microsoft Outlook as you email client.

•	 Thunderbird: When this email option is used, make sure to add the path of the executable file 
under the [Maxload] section of the Maxload2.ini file as in example below. Replace the path with 
the one on your PC where the file is located. 
ThunderbirdPath=”C:\Program Files (x86)\Mozilla Thunderbird\thunderbird.exe”

•	 SMTP Server: Select this option when you use Gmail, Outlook mail or similar SMTP based 
programs. Example for Gmail parameters are:

»» Server Name: smtp.gmail.com

»» Server port: 587 if you are using TLS and 465 if you using SSL.

»» User Name:  john@gmail.com

•	 Save to Local:  This option saves the file to a PC file location instead of sending it to a recipient via 
email. You will be prompted for a file location whenever you issue an email command.

Properties
In addition to the Configuration dialog box, MaxLoad Pro provides a number of Properties Sheets 
that allow you to define the various defaults and properties in the system.  All users have access to 
these Properties Sheets.

Each field is linked to a Properties Sheet dialog box, which allows you to change both defaults and/
or properties for the specific field.  This provides a general overview of the defaults/properties 
functions in MaxLoad Pro.

Similar fields have similar Properties Sheets. In MaxLoad Pro, the various fields fall into one of four 
categories:

•	 Lists: A collective display of various fields.  For example SKU List.

•	 Measurement Input Fields:  Fields that contain a dimension or weight.

•	 Non-Measurement Input Fields:  Fields that contain numeric values, but don’t measure anything.

•	 Radio Buttons:  Fields that contains radio buttons.

•	 Check Boxes:  Fields that contain check boxes.
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To access the Properties Sheet dialog box, use one of two options:

Option 1
1.	 Click on the field whose properties you want to change.

2.	 From the Menu Bar, open the Edit menu and select Properties. The Properties Sheet dialog box 
appears.

Option 2
1.	 Right click on the name of the field that you wish to change properties. A Properties button 

appears. 

2.	 Left click on the Properties button.  The Properties Sheet dialog box appears.

Lists
Working in the software you will notice that there are various lists, like SKU List, Manifest List, Sol 
List, Placement List, displaying important information about SKUs, unitloads, mixed pallets, solutions, 
etc.  The  type of information displayed in these lists can be controlled by the Properties feature.  
The Properties dialog box for Lists can only be accessed by the Edit menu.

For example, to view the Properties for the SKU List follow these instructions:

1.	 Select any column header in the SKU List, by clicking on the tab for SKU, Description, etc. 

2.	 From the Menu Bar, open the Edit menu and select Properties. The Properties dialog box 
appears.  Here you can check and uncheck as to what needs to be visible in the SKU List.

Measurement Input Fields
All fields with numeric values (for example, Define SKU) contain measurement input fields.  You’ll use 
this field type to input the dimensions or weight of an object.

•	 Units: Change the measurement units for the field that you are making changes to.  There are 
three choices in regards to measurement units; English, Metric, or Global.   English and Metric are 
self-explanatory.  But if you choose Global, MaxLoad Pro uses the measurement units selected in 
the toolbar.   

•	 Default Value: Set a default value for that parameter.  For example, set a default value of 12 
inches for Minimum Ceiling Clearance for fork lift maneuver.

•	 Decimal places (English/Metric): Set the number of decimal places to be displayed for each field.



                                                                                                                          Chapter 11: Configuration | 199

       

•	 Units Type (English/Metric): Select the values used for the corresponding unit of measure, inches 
or feet for English; millimeters, centimeters, or metes for metric system.

•	 Truncate zeros: Check whether or not you want MaxLoad Pro to truncate zeros (i.e., display zeros 
after the decimal point).

•	 Show Fractions: Check to input fractions rather than decimals.

•	 Control Label: Displays the name of the Control Label for the current field.  To change the Control 
Label, go to the Tool menu, select Language and then Edit Language.

Non-Measurement Input Fields
Non-measurement input fields are not as common as measurement input fields.  You’re most likely 
to run across these fields only when you’re defining stacking relationships or select a default vehicle.

The Define SKU screen provides a good example of this type of field.  Under the Stacking tab, the 
fields labeled Maximum Stack Height (On Base and On Side) are considered Non-measurement input 
fields.  In the Define Pallet screen, the field labeled Total Deck Boards is another example of a non-
measurement input field. 

A Non-Measurement Input screen accepts only whole numbers and is generally used when 
answering the question “How many?”  These fields accept a maximum of three characters.
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Notice that there’s only one tab in this dialog box:  Defaults.  When you make a change in this field, 
it will not affect any previously defined items but it will affects all future SKUs, pallets or vehicles, 
including the one you’re currently defining.   You can also change the name of this field using the 
Control Label feature.

Radio Buttons
Radio buttons contain their own default behavior.  Remember that radio buttons are mutually 
exclusive, meaning that you can choose only one option; you cannot select multiple options.  
Because radio buttons are unique in behavior, they also must have a unique Properties Sheet.  

Regardless of which field you click on in a radio button box, you’ll always access a common 
Properties Sheet; in other words, all buttons tie into the same sheet.  As with non-measurement 
input fields, this dialog box only contains a Defaults tab, meaning that changes made to the 
Properties Sheet will affect the item you’re currently defining, as well as any future items that you 
define. 

Check Boxes
Check boxes allow you to turn certain MaxLoad Pro features on and off.  Unlike radio buttons, check 
boxes are not mutually exclusive, meaning that each one behaves independently of the other.  
Because of this behavior, check boxes are considered unique enough to warrant unique Properties 
Sheet.  There’s one exception:  the check boxes in the Allowed Vertical Column, whose Properties 
Sheet behaves in much the same fashion as a radio button.

 

To change a check box default, access the Properties Sheet for the specific field that you want to 
change.  Unlike a radio button Properties Sheet, each field has its own separate Properties Sheet.  
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Use your mouse to click on or off the Default Value for that field.  Notice too that you can change the 
Control Label for the field in question.  When you’re finished making changes, click on OK to exit the 
Properties Sheet.

Examples
Below are some examples illustrating how to change the defaults for some common functions and 
features within MaxLoad Pro:

Example 1: Changing the Default Vehicle Type
If you use mostly sea vans or sea containers for your loads, you can change the vehicle type from the 
current default of Truck to Sea Van by following these steps:

1.	 At the Manifest Pick List Screen, place the mouse cursor anywhere in the Vehicle Type section 
and right click the mouse button. The Properties button appears.  

2.	 Click on the Properties button. The Properties Sheet for the Defaults of the current field (Vehicle 
Type) appears as shown here, showing the current default of “Truck”.

    

3.	 Click on “Sea Van” as the new default vehicle type. The radio button for Sea Van is now selected.

4.	 Click on OK to use the new default. The Confirm dialog box appears as below. 

   .
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5.	 Click on Yes to confirm the change.

This new default will take effect when you do a new Truck or Single SKU Manifest.

Example 2: Adding a Default Selected Vehicle
When you do a new Truck or Single SKU Manifest, you will have to select a vehicle from the Available 
Vehicles list.  If all your loads only go into 53 Ft Dry Van, you can set this as the Default Selected 
Vehicle so you don’t have to specify the vehicle every time you create a new manifest.  The following 
steps illustrates how to add a default selected vehicle.

1.	 At the Manifest Pick List Screen, place the mouse cursor anywhere in the Selected Vehicle 
section and right click the mouse button.  The Properties button appears.  

2.	 Click on the Properties button. The Properties Sheet for Selected Vehicle appears as shown here, 
showing the current default of “None”.

 
3.	 Click on the drop list and then move the scroll bar until you see 53 Ft Dry Van on the list.

4.	 Click on “53 Ft Dry Van” to make it the current selection and then click on the OK button.

5.	 You will see a Confirm dialog box as in the previous example.  Just click on the Yes button to 
confirm.

You will see the “53 Ft Dry Van” as  the Selected Vehicle whenever you create a  new Truck or Single 
SKU Manifest.
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Example 3: Changing the Default Mixed Pallet Height
When you create a Pallet Manifest or placing mixed SKUs on a pallet, you can specify how high the 
pallet can stack (Maximum Height Incl Pallet).  The default value in MaxLoad Pro for this parameter is 
55 inches.  To change this default value, please follow these steps:

1.	 At the Manifest Pick List Screen for Mixed Pallet, place the mouse cursor at the text “Maximum 
Height Incl Pallet” and right click the mouse button.   Select Properties at the pop-up menu.

  
2.	 Click on the Properties button.  The Properties Sheet appears.

  
3.	 Change the “Default Value” from 55.00 to 60 and click on the OK button.

4.	 You will see a Confirm dialog box as in the previous example.  Just click on the Yes button to 
confirm.

You will see the new default value in the Maximum Height Incl Pallet field when you create a new 
Pallet Manifest or under the Mixed Pallet tab in a new Truck Manifest.

You can follow this example to change the default Overhang Values for pallets.
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12 Import/Export Functions

Importing SKUs and shipment data is one of the most important functions when using MaxLoad Pro.  
Data can be brought in using Generic or Custom import which will be explained in this chapter.

Import and Export topics in MaxLoad Pro include:

Import (Generic)

•	 MaxLoad Pro ASCII Interface
•	 Import Command Entries
•	 Import Record Entries
•	 Units Data Field

Import - XML

Import Tops Data

Custom Import

•	 Import SKU
•	 Config SKU Import
•	 Import Picklist
•	 Config Picklist Import

Purge Master Data

Export Databases

Export - XML

Export by Placement

Custom Export (Solution, Placement List, Load List, Airbag/Dunnage)

Export - Summary

Export - Mixed Pallets

Export – UnitLoads

Export Manifest

Email Manifest

Import Manifest

Ftp Import

Import / Export using system clipboard



206 | MaxLoad®Pro User Guide v4.0

Import (Generic)
Use the Generic Import function to import data which conforms to MaxLoad Pro’s ASCII Interface 
Format as described in the following section.  Once the import file is created, follow these 
instructions to import:

1.	 Login to MaxLoad Pro.

2.	 From the Menu Bar, open the Tools menu, select Import. A sub menu appears.

3.	 Select Import (Generic) which opens the Import File dialog box as shown below.

  

4.	 Highlight the file to be opened and click on the Open button. Then click Import.

MaxLoad Pro will start importing the data. You will see the status of the process in the pop-up

MaxLoad Pro ASCII Interface
MaxLoad Pro software for Windows is capable of importing SKU, Order and other data through 
the use of ASCII comma delimited files.  Most programs and systems are capable of generating 
ASCII comma delimited files.  If Microsoft Excel is used to generate them, save the file as a CSV file 
(Comma Separated Values).  The resulting text file is readable by MaxLoad.  

A sample Excel spreadsheet called IMPORT.XLS has been included with the software.  It 
demonstrates a simple import of SKU data to populate the database and an import of an “order” 
for use as a MaxLoad Manifest.  Both import documents (this IMPORT.DOC and IMPORT.XLS) are 
accessible through their Start Menu Shortcuts under “TOPS for Windows APPS”.  The Documents 
themselves can be found in the MaxLoad installation directory (...\TOPSAPPS\Max2Pro\). 

�� Check TOPS website at www.topseng.com for the most up-to-date documentation.

To import this CSV file into MaxLoad, go to use the Tools Menu, select Import and then Import 
(Generic).
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Populating MaxLoad Pro’s SKU database
Often, a normal import of a new user’s SKU information into MaxLoad Pro goes as follows:

5.	 Export the SKU information (names, dimensions and weight) from his current application or 
database.

6.	 Load the data into Excel.  Once in Excel, manipulate the table until your data fields line up with 
MaxLoad’s Generic Import format as described in this document.  

7.	 Save the Excel spreadsheet as a CSV file.

8.	 Enter MaxLoad and select Tools | Import | Import (Generic) to import the CSV file.  Change the 
file type to CSV and browse to the folder where the file resides.

9.	 Select the file and then click open to Import.

�� NOTE: If you want to remove the pre-existing SKU and Manifest databases from 
MaxLoad before importing your data, import the file PURGEALL.TXT first.

Transferring Order information to MaxLoad Pro for Processing
The order placement system needs to generate an ASCII comma delimited file in the format 
described in this document.  Normally an order must contain:

1.	 The standard Header information ([Version], [English], etc.)

2.	 One or more [Manifest] sections.  A manifest is an item of work for MaxLoad.  SKUs are attached 
to the manifest through the manifest’s picklist, in an attempt to load them into a container.  
Many companies would refer to a manifest as an “order” or a “shipment” of orders.

3.	 One or more [PickList] sections.  The picklist names the SKUs (with quantities) to be loaded onto 
which manifests.

4.	 One or more [ContainerList] sections.  This optional section indicates what vehicles (containers) 
the manifest should attempt to load its SKUs onto.  If this section is not included then no default 
vehicle will be assigned to the manifest and the user will have to manually select one before 
calculating.

This file is then imported into MaxLoad either using the Tools | Import menu or a command line 
parameter for automatic import.  The imported file can contain Import Commands that force the 
software execute additional command such as: deleting other manifests, exiting after import, 
rename the imported file, chaining to another import file, etc. as provided on “Import Command 
Entries” on page 208.

MaxLoad Pro Import/Export Format
When importing from ASCII, MaxLoad Pro fills in any fields that are missing or incomplete. It does 
not perform this error checking during regular operation.  Any field that is left blank gets filled during 
the import using the system defaults (as if the user had been entering the information from the 
keyboard).  Defaults are adjusted in the program by using the defaults tab of the corresponding item 
properties.  In some cases it will be necessary to right click on the label next to the appropriate field 
instead of the field itself.  (i.e. if you want to change the default overhang on a pallet:  go the define 
SKU menu item; choose create UL; right click on “Maximum Length Overhang”; select “properties”; 
then the defaults tab.)

Import and export functions are performed within MaxLoad using the Tools menu within the 
program.  The following command line parameters facilitate automated import:
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-Import=	 Imports the specified file on startup if it exists.

-View	 Starts the program in View only mode; the user will be unable to modify anything 
		  and may only view existing work.

-DBPath=	 Use the MAXLOAD.MDB in the specified path instead of the checking in the path 
		  indicated in the MAXLOAD2.INI file.

-Ini=		 Use the specified INI file instead of the default MAXLOAD2.INI file.

-User=	 Automatically login as the specified user.

User names, paths, and filenames that contain spaces or other delimiters should be “quoted.”

Import Command Entries

[Version] 
Every MaxLoad Pro import/export file begins with the header [Version].  The 
next line denotes the MaxLoad Pro software version from which the data is 
being exported or being imported into.  When creating an import file, this 
information is listed on the first two lines.

[English]/[Metric] When exporting/importing, one of these two “flags” is included after the 
[Version] section to indicate the current default units in the software.

[Delete] After import or before chaining, delete the imported file.

[Rename To]
After import or before chaining, rename this file to the name indicated on 
the next line.  If both [Delete] and [Rename To] are indicated, [Delete] takes 
precedence.

[Chain To] After importing the current file, import the file listed on the next line, deleting 
or renaming this file as previously specified.

[Clear SKU File] Delete all SKU’s from the SKU database.

[Clear Truck MFT] Delete all Truck Manifests for all users & their associated records.

[Clear Vehicle MFT] Same as [Clear Truck MFT].

[Clear Pallet MFT] Delete all Mixed Pallet Manifests for all users.

[Clear Tote MFT] Not implemented.

[Clear Single MFT] Delete all Single SKU Manifests for all users.

[Clear All MFT] Delete all manifests for all the users.

[Exit] After completion of import, exit the program. 

Import Record Entries

[Annotate] Not Documented.  Describes text and graphic annotations to a manifest’s print 
preview.

[ContainerList]

This is an optional section and indicates what vehicles (containers) the manifest 
should attempt to load its SKUs into.  If this section is not included then no 
default container is assigned to the manifest and the user has to manually select 
a container before calculating the manifest.

[Cutlist] Not Documented.  Used to list which items didn’t make it onto a manifest (if the 
manifest has been calculated)

[Defaults] Not Documented.  One default table control/field to a line.

[Fonts] Not Documented.  The fonts selected under Tools | Configuration | Fonts menu.
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[Manifest]
Manifest even referred as “order” or “shipment” describes the type of container 
to be loaded, what loading patterns will be used.  Use subsequent [PickList] 
records to define what SKU’s will be loaded.

[Messages] Not Documented.  Multi-lingual export of long system phrases.

[Pallet] Descriptions of the pallets a SKU can be loaded onto.

[PickList] The PickList section lists the SKUs to be loaded to a manifest.  It includes 
manifest fields like - SKU quantities, priority, order #, whether to unitize it, etc.

[PlaceList] Use by calculated loads to record the location of each loaded item in a 
container/pallet.

[SKU] Each record describes a SKU and includes SKU type, SKU name, descriptions, 
dimensions, orientation preference, piece count and other related information.

[Stack] A list of the current stack codes and their default states.  Does not contain a 
complete description of the stackability matrix.

[Tote] Not implemented.

[UnitLoad] Describes which pallet to use for a given Manifest, SKU, or Mixed Pallet.  Also 
specifies what overhang, underhang, etc. to use instance.

[User] record Individual user settings including, Name, Stackmatrix  path, and other settings 
found under the Configuration” menu.

[Vehicle] Descriptions of the vehicles that may be loaded.

Units Data Field Anytime a distance, weight, area, volume, or percent is exported it is formatted/
described using the Units Data Field format. (See the next section.)

Units Data Field
The following information is the breakdown of the units’ field used by MaxLoad Pro while exporting 
and importing.  The following types of Units fields are used in MaxLoad Pro:  Dimensions, Weight, 
Volume, Area, and Percent (English/Metric is ignored).

When a field is a numerical floating point value, such as a distance (inches) or weight (kilograms), 
it will be stored as a Units field.  This includes all the formatting data required to display in either 
English or Metric units.  Internally, the value is stored as a standardized English value.  A Units field 
contains a number of sub-fields.  The entire set is exported as a character string enclosed in quotes.  
The sub-fields are space-delimited inside this string.

“12 (in) G N N 0 0 2 3”

Subfield: 1 2 3 4 5 6 7 8 9

Name: value units english/metric fractions zeros english convert metric 
convert #decimals #decimals

Example: 12 (in) G N N 0 0 2 3

Subfield Descriptions

1.	 Value: This value will be translated to its internal English representation upon import.  Fields 3, 
6, and 7 are used to convert this number to its internal English representation.  If this is the only 
field entered for a unit, it need not be in quotes.  In that case, all other fields will be imported as 
the current system defaults.  When MaxLoad exports this value from the program it will adhere 
to all the display parameters that were set, this means that exporting and re‑importing could 
loose a few significant digits or end up rounded to the nearest 64th.
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2.	 Units: Textual representation of the type of units, (in), (gr), (lbs), etc.  This field is currently 
ignored by the import parser and may be any value.  It is exported to ease the reading of ASCII 
file.

3.	 English/Metric:  Instructs the program to convert units.

•	E - English, convert using sub-field 6
•	M - Metric, convert using sub-field 7
•	G - Global, during a normal export the current global state is exported so that the 

appropriate state can be “assumed” on re-import. See the [English] and [Metric] 
sections

4.	 Fractions:

•	Y - Display with fractional parts rounded to the nearest 1/64th

•	N - As Decimals with the appropriate number of decimal places
5.	 Zeros:

•	Y - Show significant figures after the decimal point.
•	N - Truncate trailing digits after the decimal

6.	 English Convert: An index into the English multiplier table.  The multiplier is used to convert the 
internal value to and from the displayed value.  Each type of Units field has its own multiplier 
tables.

7.	 Metric Convert:  An index into the Metric multiplier table.

8.	 English Decimals: The maximum number of significant digits after the decimal to show when 
displayed in English.

9.	 Metric Decimals: The maximum number of significant digits after the decimal to show when 
displayed in Metric.

All sub-fields except sub-field 1 are optional when creating your own import file.  However, you 
may not skip one and enter the next.  This would confuse the parser.  For example, you may enter 
12, “12”, “12 (in) G”, or “12 (in) G Y N 0 0”, but not “12 (in) G 0 0”.  The 
missing sub-fields will be filled by the defaults for the particular field (ex: the weight field for an SKU 
or the Length field of a pallet).  Careful coordination must be used if you skip these sub-fields. Know 
your defaults.

In the following few pages we will discuss some of the Import Record Entries in detail.  Please follow 
this key to better understand Record Entry Tables for each Entry:

�� Note:  A ‘Y’ indicates that the mentioned pallet pattern is allowed.  Patterns switches 
only apply to Single SKU Manifests and UnitLoads.

�� Reserved:  These fields are reserved for future use.  Items may have values when 
exported but should not be constructed by the user for import.  Allow the system to fill them 
in during import.

�� Italics:  Items in italics are not currently implemented. Leave these blank.

�� (#):  On some of the string values below, a number can be found in parentheses.  This 
number represents the maximum field width.



                                                                                                                          Chapter 12: Import/Export Functions | 211

[SKU] Record
This record field is used to define SKUs.  Each record describes a SKU.

Column Name Type Description
A SKU Type Numeric 0 – Unknown

1 – Carton
2 - Tray
3 – Shipcase
4 – Bag
5 – Tub
6 – Drum
7 – Bottle
9 – Tote SKU
10 – Pallet SKU
11 – Unitload / Pallet Load
13 – L Shape SKU
14 – Trapezoid SKU

B Name String (32) SKU Number
C Description String (50) SKU Description (Optional)
D MFT

E Pallet String (32) Name of the pallet to Unitize this SKU onto.
F SubType Numeric 0 – Unknown

1 - Single Ended bags
2 – Double Ended Bags
3 – Round Drum
4 - Ovals
5 – Rectangular
6 – Mixed Pallet

G Length Distance SKU length or SKU diameter for drum style SKUs.
H Width Distance SKU width
I Height Distance SKU height.
J Weight Weight SKU weight.
K Bottom Width 

/ Height Base
Distance Trapezoid SKU bottom width or 

height base of L-shape SKU
L Bottom Length 

/ Width Base
Distance Trapezoid SKU bottom length or 

width base of L-shape SKU
M Reserved Reserved – Distance
N Max Stack Wgt Weight Maximum weight allowed to be stacked on this SKU
O Length Vert Y/N Y - Length is allowed Vertical (End Stack)
P Width Vert Y/N Y - Width is allowed Vertical (Side Stack)
Q Height Vert Y/N Y - Height is allowed Vertical (Bottom Stack)
R Unitize Y/N Y –MaxLoad Pro will use this SKU as a unitload whenever 

possible.
S Mixed Pallet Y/N Y - This SKU may be placed on a pallet with other SKU’s 

after as many full pallets of this SKU as can be have been 
constructed  (that is, put leftovers on mixed pallets).

T Tote
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U Has UL Y - A UnitLoad Record exists for this SKU.  If the user 
indicated that he wants the SKU unitized, it will use this 
pre-defined UnitLoad for full pallets of the SKU instead of 
generating one on the fly.

V Stagger Y/N Mostly used for cylindrical shape SKUs.
W Preferred Vert Numeric 0 - Length

1 - Width
2 - Height
3 - No Preference

X Label Surface Numeric 0 - Length
1 - Width
2 - Height

Y Dead Stacking 
Rules

Numeric 0 - Must be stacked floor 
1 - Must not be stacked on floor 
2 – Best Fit
3 – Prefer on Floor
4 – Prefer on Top

Z Load Into 
vehicle 

Numeric 0 - Length
1 - Width
2 - Best Fit

AA Stack Code String (20) Stack Code from stack matrix.
AB Max Stack 

Height (On 
Base)

Numeric Maximum number of cases allowed high (of Self) when 
upright.

AC Max Stack 
Height (On 
Side)

Numeric Maximum number of cases allowed high when on side or 
on end.

AD Color Numeric Decimal representation of a 4 Byte RGB value (see values 
on the next page)

AE Label String (20) Another name for the SKU besides SKU Number
AF Top Graphic String (255) Full path to the paste on graphic file to be shown on top 

of the SKU. 
AG Side Graphic String (255) Full path to the paste on graphic file to be displayed on 

the side of the SKU
AH Front Graphic String (255) Full path to the paste on graphic file to be pasted on the 

front of the SKU
AI SKU Info 1 String (64) Additional notes fields for SKU.  This info gets displayed in 

the SKU List and the Manifest List but not on reports.
AJ SKU Info 2 String (64) Same as SKU Info 1
AK SKU Info 3 String (64) Same as SKU Info 1

AL – AX Reserved Reserved
AY Piece Count Numeric This reflects the quantity of items going in the SKU.
AZ No Stack Side Y/N Nothing can stack on top of this SKU if it’s side loaded
BA Bundle Count 1 Numeric Number of items in a bundle (first preference)
BB Bundle Count 2 Numeric Number of items in a bundle (second preference)
BC Bundle Count 3 Numeric Number of items in a bundle (third preference)
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BD Load Location Numeric 0 – Load in front
1 – Load in middle
2 – Load in rear

BE - BG Reserved Reserved - Distance
BH OrgID Numeric Organization ID (for ADO version only)

[UnitLoad] Record
UnitLoad Records are used to describe the parameters needed to display items grouped together on 
a pallet.  This includes unitloads for individual SKUs, the mixed pallet parameters for truck Manifests, 
and the parameters for mixed pallet manifests.

Column Name Type Description
A Type Numeric 0 - UnitLoad

1 - Mixed Pallet on a Truck
2 - Mixed Pallet Manifest

B Name String (64) Name of SKU or Manifest, depending on type.  SKU 
names are limited to32 characters while Manifest Names 
can be up to 64 characters.

C Pallet String (32) Name of Pallet being used.
D Stack Code String (20) Stack code (from Stack Matrix) to use when loading into 

vehicle.
E – N Reserved Reserved

O Stack Height Numeric Number of SKUs/loads allowed to be stacked on one 
another.

P Stack Rules Numeric 0 - Must be stacked on floor
1 - Must not be stacked on floor
2 - Best Fit

Q Load Into vehicle Numeric 0 - Load By Length
1 - Load By Width
2 - Best fit.

R - T Reserved Reserved
U Corner Posts Y – Place corner posts on the unitloads

V - Z Reserved Reserved
AA Block 1 Y/N Note 1 - One Block (Columnar)
AB Block 2 Y/N Note 1 - Two Block (Interlock)
AC Block 3 Y/N Note 1 - Three Block (TriBlock)
AD Block 4 Y/N Note 1 - Four Block (Spiral, Pinwheel)
AE Block 5 Y/N Note 1 - Five Block (Filled Spiral)
AF Block 5P Y/N Note 1 - Five Block Plus (Double spiral with Fill)
AG Soldier Y/N Note 1 - Soldiered
AH Diagonal Y/N Note 1 - Diagonal
AI Reserved Reserved
AJ Multi-Dim Y/N Note 1 - Allow each layer to have a different case dim 

vertical.



214 | MaxLoad®Pro User Guide v4.0

AK Multi-Surface Y/N Note 1 - Using the one through four blocks, load as 
though gravity were pulling toward the wall.

AL Multi-Layer Y/N Note 1 - Allow top layer to be any dimension vertical 
regardless of dimensions allowed vertical for this SKU 
(because it’s on top).

AM Stagger Y/N Note 1 - Allow staggered patterns for round objects.
AN Max. Len. Overhang Distance Distance cases are allowed past edge of pallet.
AO Max. Wid. Overhang Distance Distance cases are allowed past edge of pallet.
AP Max Height Distance Maximum unitload height.
AQ Max Weight Weight Maximum unitload weight 
AR Corner Posts 

Support Length 
Distance Thickness of material for corner posts.

AS Corner Posts  
Support Width

Distance Width of corner posts.

AT Max Stack Wgt Weight Maximum weight of items allowed being stacked on top 
of this UL.

AU Max Vert Gap Distance Maximum height difference between adjacent mixed 
pallet items to be considered level when loading items 
onto them.

AV Stack Code 2 String (20) Stack code (from stack matrix) to use when loading into 
vehicle.

AW Length Float Calculated length of loaded unitload.
AX Width Float Calculated width of loaded unitload.
AY Height Float Calculated height of loaded unitload.
AZ Weight Float Calculated weight of loaded unitload.
BA OrgID Numeric Organization ID (for ADO version only)

�� The Decimal representation of a bit field defining the layers that are to be rotated.  Bit 1 
= bottom layer.  Max of 32 bits.

�� A ‘Y’ indicates that the mentioned pallet pattern is allowed.  Patterns switches only apply 
to single SKU UnitLoads (Not Mixed Pallet Loads).

�� Reserved Items may have values when exported but should not be constructed by the 
user for import.  Allow the system to fill them in during import

[Manifest] Record
Manifest even referred as “order” or “shipment” describes the type of container to be loaded, what 
loading patterns will be used.  Use subsequent [PickList] records to define what SKU’s will be loaded.

Column Name Type Description

A Name String (64) Name of the manifest.

B User Name String Name of user creating this manifest.  If left blank and 
user logins are active, only Supervisor will be able to 
open.
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C Manifest Type Numeric 0 - Vehicle
1 - Pallet
2 - Tote
3 - Single SKU

D Units E/M E - English
M - Metric
G - Global Setting to be put into place when opening 
this manifest

E - G Reserved Reserved.

H Show Flaps Y/N Y - Show Flaps on cases.

I Vehicle Type Numeric 0 - Truck
1 - Sea van
2 - Railcar
Vehicle manifests only.

J Use UnitLoads Y/N Y - Put SKU’s on pallets (unitize) - Vehicle manifests only.

K Use Mixed Pallets Y/N Y - Put SKUs on mixed pallets - Vehicle manifests only.

L Reserved Reserved

M Group Orders Y/N Y - Attempt to keep items with the same stop off or 
priority and the same order number near each other in 
the load.  This may cause a loss of efficiency.

N Group Like SKUs Y/N Y - Attempt to keep SKUs with the same stop off or 
priority clustered in the load.

O Load Front to Back Y/N Y - Use the standard front to back algorithm.

P Load Floor to 
Ceiling

Y/N Y - Use the optional floor to ceiling algorithm.  This 
algorithm does not handle multiple stop off’s or 
priorities.

Q Load by priority Y/N Use the priority system rather than the stop off system.

R Load by stop off Y/N Use the stop off system rather than the priority system.  
Do not set both load by priority and load by stop off to 
‘Y’

S - U Reserved Reserved

V Max Cargo Wgt Weight Maximum weight allowed in load.

W Min Vert 
Clearance

Distance For vehicles only.  The amount of ceiling clearance 
required.

X Max Vert Gap Distance Maximum height difference between adjacent items to 
be considered level when loading items onto them.

Y Max Overlap Distance The distance down the length of the vehicle one priority 
or stop off can overlap the previous priority or stop off.

Z Reserved Reserved

AA Block 1 Y/N Note 1 - One Block (Columnar)

AB Block 2 Y/N Note 1 - Two Block (Interlock)

AC Block 3 Y/N Note 1 - Three Block	 (TriBlock)

AD Block 4 Y/N Note 1 - Four Block (Spiral, Pinwheel)
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AE Block 5 Y/N Note 1 - Five Block (Filled Spiral)

AF Block 5P Y/N Note 1 - Five Block Plus (Double Spiral with fill)

AG Soldier Y/N Note 1 - Soldiered

AH Diagonal Y/N Note 1 - Diagonal

AI Reserved Reserved

AJ Multi-Dim Y/N Note 1 - Allow each layer to have a different case dim 
vertical.

AK Multi-Surface Y/N Note 1 - Using the one through four blocks, load as 
though gravity were pulling toward the wall.

AL Multi-Layer Y/N Note 1 - Allow top layer to be any dimension vertical 
regardless of dimensions allowed vertical for this SKU.

AM Stagger Y/N Note 1 - Allow staggered patterns for round objects.

AN Reserved Reserved

AO Load Layers Y/N Y - For mixed pallet manifests, Attempt to load complete 
layers of SKUs, as defined in the individual UnitLoads for 
those SKUs, before loading loose cases.

AP Reserved Reserved

AQ Mixed Pallet Count Numeric Number of mixed pallets generated by this Vehicle 
Manifest.

AR - AU Reserved Reserved

AV Load Space Evenly Y/N Y - Load using the Space evenly algorithm

AW Load using L/R Y/N Y - Apply Left to right optimization to the other 
algorithms when loading

AX MFT Comment 1 String (128) An optional comment field that appears on reports.

AY MFT Comment 2 String (128) An optional comment field that appears on reports.

AZ MFT Comment 3 String (128) An optional comment field that appears on reports.

BA Report Type Numeric Indicates which views to print 
1 - 3D Front
2 - 3D Back
4 - Top
8 - Side
16 - Front.

BB Show Graphics Y/N Print cases with Paste on 

BC Print Style Numeric 0 - B/W
1 - Color Outline
2 - Color throughout

BD Resolution Numeric Integer between 50 and 100.  100 - Fine print using the 
largest Bitmap we can make, AKA fine. 50 - Course.

BE ZipCode1 String(16) For costing function.

BF ZipCode2 String (16) For costing function.

BG ZipCode3 String (16) For costing function.

BH ZipCode4 String (16) For costing function.

BI - BS Reserved Reserved
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BT IterSpeed Numeric Iteration count or speed. This is the setting of the 
speed/space control under the Optimize option via 
the Algorithms button. Value is from 0 to 200, 0 for 
speed (less iterations) and 200 for maximum space 
optimization (more iterations).

BU King Pin Weight Float King Pin Weight Limit under the Weight tab when 
Weight Limit is enforced.

BV Axle Weight Float Axle Weight Limit under the Weight tab when Weight 
Limit is enforced.

BW Reserved Reserved

BX Weight Limit Numeric 0 - No Weight Limit
1 - COG Deviation
2 - Weight Limit
3 - Segment Weight Limit

BY - CF Reserved Reserved

CG Customer Name String (64) Customer name under the Comments tab.

CH Customer Address String (128) Customer address under the Comments tab.

CI Status String (32) Status under the Comments tab.

CJ - CX Reserved Reserved

CY OrgID Numeric Organization ID (for ADO version only)

 
[ContainerList] Record

The ContainerList Record indicates the vehicle(s) to be loaded by this manifest.  Mixed pallet 
manifests do not use this record and Single SKU manifests use exactly one container.

Column Name Type Description

A MFT Name String
(64)

Manifest that this vehicle is being used in for.  Must already 
exist.

B Vehicle Name String As found in the vehicle database.  Must already exist.

C Number Numeric Which truck should this vehicle be assigned to?  If there are 
multiple trucks of SKUs, then this would specify that the 
vehicle was for the nth truck.  Normally should be 1 for new 
manifests.

D Current Y/N Used when ‘View’ is clicked. The current vehicle is the one 
displayed.

E MFT Type Numeric 0 - Vehicle
1 - Pallet
2 - Tote
3 - Single SKU onto Vehicle.

F Reserved Reserved

G OrgID Numeric Organization ID (for ADO version only)
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[PickList] Record
The PickList section lists the SKUs to be loaded to a manifest.  It includes manifest fields like - SKU 
quantities, priority, order #, whether to unitize it, etc.

Column Name Type Description

A SKU Name String
(32)

Name of the SKU as found in the SKU file.

B MFT Name String
(64)

Name of the Manifest this record belongs to.

C Number Numeric All Pick records for a given single Manifest are numbered 
sequentially.

D SKU Type Numeric See Type in the SKU Record definition on “[SKU] Record” 
on page 211.

E SKU Subtype Numeric See Subtype in the SKU Record definition on “[SKU] 
Record” on page 211.

F Reserved Reserved

G Quantity. Numeric SKU quantity to be loaded.

H Order 
Number

String Use as you will.  The “Keep Like Orders Together” switch 
makes use of this.

I Priority Numeric Lowest priority is loaded first.

J Use 
UnitLoads

Y/N Y - Build unitloads of this SKU before loading into 
container.

K Reserved Reserved

L Use Mixed 
Pallets

Y/N Y - Load loose items of this SKU on Mixed Pallets.

M Stop Off Numeric Load Last Stop First.  Never load a partial stop.  Base 1.  
Stop off’s of zero “0” never get loaded.

N - O Reserved Reserved

P MFT Type Numeric 0 - Vehicle
1 - Pallet
2 - Tote
3 - Single SKU onto Vehicle.

Q Piece Count Numeric This is the quantity of items going in the SKU.

R FillItem Y/N

S OrgID Numeric Organization ID (for ADO version only)

[Tote] Record
The Tote is where you describe the Tote Container types.

Column Name Type Description

A Style Numeric Use 0

B Name String Name of Tote

C Group Numeric Not used

D Outside Length Distance Outside Length
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Column Name Type Description

E Outside Width Distance Outside Width

F Outside Height Distance Outside Height

G Inside Length Distance Inside Length

H Inside Width Distance Inside Width

I Inside Height Distance Inside Height

J Weight Weight Weight of this Tote

K Special Length Distance Not Used

L Special Width Distance Not Used

M Special Height Distance Not Used

N Maximum weight Weight Maximum Weight that can be loaded in this Tote

O Maximum Stack 
Weight

Weight Maximum Weight that can be put on top of this Tote

P Orientation Numeric 0 - Load into Vehicle by Length
1 - Load into Vehicle by Width
2 - don’t care

Q Stack Rules Numeric 0 - Must be stacked on floor
1 = Must not be stacked on floor

R Stack Code Numeric Stack code to use for the Tote

S Stack Height Distance Number of these UnitLoads allowed to be stacked on 
one another.

T Manifest Type Numeric 0 - Vehicle
1 – Pallet
2 – Tote
3 - Single SKU onto Vehicle

U Color Numeric Decimal representation of a 4 Byte RGB value.

V OrgID Numeric Organization ID (for ADO version only)

[Pallet] Record
The Pallet record section contains descriptions of the pallet a SKU can be loaded onto.

Column Name Type Description

A Type Numeric Type – 10 for Pallet

B Name String(32) Name of the Pallet

C Style Numeric Pallet Style 
1 = None;
2 = Stringer;
3 = Notched Stringer;
4 = Block;
5 = Block Stringer;
6 = Euro;
7 = Slip-Sheet

D Total Deck 
boards

Numeric Number of deck boards in the Pallet
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E Auto Size Y/N Y = Slip-sheet is trimmed to outside dimensions of the 
unit load

F Length Tab Y/N Y = Tab added to length

G Width Tab Y/N Y = Tab added to width

H Both sides Y/N Y = Tab added on both sides

I Construction Numeric Pallet construction style
0 = Single Face
1 = Double Face
2 = Reversible

J Alignment Numeric Refers to how the stringer is positioned in relation to the 
deck boards.
0 =Flush
1 = Single Wing
2 = Double Wing

K Length Distance Length of Pallet or Slip sheet

L Width Distance Width of Pallet or Slip sheet

M Height Distance Height of Pallet or Slip sheet

N Weight Weight Weight of Pallet or Slip sheet

O Wing Offset Distance Distance that the stringers will be offset from the edge of 
the pallet. 0 if alignment is Flush

P Deck board 
Thickness

Distance Deck board thickness

Q Inside Deck 
board Width

Distance Width of the inside deck board

R Outside Deck 
board Width

Distance Width  of the outside deck board 

S Center Deck 
board Width

Distance Width of the center deck board

T Stringer 
Width

Distance Width of the stringer

U Tab Width Distance Width of Tabs

V Color Numeric Decimal representation of a 4 Byte RGB value

W Number of 
Stringers

Numeric Number of stringers on the Pallet

X LoadPriority Numeric Preference to use current pallet when multiple pallet 
styles are selected in the manifest. 1 is the top preference, 
2 as second and so on.

Y OrgID Numeric Organization ID (for ADO version only)

[Vehicle] Record
The Vehicle record section contains descriptions of the vehicle types.

Column Name Type Description
A Type Numeric Use 12
B Name String (64) Name of vehicle
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C Style Numeric 0 = Truck
D Rail Car style Numeric 0 = Split
E Length Distance Loadable inside length of vehicle
F Width Distance Loadable inside width of vehicle
G Height Distance Loadable inside height of vehicle
H Max. Weight Weight Maximum loadable weight for the vehicle
I Distance to Drop off 

(Front)
Distance Distance of drop deck at the front of the 

vehicle
J Front Drop off Depth Distance Depth of drop deck at the front of the vehicle
K Distance to Drop off (Rear) Distance Location of drop deck at the rear of the vehicle 

(distance from front of vehicle)
L Rear Drop off Depth Distance Depth of drop deck at the rear of the vehicle
M Side Door Distance Distance (For rail car only) Location of side door from 

the front of the car. 
N Side Door Width Distance (For rail car only) Width of the side door.
O King Pin Distance Distance Distance of king pin from the front of the 

vehicle.
P Axle Count Numeric Axle count for the vehicle.
Q Axle 1 Numeric Distance of first axle from the front of the 

vehicle.
R Axle 2 Numeric Distance of second axle from the front of the 

vehicle.
S Axle 3 Numeric Distance of third axle from the front of the 

vehicle.
T Tare Weight Weight Tare weight of the vehicle.
U Color Numeric Color of the vehicle.
V King Pin/Front Axle Numeric Specify whether it is a king pin or axle at the 

front of the trailer

W
Front Ceiling Drop/Outside 
Ceiling Width (rail Wagon)

Distance Distance of ceiling drop from front of the 
vehicle (For Rail Wagon, this is the outside 
width of the raised ceiling)

X Front Ceiling Drop 
Distance/ Outside Ceiling 
height (rail Wagon)

Distance Depth of the ceiling drop at the front of the 
vehicle (For Rail Wagon, this is the outside 
height of the raised ceiling)

Y Rear Ceiling Drop/ Inside 
Ceiling Width (rail Wagon)

Distance Location of ceiling drop at the rear of the 
vehicle (distance is from front of the vehicle). 
(For Rail Wagon, this is the inside width of the 
raised ceiling)

Z Rear Ceiling Drop 
Distance/ Inside Ceiling 
Width (rail Wagon)

Distance Depth of the ceiling drop at the rear of the 
vehicle
(For Rail Wagon, this is the inside height of the 
raised ceiling)

AA Split Thickness (Rail car 
when split)

Distance (For Split Rail Car only) The thickness of the 
divider running along the length of the rail car.

AB Trailer 1 (Double Trailer) String (64) Name of vehicle used as first trailer
AC Trailer 2 (Double Trailer) String (64) Name of vehicle used as second trailer
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AD Bay Count Numeric Number of total bays in the side bay truck
AE Short Bays Numeric, 

Numeric
The location of short bays separated by 
commas (MaxLoad assumes short bays on 
both side of the vehicle) 

AF Split Bays Y/N Should be blank
AG Short Bay Height Distance Loadable height of each short bay
AH Split Bay Height Distance Not used
AI Bay Split Thickness Distance Not used
AJ Bay Width Distance Width of each bay (along length of truck)
AK Bay Depth Distance Depth of each bay (along width of truck)
AL Wheel Well Distance Distance Location of wheel wells from the front of the 

vehicle
AM Wheel Well Length Distance Length of wheel wells of the vehicle
AN Wheel Well Width Distance Width of wheel wells of the vehicle
AO Wheel Well Height Distance Height of wheel wells of the vehicle
AP Corner Boxes: Distance 

from front - Location1
Distance Location of first set of corner boxes from the 

front of the vehicle
AQ Corner Boxes: Distance 

from front - Location2
Distance Location of second set of corner boxes from 

the front of the vehicle
AR Corner Boxes: length Distance Length of defined corner boxes (apply to for 

both sets of corner boxes)
AS Corner Boxes: width Distance Width of defined corner boxes (apply to for 

both sets of corner boxes)
AT Corner Boxes: height Distance Height of defined corner boxes (apply to for 

both sets of corner boxes)
AU # of Axles for Axle 1 Numeric Number of axles for Axle 1
AV # of Axles for Axle 2 Numeric Number of axles for Axle 2
AW # of Axles for Axle 3 Numeric Number of axles for Axle 3
AX OrgID Numeric Organization ID (for ADO version only)

Color Values for SKU Import
Use the decimal value on the far right to represent the color of SKU when doing a generic import of 
SKU as explained in the previous section.

Red RGB( 255, 0, 0 )  255

Maroon RGB( 128, 0, 0 ) 128

Light yellow RGB( 255, 255, 128 ) 8454143

Yellow RGB( 255, 255, 0 ) 65535

Light Orange RGB( 255, 128, 64 ) 4227327

Orange RGB( 255, 128, 0 ) 33023

Olive/brown RGB( 128, 128, 0 ) 32896

Light green RGB( 128, 255, 128 ) 8454016

Neon Green RGB( 128, 255, 0 ) 65408

Green RGB( 0, 255, 0 ) 65280
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Medium Green RGB( 0, 255, 128) 8453888

Aqua/Teal RGB( 0, 128, 128) 8421376

Light Cyan RGB( 128, 255, 255) 16777088

Cyan RGB( 0, 255, 255) 16776960

Blue RGB( 0, 0, 255) 16711680

Dark blue RGB( 0, 0, 128) 838608

Pink  RGB( 255, 128, 255) 16744703

Magenta RGB( 255, 0, 255) 16711935

Rose  RGB( 255, 0, 128) 8388863

Purple  RGB( 128, 0, 255) 16711808

Dark Blue RGB( 0,0,128) 8388608

XML
XML (eXtensible Markup Language) is a widely used standard that facilitates the interchange of 
data between computer applications.  Import of data in XML format is flexible and not tied to any 
operating system or hardware type.  It is a fairly easy way for external data to be imported into 
MaxLoad Pro.

1.	 From the Menu Bar, open the Tools menu, select Import, then XML.  The Open File dialog box 
appears, as pictured here.

2.	 The file filter in the dialog box displays only XML files. Highlight the file you’d like to import and 
click on the Open button.

�� Note:  Contact TOPS tech Support for further assistance.
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Import Tops Data
This feature is available for MaxLoad Pro 2.70 or later and TOPS Pro 5.05 or later. It allows case sizes 
and most pallet patterns created from TOPS Pro (TOPS’ Package Design and Palletization Software) to 
be imported into MaxLoad Pro.

In MaxLoad Pro 2.70 or later, the software comes with an INI file, Tops2Max.ini, found in Windows 
system folder. This text file specifies the paths where the two programs (TOPS and MaxLoad Pro) are 
located as well as the location where MaxLoad Pro will look for the data to be exported from TOPS 
Pro. Below is an example of the file.

Tops2Max.ini

[TopsPro]
AppPath=C:\Program Files\TOPSAPPS\TOPSPRO
ExportPath=C:\Program Files\TOPSAPPS\TOPSPRO\Export
AutoLoad=

[Maxload]
AppPath= C:\Program Files\TOPSAPPS\Max2Pro

From the Menu Bar, open the Tools menu; select Import, then Import Tops Data.  MaxLoad will go to 
the location specified in the ExportPath of the Tops2Max.ini file and import all files. When importing 
is done, it will display a message “Import Complete”.

�� Note: To export analyses from TOPS Pro (which will be placed in the folder referenced in 
the Tops2Max.ini file), open the File menu from Menu Bar and select Save As. After entering 
the filename, check the “Export to MaxLoad” option and click on Save. Please also refer to 
the TOPS Pro User’s Guide for more information.

Custom Import
The Custom Import function allows you to import SKU and Picklist (include truck, pallet and tote 
manifests) details stored in other database into MaxLoad Pro for load optimization. The data to be 
imported needs to be saved in a comma separated value (CSV) file as in an Excel spreadsheet or a 
pure text file (TXT).

With Custom Import, you will tell MaxLoad what data to bring in. Use the configuration set up file 
to select the corresponding data for each column (field) in your data file to be imported.  Before you 
can import a Picklist (Manifest), you will need to import your SKUs.

Config SKU Import
Before you can start importing custom data, you have to tell MaxLoad Pro how the incoming data 
are formatted in the csv or text files.  This involves specifying what data each column in the CSV file 
represents via a field selection screen as described below.
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From the Menu Bar, open the Tools menu, select Import and then Config SKU Import. The Select 
Fields (SKU) dialog box appears, as shown above.

•	 Unit: Specify the unit measure for the imported data.

•	 Delimiter: MaxLoad will automatically choose a comma (,) as the delimiter. This character is 
used to separate the individual field for each record in the file.  Unless otherwise instructed, the 
delimiter can remain a comma. If you are using other characters e.g. semicolon (;) in the CSV file, 
enter it in this field. 

•	 Ignore Lines: Indicates the number of lines at the beginning of the CSV file that MaxLoad Pro 
should ignore during the import process. These are likely to be dates, column headings and 
information other than the actual records.

•	 Fields: The fields are labeled alphabetically with drop down menus next to each. Each field 
corresponds directly with the alphabetical column in your Excel spreadsheet. For example, “Field 
A” and its drop-down menu corresponds with column A in your Excel spreadsheet, “Field B” with 
column B, and so on.

For example, if your data file contains SKU Name in column A and SKU Description in column B, 
select SKU Name from the drop-down list in Field A and Description in Field B. The rest of the 
fields can be left as “Skip”, meaning not imported into MaxLoad Pro.

The data which can be imported are the same data that you can define for each SKU, can 
described in Chapter 3 under SKU Database.

•	 File has Header: Check this box if you‘d like to verify the mapping of the data file to the fields 
assigned.  When this option is checked, MaxLoad will display the contents of the last ignored line 
next to the assigned fields when you browse the sample data file.
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•	 Browse Sample Data: This opens the “Import a File” dialog box where you can specify the 
external file to be imported.  After you have provided a filename and click the open button, 
the contents of the data file will be displayed.  You can then verify the data import is properly 
configured.

•	 Clear All: Click this button to clear all current settings.

Minimum Data Required for SKU Import

For SKU import, the only data MaxLoad requires are:

•	 SKU Name

•	 SKU Type – In the Excel spreadsheet, this column will only have the number pertaining to the type 
of SKU. The most commonly used numbers are.

»» 3 – Shipcase
»» 6 – Drum
»» 9 – Tote SKU
»» 10 – Pallet SKU
»» 11 – Pallet Load
»» 13 – L Shape SKU
»» 14 – Trapezoid SKU

If this field is left blank, the SKU type will be defaulted to Shipcase.

•	 Length – The numerical length of the SKU

•	 Width – The numerical width of the SKU

•	 Height – The numerical height of the SKU

Anything else is additional information you may specify only if needed. For fields unused in your 
Excel spreadsheet, select “Skip” from the MaxLoad dialog box drop down menus.

Import SKU
Once you have configured the import SKU format, you can import the data file using these steps:

1.	 From the Menu Bar, go to Tools | Import | Import SKU. The Import File dialog box appears.

2.	 MaxLoad Pro accepts ASCII files with both .TXT and .CSV extension. Specify the file in the Files of 
type field. You can also select All to display all files in the selected folder.

3.	 Highlight the file to be opened and click on the Open button. If you have previously configure 
the SKU Import function (see previous section), MaxLoad Pro will start importing the data. 
Otherwise, MaxLoad Pro will open a SKU Select Fields dialog box as described earlier section.
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Config Picklist Import
From the Menu Bar, open the Tools menu, select Import and then select Config Picklist Import.  You 
can import Truck, Pallet or Tote manifests.

The Picklist Select Fields dialog box appears, as pictured here. 

•	 Delimiter: MaxLoad will automatically choose a comma (,) as the delimiter. This character is 
used to separate the individual field for each record in the file.  Unless otherwise instructed, the 
delimiter can remain a comma. If you are using other characters e.g. semicolon (;) in the CSV file, 
enter it in this field. 

•	 Ignore Lines: Indicates the number of lines at the beginning of the CSV file that MaxLoad Pro 
should ignore during the import process. These are likely to be dates, column headings and 
information other than the actual records.

•	 Fields: Defines which columns or fields from the external data file will be imported into MaxLoad 
Pro. The field number (from A through AK) corresponds to the columns in your data file. Click on 
the down arrow at the corresponding field to open the drop-down list and select the item to be 
imported.  Select Skip if the data is not to be imported into MaxLoad.

»» For example, if your data file contains Manifest Name, SKU, Quantity, Priority and Order 
Number in columns A, B, C, G & H respectively, you should select the corresponding item from 
the drop-down list in the same Field number. The rest of the fields can be left as Skip, meaning 
not being imported into MaxLoad Pro.

»» Your external data file must contain the column “manifest” which corresponds to the name of 
the manifest inside MaxLoad Pro.  After import, you should see this manifest name in the File 
Open dialog box.

•	 File has Header: Check this box if you‘d like to verify the mapping of the data file to the fields 
assigned.  When this option is checked, MaxLoad will display the contents of the last ignored line 
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next to the assigned fields when you browse the sample data file.

•	 Browse Sample Data: This opens the “Import a File” dialog box where you can specify the 
external file to be imported.  After you have provided a filename and click the open button, 
the contents of the data file will be displayed.  You can then verify the data import is properly 
configured.

•	 Clear All: Click this button to clear all current settings.

Minimum Data Required for SKU Import

For Picklist import, the only data MaxLoad requires are:

•	 Manifest – The name(s) of the manifest(s).  You can import multiple manifests at one time.

•	 SKU – The SKUs to be loaded in the manifest.

•	 Quantity or Piece Count – Though quantity is the more common parameter for the picklist, you 
can also use piece count if your company decides amounts by piece count.

•	 Type – This is the manifest type as represented by these numbers.

»» 0 – Vehicle
»» 1 – Pallet
»» 2 – Tote
»» 3 – Single SKU

Anything else is additional information you may specify only if needed. For fields unused in your 
Excel spreadsheet, select “Skip” from the MaxLoad dialog box drop down menus.

Import Picklist
To import Picklist into MaxLoad Pro, follow these instructions:
1.	 From the Menu Bar, go to Tools | Import | Import PickList.  The Import a File dialog box appears.

2.	 MaxLoad Pro accepts ASCII files with both .txt and .CSV extension. Specify the file in he Files of 
type field. You can also select All to display all files in the selected folder.

3.	 Highlight the file to be opened and click on the Open button.

If you have previously configured the PickList Import function (see previous section), MaxLoad Pro 
will start importing the data. Otherwise, MaxLoad Pro will open a PickList | Select Fields dialog box.

�� Note:  As MaxLoad Pro’s internal data structure is generated through DAO, it is possible 
to directly manipulate MaxLoad Pro’s data (through Microsoft Access for instance).  
However, this manipulation should be limited to extracting information from the MaxLoad 
Pro tables.

Purge Master Data
You can remove pre-existing master data, SKUs and manifests, from MaxLoad Pro using a purge 
command.  To do so, import the file PURGEALL.TXT from the \Max2Pro\ folder. 

�� Make sure you have a back up of  master data before issuing the purge all data 
command. For example, you can create a back up copy of the MaxLoad \DATA\ folder where 
all MaxLoad Pro data resides. 
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Export Databases
As in the same way you prepare data to be imported into MaxLoad Pro, you can export data from 
MaxLoad Pro and use them in other applications. The export file created will be in the comma 
delimited format. 

To export databases from MaxLoad Pro, follow these instructions:

1.	 From the Menu Bar, open the Tools menu, select Export. A submenu appears with a list of Export 
options – Export Databases, XML, Export By Placement, and Custom Export.

2.	 Select Export Databases to open the Export dialog box.

  
3.	 The Export dialog box lets you browse to a location, where you want to save the exported 

database.  By default the exported file gets saved to the Data folder, under the Mx2Pro directory.  
The Export dialog box lets you export over 15 databases.

4.	 Once the selection is made, click OK.

The software will create the file and export the selected data.  During export an export dialog box 
will appear on the screen.  Once the export is complete, the dialog box will be closed automatically.

XML
MaxLoad Pro can export the currently opened manifest to an XML file. The output can be easily read 
by other applications for further processing.

To export MaxLoad Pro data in XML format, follow these instructions:

1.	 From the Menu Bar, open the Tools menu and select Export. The Save As dialog box appears, as 
pictured below. 
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2.	 Type the file name that will be used for the selected export in the File name field and click Save. 

MaxLoad Pro will create an XML file in the specified directory path.

Export by Placement
The Export by Placement function generates step-by-step JPEG images to illustrate the loading 
procedure to a transit container for the currently opened manifest. To Export by Placement, follow 
these instructions:

1.	 From the Menu Bar, open the Tools menu and select Export, then Export by Placement. The Save 
As dialog box appears, as pictured below. 

   
2.	 Type in the name of the image file that will be used to save the placement images in the File 

name field and click Save. 

Depending on the number of placement steps for the manifest, MaxLoad Pro will generate a 
series of JPG images in the specified directory path. 

�� Note:  The images will be named Filename1-1.jpg, Filename1-2.jpg, and so on. In the 
example illustrated in the above dialog box, the placement images will be named Load1-1.
jpg, Load1-2.jpg… Load1-10.jpg. 
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Custom Export
The Custom Export function allows you to export load summaries to an ASCII comma delimited text 
file.  With custom export you can specify which fields in summary you would like to export from 
MaxLoad Pro and where to place the fields in the output file.  The output file(s) can then be easily 
imported into other applications for further processing.  The various load summaries that can be 
exported using this feature are as follows:

•	 Solution
•	 Placement List
•	 Load List
•	 Air Bag/Dunnage

To custom export a summary, follow these instructions:

1.	 From the Menu Bar, open the Tools menu and select Export. A submenu appears with a list of 
Export options – Export Databases, XML, Export By Placement, and Custom Export.

2.	 Cursor over Custom Export and another sub menu appears.  Select one of the four options – 
Solutions, Placement List, Load List or Air bag/ Dunnage. The Export dialog box appears, as 
pictured here.

   
3.	 Type the file name that will be used for the selected export in the Filename field and click Open. 

The Select Fields dialog box appears.
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4.	 Select Fields dialog box allows you to specify the data to be included in the data file.

•	 Containers: If your load solution uses more than one container, click All to export data for all 
containers, else click Current to export data for the current container only.

•	 Export Fields: For each field, click the down-arrow to view the list of data you can export for 
the selected report type. The data available is similar to the data available under the same 
report name within the MaxLoad Pro’s Manifest View Screen.

•	 Export to JPG:  Check this box instruct MaxLoad Pro to also create a JPG output for the 
selected report and container.

5.	 Once the selection is made, click OK. The software will create the file and export the selected 
data.

Custom Export File
The first export field in the custom export file corresponds to the first column of the comma 
delimited file, the second field to the second column, respectively. Select Skip if you’d like to keep a 
blank column in the output file.

Below is a sample Placement list. The data are in the sequence of SKU, Quantity, Unitload Count, 
Cube, %Cube, X Front, X Side and X Floor for all containers.

Truck #1 
Deepfreezer, 16, 0, 723.3 (ft3), 20.5 %, 0 (in), 0 (in), 0 (in) 
Deepfreezer, 14, 0, 632.9 (ft3), 18.0 %, 0 (in), 0 (in), 35 (in) 
TV, 15, 0, 332.5 (ft3), 9.4 %, 0 (in), 0 (in), 70 (in) 
Stereo, 17, 0, 58.2 (ft3), 1.7 %, 0 (in), 42 (in), 70 (in) 
Stereo, 7, 0, 24.0 (ft3), 0.7 %, 0 (in), 42 (in), 82 (in) 
Stereo, 76, 0, 260.2 (ft3), 7.4 %, 0 (in), 62 (in), 0 (in) 
Refrigerator, 19, 0, 663.2 (ft3), 18.8 %, 0 (in), 62 (in), 24 (in) 
Computer, 9, 0, 88.2 (ft3), 2.5 %, 0 (in), 62 (in), 89 (in) 
Computer, 1, 0, 9.8 (ft3), 0.3 %, 480 (in), 0 (in), 70 (in) 
Computer, 12, 0, 117.5 (ft3), 3.3 %, 504 (in), 0 (in), 35 (in) 
Computer, 4, 0, 39.2 (ft3), 1.1 %, 504 (in), 0 (in), 87 (in) 
Computer, 2, 0, 19.6 (ft3), 0.6 %, 551 (in), 62 (in), 0 (in) 
Computer, 1, 0, 9.8 (ft3), 0.3 %, 551 (in), 62 (in), 52 (in) 
Computer, 1, 0, 9.8 (ft3), 0.3 %, 551 (in), 62 (in), 78 (in)
Truck #2 
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TV, 81, 0, 1795.5 (ft3), 51.0 %, 0 (in), 0 (in), 0 (in) 
Stove, 8, 0, 295.0 (ft3), 8.4 %, 378 (in), 0 (in), 0 (in) 
Refrigerator, 10, 0, 349.1 (ft3), 9.9 %, 378 (in), 37 (in), 0 (in) 
TV, 4, 0, 88.7 (ft3), 2.5 %, 378 (in), 37 (in), 65 (in) 
Stove, 2, 0, 73.7 (ft3), 2.1 %, 538 (in), 37 (in), 0 (in) 
Refrigerator, 1, 0, 34.9 (ft3), 1.0 %, 542 (in), 0 (in), 0 (in)
Truck #3 
Stove, 40, 0, 1474.9 (ft3), 41.9 %, 0 (in), 0 (in), 0 (in)

Export Summary
The Summary export function allows you to export load summary to an ASCII comma delimited 
text file.  The export include manifest name, truck type, truck number, SKU name, SKU description, 
quantity, and load priority as in the example below:

Appliance Load,48 Ft. Dry Cargo,1/2,Computer,Pentium 200 mhz.,20,20,1,0,
Appliance Load,48 Ft. Dry Cargo,1/2,Deepfreezer,Arctic Plus Model,27,27,1,0,
Appliance Load,48 Ft. Dry Cargo,1/2,Refrigerator,Model 363-2,24,24,1,0,
Appliance Load,48 Ft. Dry Cargo,1/2,Stereo,Surround Sound,34,34,1,0,
Appliance Load,48 Ft. Dry Cargo,1/2,TV,Surround Sound Plus,33,33,1,0,
Appliance Load,48 Ft. Dry Cargo,2/2,Deepfreezer,Arctic Plus Model,1,1,1,0,
Appliance Load,48 Ft. Dry Cargo,2/2,Refrigerator,Model 363-2,2,2,1,0,
Appliance Load,48 Ft. Dry Cargo,2/2,Stove,5 Burner,30,30,1,0,
Appliance Load,48 Ft. Dry Cargo,2/2,TV,Surround Sound Plus,5,5,1,0,

Export Mixed Pallets
The Mixed Pallets Report output a text file in the specified location, providing details on the contents 
of each mixed pallet in the current manifest.  If there is no mixed pallets in the current manifest, the 
output file will only contain the first title row but with no data.

Mixed Pallet, SKU, Qty
Mixed Pallet 6, Hand Towels, 5
Mixed Pallet 5, Saltines, 1
Mixed Pallet 4, Saltines, 2
Mixed Pallet 4, Toilet Tissue, 7
Mixed Pallet 3, Saltines, 4
Mixed Pallet 3, Tissue Paper, 8
Mixed Pallet 2, Cookies, 11
Mixed Pallet 2, Saltines, 4
Mixed Pallet 2, Toilet Tissue, 8
Mixed Pallet 1, Cookies, 17
Mixed Pallet 1, Potato Chips, 20

Export UnitLoads
The UnitLoads Export allows you to output all unitloads created for each SKU in the MaxLoad Pro 
database to an XML file.  The export file will be in the format as provided below, giving dimension 
of the SKUs and TIHI details (number of cases per unitload layer and number of layers on the pallet) 
and overall dimension of the unitload.

- <maxout units=”English”>
  - <UnitLoadList>
    - <UnitLoad>
       <SKUNumber>Bulk Frozen Yogurt</SKUNumber> 
       <SKUDescription>Swirl Flavor Yogurt</SKUDescription> 
       <SKULength>10.00 (in)</SKULength> 
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       <SKUWidth>10.00 (in)</SKUWidth> 
       <SKUHeight>12.00 (in)</SKUHeight> 
       <SKUWeight>0.08 (lb)</SKUWeight> 
       <CasePerLayer>20</CasePerLayer> 
       <LayerPerUL>4</LayerPerUL> 
       <CasePerUL>80</CasePerUL> 
       <ULLength>50.00 (in)</ULLength> 
       <ULWidth>40.00 (in)</ULWidth> 
       <ULHeight>53.00 (in)</ULHeight> 
       <ULWeight>71.40 (lb)</ULWeight> 

   </UnitLoad>
   - <UnitLoad>
       <SKUNumber>Case 1</SKUNumber> 
       <SKUDescription>Sample Case 1</SKUDescription> 
       <SKULength>23.00 (in)</SKULength> 
       <SKUWidth>19.00 (in)</SKUWidth> 
       <SKUHeight>15.00 (in)</SKUHeight> 
       <SKUWeight>10.00 (lb)</SKUWeight> 
       <CasePerLayer>4</CasePerLayer> 
       <LayerPerUL>3</LayerPerUL> 
       <CasePerUL>12</CasePerUL> 
       <ULLength>48.00 (in)</ULLength> 
       <ULWidth>40.00 (in)</ULWidth> 
       <ULHeight>50.00 (in)</ULHeight> 
       <ULWeight>185.00 (lb)</ULWeight> 

   </UnitLoad>
   - <UnitLoad>
  ...... 
  ......	

Export Manifest
The Export Manifest function allows you to export the current manifest to a comma separated text 
file in a specified location.  The output text file contains all data pertaining to the current manifest 
including SKU, vehicle and load solution details.  Use this function to export all relevant data for a 
manifest so it can be directly imported in MaxLoad Pro.  You can use this function to send a manifest  
to TOPS technical support team for assistance.

Email Manifest
The Email Manifest function combines the steps of exporting the current manifest and adding it as 
an attachment in your email client so it can be sent off to another party.

The receiving party needs to have MaxLoad Pro to view the manifest.  Upon receipt of the manifest 
(txt file), they should go to the Tools Menu, select Import and then Import (Generic).  The manifest 
should now appear in the File Open dialog box. 

Ftp Import
The Ftp Import function allows you to import a file from an ftp site. 

1.	 From the Menu Bar, open the Tools menu and select Ftp Import. The FTP Get dialog box opens.

2.	 Enter the address for the ftp site where data is to be imported or select from the drop list if 
previous ftp addresses have been used. Enter the User name and Password for site access and 
click on the Connect button.
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Once connected, the contents of the site will be displayed in the File List as shown here.

  
3.	 Select the file to be imported from the list and click on the Import button. You will see a process 

window which will close automatically when the import process is complete.  If this is a manifest 
you are importing, you should see it in the File Open dialog box.  For SKU import, they will 
appear in the SKU list in the PickList screen.

4.	 Click on the Disconnect button and then the Close button to exit the Ftp Import function.

Import/Export Using System Clipboard 
Users can easily send data between MaxLoad and other applications using Windows system 
clipboard.  This allows users to easily bring in pick list data into MaxLoad’s Manifest List or export 
load results to other applications.

Copy Data from Other Applications to MaxLoad Pick List
This function allows users to paste contents of the system clipboard to MaxLoad’s current Pick List. 
Data can be from any application capable of copying data to clipboard in delimiter format including 
ERP, WMS and MS Office programs.

Steps (Example using Excel / Word data):

1.	 Start with a table of data in Excel or Word containing at least SKU and Qty. Highlight the data to 
be copied and issue the copy to clipboard command or use keyboard shortcut [Ctrl]+[C] to save 
the data to the system clipboard. 
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2.	 With MaxLoad open, right click in the Manifest List pane and select “Paste from Clipboard”. 

   
3.	 The Select Fields dialog, as shown next, will open. 

  
4.	 At the Select Fields dialog box, select from the drop list the MaxLoad data corresponding to the 

clipboard data.  Each field starting from A corresponds to one column of data on the clipboard.

5.	 To paste data from the Excel/Word clipboard in step 1, enter:

•	 Ignore lines = 0 as there is no column heading
•	 Field A = SKU
•	 Field B = Qty

6.	 Click OK to import the data.

7.	 To use the same column correspondence for future import from clipboard, click the Set Default 
button.

�� Note: The SKUs must already reside in the MaxLoad database; otherwise, you will 
receive an error message saying - Record “XXX” not found in SKU.  

�� Note: Clipboard data to be imported to MaxLoad Pick List must contain (1) SKU Number 
(SKU) and (2) quantity with SKU placed before Qty.
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Copy Data from MaxLoad Screen to Clipboard
This function exports data from any MaxLoad screen to the system clipboard using Copy & Paste.  

Data can be the SKU List, Manifest List, Solution List, Placement, Load List, Cut List, as well as the UL 
solution list under the Define SKU - Create UL function.

1.	 To export data list from MaxLoad, right-click on the list you are exporting, select “Copy to 
clipboard.”  

2.	 To paste MaxLoad data on the clipboard to other application, go to the application.

3.	 Issue the corresponding Paste command or use the keyboard shortcut [Ctrl]+[C] to paste the 
data.
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 A Command Line Parameters

MaxLoad Pro supports the following command line options:

Command Description

-DBPath=<path> Allows users to override the .ini file and specify a different location for 
the software to find its data.  Use the Maxload.mdb in the specified path 
instead of checking in the path indicated in the Maxload2.ini file.

-Import=<path> This command automatically imports the specified file when the software 
starts. For example, an order processing system could first export an order 
file and then when Maxload Pro is launched, the data would automatically 
be imported.  Imports the specified file on startup if it exists.

-Ini=<path> Allows users to specify the location of the specific maxload2.ini file that 
they want to use.  Use the specified INI file instead of the one in C:\
Windows\maxload2.ini file.

-MultiDb=On With this option, users can specify multiple database paths (dbpath) in the 
Maxload2.ini file. With this feature activated, the user will be prompted on 
startup, for which database to use.

-User=<username> Automatically logs the user into the software as a specified user. This 
allows the user to skip the login screen.

-View Starts the program in view only mode. View only mode prevents the user 
from being able to modify any data in the program.

�� Note:  User names, paths, and filenames that contain spaces or other delimiters should 
be enclosed in double quotation marks like “this”.
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 B Frequently Asked Questions

ÂÂ How is stand-alone license different from the network license? We expect to have 3 users for 
MaxLoad, what type of license configuration should I get?
A stand alone license can only be loaded onto one (1) computer and can be used by only one user 
at a time.  A network license is installed onto a server or network file share, but can be accessed 
from as many client PCs as you desire. The number of network seats purchased will dictate how 
many concurrent users can run MaxLoad at one time. For example if you have installed the program 
on 5 client PCs, but only have a 2 user network, only 2 users would be allowed to use MaxLoad 
concurrently. 
However, additional users can login to MaxLoad “Viewer Mode” which does not take up license seat. 
In viewer mode, users can only open and view existing manifests but not make calculations.

ÂÂ Can I install MaxLoad on a Citrix server or use terminal server? What requirements are there and 
what steps should I take?
1.	 Yes, for a single Citrix server (or any RDP software), you would install MaxLoad directly to the 

server; then grant permissions to users and publish the application shortcut to your remote 
users. 

2.	 If you are using a server farm, you will need to have a single back end server, then make each 
front end RDP server a client just like you would in a LAN situation, and publish shortcuts from 
the front end servers to the remote clients.

ÂÂ Where are the MaxLoad data saved? Can I access them outside MaxLoad?
All MaxLoad data is stored in an Access database under the \Max2Pro\Data\ folder. You can open 
and view the data directly using Access.

ÂÂ What special steps should I take to move the MaxLoad Pro software to a different machine?
You cannot simply copy the install from the old computer to the new one.  You will need the install 
file sent to you via email or the CD installer to do a new install and then call TOPS to get a new 
license code. Once the new install is functional, you can copy and paste the old Data to the new 
computer. However, if it is an upgrade, you must export the old data and import into the new 
version.  Contact TOPS if you need assistance.

ÂÂ I’m trying to remove all the MaxLoad Pro files after uninstalling. What do I need to delete?
Other than the files in the \Max2Pro\ directory and its subdirectories, MaxLoad Pro makes the 
following adjustments to your system:
1.  It creates a MAXLOAD2.INI file in the local Windows directory.
2.  It creates the icons/shortcuts used to start the program.
3.  C:\program files\topsapps\max2pro\ may need deleting as well.

ÂÂ How do I tell what version of MaxLoad Pro I have and its serial number?
Login to MaxLoad Pro as any user and go to the Help menu and select About MaxLoad.  At the top it 
should indicate your software version. The serial number information is also displayed here.  When 
contacting TOPS for assistance, provide the first 7-digit of the long serial number.
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Click on the System Info button to view more details on your current system as well as default 
locations for the application and its data.

ÂÂ What formats are MaxLoad reports in? Can I create load reports in PDF format?
MaxLoad reports are available as JPEG, BMP and PDF files.  At the Print Preview screen, go to Export 
and then specify the format. When emailing reports from MaxLoad, each page will be saved as a 
JPEG file and attached to your email client.

ÂÂ Is it possible to display both English/Metric dimensions in the output?
Currently, you can use either English or Metric. To specify the unit of measure, use the drop down 
selection button on the Tool Bar or via the Defaults button under Tools | Configuration menu.

ÂÂ How do I change the language I see in MaxLoad?
To change the language in MaxLoad, go to the Tools | Language menu and select the new language.  
In addition, each language is fully configurable, so if you would like to change the term “Sea Van” 
to “Ocean Container”, go to Tools | Language menu and select Edit Language.  Select the string 
“Sea Van” under American and enter “Ocean Container” under the New Word field. Click Update to 
save and exit.  You can also change the term directly by modifying the string file saved in MaxLoad’s 
Language folder.

ÂÂ How do I login as Supervisor?
In MaxLoad, the Supervisor has the rights to delete users and access global settings.  To login as a 
Supervisor, enter the default password of “tops software” which is case insensitive.

ÂÂ How do I change the defaults in MaxLoad Pro?
Follow these instructions:
1.  Right click over the text of the default you want to change. 
2.  Click the Properties button at the pop-up menu.
3.  Make the changes at the Defaults tab and click OK to save.
To change other defaults, go the Tools | Configuration menu.

ÂÂ How do I turn on user passwords for all users?
1.  Login as the Supervisor.
2.  Go  to the Tools menu and select Configuration.
3.  Click on the Global button.
4.  Check against the option User Passwords.

ÂÂ How do I replace the TOPS logo with my company logo?
1.  Login as the Supervisor.
2.  Go  to the Tools | Configuration menu.
3.  Click on the Defaults button.
4.  At the Logo Path field of the Defaults dialog, click the Browse button to where the logo graphic 
file resides.  
Note that the logo file should be in BMP format and no more than 256x256 pixel, and 256 colors (8-
bit) recommended.
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ÂÂ How do I add items into MaxLoad Pro database?
There are two ways to add items to the MaxLoad database. The first, is the manual method; go 
to the Define menu, then select the type of item you wish to add and enter them one by one into 
MaxLoad. The other method is by importing a text or CSV file. You can import SKU data, vehicles, 
pallets or order list into MaxLoad via Generic or Custom Import. This is covered in Chapter 12.

ÂÂ How do I save a mixed pallet as a SKU item and load into a vehicle?
In MaxLoad, you can do a Truck manifest which can create mixed pallets on the fly.  But to load a 
saved pallet manifest into a vehicle, you will need to use “Save Manifest as SKU” function to first 
create a Pallet SKU. The Save Manifest as SKU function is only available for pallet and tote manifests.
Go to the File menu and select Save Manifest As SKU or check the Save as SKU option in the 
File|Save dialog.  See page 29 for more details.

ÂÂ How do I delete a mixed pallet saved as a SKU item?
Go to the Define menu, then choose SKU.  Select Pallet SKU as SKU Style and select your mixed pallet 
under SKU number.  Click the Delete button. The program will respond with: Do you want to delete 
this record? If you are sure, then select Yes.

ÂÂ Why isn’t the truck graphics visible?
This normally happens if you run MaxLoad using a secondary monitor.  Bringing MaxLoad to the 
primary monitor will solve the problem.

ÂÂ What is MaxLoad Pro Viewer and how do I use it?
The Viewer mode is an operation mode in MaxLoad Pro where users can only open and view saved 
manifests but not making calculations or create new manifests. In this mode, the “New” option in 
the Control Panel will be disabled (grayed out). To use Viewer mode, check Viewer mode box in the 
login screen and login as usual. Viewer mode login does not count towards license seat.

ÂÂ How do I use the editor?
Create or open a manifest in Truck, Pallet or Tote manifest from the main screen. At the Solution 
View screen, click on the Edit button on the upper right hand corner or click the Split Edit button 

  to use split screen edit.  To move your items left-click and hold on your item and drag it to a 
destination - another location in the truck, to the cut list or temporarily outside the truck.  
In split screen mode, you can drag SKUs directly from one vehicle to the other.  For more detailed 
discussion, please refer Chapter 9: Editing a Solution.

ÂÂ How do I create and edit a unitload?
The unitload is a “saved pallet pattern” MaxLoad can use when you have enough items to create that 
pattern. We recommend creating unitloads for all of your items if they will be placed on pallets. This 
will give you the best pallet patterns. 
To use, go to Define|SKU then click on the Create UL button. From there, pick your parameters 
for the pallet and stacking rules for your SKU and click the Calculate button. Once you have your 
unitload created, click on the Save button.  The unitload is now ready for use. 
To use unitload when loading, make sure the “Use UnitLoads” selection under the Options tab is 
checked when calculating a manifest.
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ÂÂ How do I use the single SKU module?
The single SKU module is used to maximize your vehicle load with one item only. Select the Vehicle 
and the SKU you want to load in it and you are ready to go. There is no need to specify a quantity, 
MaxLoad will find the best way to cube out the vehicle.

ÂÂ Can I use SQL or other database server for MaxLoad data?
Yes, there is an upgraded ADO version of MaxLoad that uses SQL or Oracle as the back end database.  
In addition to the features provided by the database servers, MaxLoad ADO version also offers these 
additional benefits: 
•	 Multiple user roles (supervisor, power user, standard user and viewer).
•	 Automatic user logout based on time limit or inactivity.
•	 Allow users to manage orders within the manifest.
•	 Allow automatic import and update of SKU and picklist data via database table.
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 C Glossary

Algorithm:  Mathematical rule or rules that specify how to solve a given problem

Allow Loose fills on sides:  This feature will first fill the container with as many unitloads as possible, 
and then it looks at any SKUs in the Cut List to see if they will fit in any of the open spaces remaining. 

Allowed Vertical:  Dimension of the SKU (length, width, and/or depth) that is allowed to be loaded 
vertical.  See also Preferred Vertical.

Axles:  A transverse bar or shaft connecting the opposite wheels of a trailer or railcar.

Bundle: Two or more SKUs held together with a strap or a rope to form a shipping unit.

Button Bar:  A bar at the top of the screen comprised of icons that control certain functions (such as 
print, open, save, etc.) and give you instant access to those functions.

Case:  An SKU defined as a square or rectangle.

Check Box: A check box turns an option on or off.  If the check box contains an X or check mark, the 
option is turned on.

Clampable:  Ability of a palletload to be handled by squeezing both sides of the load.  A pallet 
pattern is suitable for being clamped if any void between SKU’s does not exceed 0.5” inches.

Clipboard:  Areas of memory where text and commands can be stored to wait for further action, 
such as importing into a report.  The contents of the Clipboard are erased when you exit Windows.

COG:  Center of Gravity.

Column Loading:  Loading a mixed pallet by building full columns of each SKU.

Column Stack Loading:  Loading a straight pallet by building full columns of an SKU.  Also called row 
or column loading.

Command Line Parameter:  An instruction or a switch, issued to MaxLoad Pro, to execute a 
particular action when the executable is launched.  Example –user will automatically login a specified 
user.

Control Center:  This the first screen when the user logs into to software.  This screen has four 
buttons – Truck, Pallet, Tote, Single SKU – that allow the user to launch various parts of MaxLoad Pro.  

Control Label:  The name of a specific field.  For example, in the Define SKU screen, SKU Name and 
Description represent the Control Label for those particular fields.

Constraint Message:  A warning message that appears when you’ve violated a stacking or placement 
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rule while manually editing a manifest.  This message always displays in the Status Bar at the bottom 
of the Edit screen.

Corner Posts:  Edge protectors found on the corner of unitloads, used to force corner support.  
MaxLoad Pro allows you to define the length and thickness of corner posts for a unitload.

Creating a Unitload:  The process of loading a SKU onto a pallet or a slipsheet.  This procedure 
takes into account various parameters, including the maximum height, weight and overhang of 
the unitload you’re creating.  MaxLoad Pro also allows you to analyze various pallet patterns when 
creating a unitload.

Cubic Efficiency %:  The cubic efficiency of a transit vehicle load is calculated by multiplying the 
(individual SKU cube) by (the number of shipping cases per transit vehicle load), then dividing this 
product by the available cube of the transit vehicle.  The available cube of the transit vehicle is (the 
transit vehicle length) times (the transit vehicle width) times (the transit vehicle height).  When 
calculating the cubic efficiency % of a unitload or mixed-pallet load, MaxLoad Pro will use the 
absolute outside dimensions (including the pallet) of the loaded unitload.

Cut List:  After calculating a manifest the SKUs which cannot fit in the specified container or a pallet 
are listed in the Cut List

Deck Boards:  Wooden planks that make up the surface of a pallet.  When you define a pallet in 
MaxLoad Pro, you’re required to define the number of deck boards, as well as the deck board width 
and height.

Dead Stacking / Floor Loading:  Loading an SKU loosely in to a vehicle without the use of pallets or 
slipsheets.  Also known as hand stacking. 

Dead Stacking Rules:  Stacking rules for SKU’s that are loaded loosely into a vehicle rather than as 
part of a unitload or mixed pallet.

Default:  A setting or value automatically provided by MaxLoad Pro unless an alternative is specified.  
Many MaxLoad Pro defaults can be changed for all future analysis by going into the Configuration 
section and changing them.  Other options may change a default for the active analysis only, and will 
reset when you exit MaxLoad Pro.

Double-Face Pallet Construction:  A pallet style that has both a top and bottom deck.

Double Trailer:  A single tractor may pull more than one trailer at one time.  MaxLoad Pro can 
calculate the contents of both trailers at the same time.

Double-Wing Alignment:  A type of pallet alignment that has overhangs on both decks. 

Drop Deck:  A goose-neck trailer that has a drop-off for both the front and rear of the trailer.

Drum:  An SKU that is defined as a cylinder.

End Gap:  The distance between the last loaded SKU the end of the container.

Euro-Pallet:  A commonly used pallet style in Western European countries.  The Euro-Pallet is usually 
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1200 mm in size and utilizes a block construction to allow for four-way entry.
Floor to Ceiling:  A specific algorithm used by MaxLoad which loads a layer of SKUs across the entire 
floor before it allows to create a second layer.

Floor loading:  See Dead Stacking.

Flush Alignment:  A pallet style that has no wings. 

Footprint-Shipcase:  The area of the horizontal surface (base) touching an item below it (another 
SKU or the floor).  This value can be referred to either in square inches/ centimeters or by the length 
and width of an SKU’s base.

Footprint-Pallet Load:  The area of the physical pallet plus any defined overhang.

Front to Back:  A specific algorithm used by MaxLoad Pro which will stack a vertical layer at the front 
of the truck before proceeding with further vertical layers moving towards the back of the truck

Global Configuration:  A configuration that applies to all aspects of the program.  For instance, 
Maximum Overhang is defined in the Vehicle Loading Options screen, and applies to all SKU’s loaded 
in a manifest, as opposed to a separate value for each individual SKU.

King Pin:  Vertical rod sticking out of the bottom-forward portion of a vehicle that connects the 
trailer to a tractor.

Layer Loading:  Loading a mixed pallet by building full layers of an SKU.

Leading Edge Loading:  Loading method whereby each new placement that touches the far wall of 
the vehicle is considered to be a new leading edge.

Load By SKU Ratio:  This algorithm gives the user an option to a container with a specified ratio of 
SKUs in the Manifest List.

Load By Priority:  A number assigned to a SKU as it is loaded into a transit vehicle that denotes its 
importance of loading order in relation to other items in the load.  SKUs assigned with smallest  
priority number will be loaded first i.e. SKUs will priority 1 will be loaded before 2, then 3 and so on.

Load List:  Displays the list of SKUs which are loaded on the truck.  This shows the SKU quantity, the 
priority, the cubic usage and relative weight.

Manifest:  All the relevant information regarding the building of a load.  A manifest is comprised of 
vehicle information, as well as the type and quantity of SKU’s to be loaded into a vehicle.

Maximize Button:  A small box at the top right of a window title bar that contains an upward-
pointing triangle.  When clicked, a window that has been at a medium size will expand to the screen.  

Maximum Overhang:  Maximum amount of space an SKU is allowed to hang over the edge of a 
pallet.  This figure is defined individually for both the length and width of the pallet.  

Maximum Priority Overlap:  Maximum amount of space SKU’s of two separate load priorities are 
allowed to “mix” together when being loaded into a transit vehicle.  For example, if the maximum 



248 | MaxLoad®Pro User Guide v4.0

priority overlap is defined as 48 inches, items given a priority of “2” would be loaded on top of 
items with a priority of “1” by no more than the 48 inches defined.  This figure is based on the front 
(leading edge) of the SKU.

Maximum Vertical Gap:  The maximum difference in height between two surfaces that can still be 
considered level or flat.  Older versions of MaxLoad Pro refer to this as amalgamation distance.

MaxLoad Pro Control Panel:  A screen that provides the initial interface with MaxLoad Pro.  This 
screen contains various “hotkeys” that allow you to launch into various parts of the program.

Menu:  A list of commands that can be applied to the active window or application.

Menu Bar:  The area at the top of a window containing the main headings for all menu items 
available for that window.

Minimize Button:  A small box containing a downward-pointing arrow, which is located next to the 
maximize button at the right of a window’s title bar.  Clicking on this button shrinks the window to an 
icon.  See also Maximize Button.

Minimum Ceiling Clearance:  Minimum amount of required space between the top of the cargo and 
the ceiling of the transit vehicle.  

Mixed Pallet:  A palletload consisting of multiple kinds of SKU’s and isn’t made up of full SKU layers.

Mixed Pallet for Display:  Mixed pallet or unitload used for end-of-aisle display purposes at 
warehouse clubs and other wholesale and retail outlets.  Usually multiple products are arranged in 
eye-pleasing layers that allow consumers to pick items off the pallet for purchase.

Nest:  A group of cylindrical SKUs like cans, drums or pipes that fit one within the other

Offset (Pallet):  The figure that represents how far a wing extends beyond a stringer on a pallet. 

Optimize Height for Top Layer:  This algorithm lets the software load partial unitloads in a container.  
This is only true for Truck Manifest.  

Pallet:  A low platform of wood, metal or fiberboard used to stack smaller units of product for 
transportation or storage.

Pattern Styles:  MaxLoad Pro assigns a name to a pallet pattern type to assist in visualizing the basic 
pattern.  For more information on pallet patterns, including graphic images, please refer to Chapter 
7 - Loading a Single-SKU Manifest, section Options Tab.

Pinwheel Optimization:  This algorithm will load unitloads onto the truck in a pinwheel layout as 
opposed to loading by length or width. 

Placement:  A block of SKU’s loaded with the same dimension vertical and oriented in the same 
direction in the vehicle.

Plan View / Top View:  Overhead view of a diagram.  
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Picklist:  List of all loaded SKU’s from the Manifest List.

Piece Count:  Number of items contained within a given SKU.

Preferred Vert:  Due to stacking strength requirements, every SKU will have both an “allowed” and 
“preferred” vertical orientation.  The preferred vertical dimension is assumed to be the dimension 
with the greatest stacking strength.  Unless it is physically not possible, the preferred vertical 
dimension will always be used when floor-loading an item within a vehicle.

Priority:  Sets the relative importance of a SKU.  SKUs with the lowest number gets greater 
importance than higher numbered SKUs and will be loaded on the container or pallet in sequential 
order. 

Properties:  Properties are similar to defaults (defined earlier). They represent a specific setting for 
a particular field.  However, they differ from defaults in that a Property applies only to one record 
(i.e., one specific SKU) rather than all records.  For example, when you change the properties from 
inches to feet for the length field of SKU # 12345, only SKU # 12345 will be affected.  If you want that 
change to affect all future SKU’s that you define, you will need to make the change in the Defaults 
field.

Rail Car:  Standard container behind a train engine

Rail Wagon:  Container pulled behind a train engine which has a curved roof.

Record:  MaxLoad Pro stores much of its information in an Access database within the system.  The 
database consists of various records, which represent various pieces of stored information.  For 
example, when you define a vehicle, all the information you input to define that vehicle makes up 
the record for that vehicle.  The same goes for an SKU or pallet.  Information for each individual SKU 
or pallet is considered the record for that SKU or pallet. 

Reversible Pallet Construction:  A pallet style that has a similar top and bottom deck, both capable 
of carrying a load.

Sea Van:  Any end-loading container capable of being transported via an ocean carrier, also go by 
ocean or sea container.

Single Face Pallet Construction:  A pallet style that only has a top deck.

Single-Wing Alignment:  A type of pallet alignment in which the overhang is only on the top deck.

Sizing Handle: The small solid squares that appear on the borders of certain list boxes.  You can drag 
these handles to size the box and its contents.

SKU:  Stock Keeping Unit.  Any individual shipcase, unitload or drum that is loaded onto a pallet or 
into a container.

Smart Pallet Placement:  Regular pallet placement sees the unitload as a single block and does not 
consider how level the top layer is.  Smart Pallet Placement ensures the top layer will be suitable for 
other items to stack upon looks at the stability of the unitload to determine which should be on top 
and which should be loaded on the floor. 
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Space Evenly:  This algorithm spreads the load over the entire surface area of the container in order 
to make a more secure load.  

Sol List:  Solution List - Based on the algorithms selected, Maxload Pro will typically display several 
solutions and these are listed in the solution list or sol list.  

Soldiered:  Type of pallet loading where a SKU can be slipped down turned on its edge between the 
pallet pattern seams in order to create a more efficient palletload.

Stack Code:  User-defined label that determines how items are stacked within a load.  Items with 
similar stacking characteristics should be defined with the same stack code.

Stack Matrix:  The row/column matrix that allows you to define stacking relationships among groups 
of SKU’s.  The stack matrix can be accessed either through the Define SKU screen or through the 
Tools/Stackability menu option.

Staggered Patterns:  Allows the user to nest/stagger cylindrical objects.  

Stop-Off:  Same as Drop-Off.  This is a load that will have items delivered to multiple destinations.

Straight Pallet:  A palletload consisting of a single type of SKU.

Tare Weight: Empty weight of a container.

Title Bar:  The part of a window or dialog box that contains its title.

Tote:  A master pack carton into which SKUs of various sizes and shapes are loaded for transit.

Unitized:  The placing of a single type of SKU onto a pallet.

Unitload:  The product created when MaxLoad Pro develops a palletload of SKUs.  A unitload differs 
from a mixed pallet in the sense that a unitload is comprised of identical SKUs, while a mixed pallet is 
comprised of multiple kinds of SKUs.

Unitload Height:  The overall unitload including pallet height.  For example, most transit vehicles 
allow for approximately 108-110 inches of vertical clearance height.  Therefore, a good Unitload 
Height will not exceed 54 inches (to allow for double stacking in the transit vehicle).

UL:  UL stands for unitload.  It represents a loaded pallet or slipsheet with one size of SKUs.

Unitload Length:  The length of the pallet plus any allowable overhang.  For example, if the pallet 
length is 48 inches and there’s one inch of overhang allowed on each side of the pallet, the Unitload 
Length is 50 inches.

Unitload Width:  The width of the pallet plus any allowable overhang.  For example, if the pallet 
width is 40 inches and there’s one inch of overhang allowed on each side of the pallet, the Unitload 
Width is 42 inches.

Viewer:  A utility program that allows users to view completed manifests.  The viewer doesn’t 
actually perform any work, and therefore is not limited to the number of concurrent users.  Used 
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primarily for integrating MaxLoad Pro with document management systems, the Viewer also allows 
loaders to view, on screen, the results of a completed manifest as well as sending the manifest to a 
printer or an e-mail program.

Weight Efficiency %:  The weight efficiency of a transit vehicle load is calculated by multiplying (the 
individual SKU weights) by (the number of shipcases per transit vehicle load), and then dividing this 
product by the maximum allowable weight of the transit vehicle.
Weight Limit:  Represents the maximum amount of weight which may be loaded in a given container 
or UL.
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